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INTRODUCTION

WELCOME TO THE EXPERT SERIES

 At American Dictation, we’re always working to help professionals become more efficient using digital 

dictation and transcription technology. As we discover best practices, we want to make them available to 

others who use our products.

To that end, we have created the Expert Series of Guides, such as this one. We wanted to create guides 

that we at American Dictation use for our own training purposes. Therefore, each Guide must address the 

full range of product knowledge and expertise necessary to take a novice from beginner level to expert user.

FOR BEGINNERS

While this is called an Expert Guide, it is intended to be an excellent tool for both novice and expert. To 

whatever level of expertise you aspire, we hope this Guide will take you as near or as far as you wish to go.

However new you are to the subject of this Guide, we assume you do have a good understanding of the 

operation of your own personal computer. You should be able to perform most normal, daily tasks on your 

computer, including navigating folders and files, working within basic applications, and the location of 

common folders such as documents, program files, and control panels.

FOR EXPERTS

As experts, we understand the temptation to skip to later sections of any user guide, to jump ahead to the 

more advanced topics. If you have never used the hardware or software discussed here in, we encourage 

you to at least review the initial chapters as a basis of understanding the more advanced subject matter.

CONVENTIONS

We’ve created a number of ways to differentiate among various concepts used to describe the user expe-
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rience. In addition, we include a great number of screenshots to better illustrate how to interact with soft-

ware applications. Please note that your screen may look different depending on your operating system or 

display configuration.

MENU COMMANDS

To show menus that you should navigate within an application, such as those usually found at the top of 

the application window:

Edit > Copy

would indicate that you should select “Copy” from the pull-down “Edit” menu.

BUTTONS

To show a button or clickable choice you should make, we will often show actual screen shots of the ap-

plication. In other cases, we will use:

Select

to show a button entitled “Select.”

ENTRIES

Where you are instructed to enter words, numbers or phrases, we will show:

Now is the time for all good men to come to the aid of their country.

as a means of showing that you should enter this text. For text which depends on your own choice of 

information, brackets will be used:

[First Name] [Last Name]

HELPFUL ADVICE

Periodically, we will include sidebars of information which may be helpful advice as you use the applica-

tions:

 means that you should stop and take an important action before proceeding.

 will refer to a warning that deserves your attention, but which is not usually fatal if not followed.

 is used to point out an idea or concept that we have found will help improve your use of the appli-
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cation.

 indicates that you may want to record certain information for future use.

SCREENSHOTS

Throughout this Guide, we will show actual screen captures taken from our computers. While your 

screen may look different due to customization of your computer (e.g, colors, fonts), you should be able to 

recognize the screens shown. For this Guide, we will usually show the application using the Microsoft® 

Vista® operating system. If you use another version of Windows®, your screens will look slightly different.

CROSS REFERENCES

While you may see cross references to other sections in this Guide within copy paragraphs, you will also 

see special attention made to give you easy access to other referenced sections.

➡ Introduction / Conventions

The first name is the chapter, the following is a section within that chapter. If you are viewing this Guide 

on your computer as a PDF, you should be able to click on the cross reference to immediately go to that 

section of the Guide.

Inline references will appear as This Example, which, if you’re viewing this as a PDF, should be linked to 

another section in this Guide.

PRINTING

To save paper, this document is laid out for two-sided printing. While this may require extra configuration 

with your printer, we hope this will help conserve your resources and provide a slimmer book once printed. 

You are more than welcome to print this Guide for your own personal use. However, please remember 

that your purchase of this Guide does not allow you to share it electronically or printed with others. 

Our ability to provide these Guides at an affordable price depends on your observance of our copyright.

FEEDBACK

We’re always happy to receive feedback on our Expert Guides. If you find an error or feel we should 

revise or add content to this Guide, please let us know. You may email us at 

support@AmericanDictation.com, or call us toll-free at 866-408-1383. We appreciate your help.
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BASICS OF SPEECH RECOGNITION

Dragon™ NaturallySpeaking® (DNS) represents a leading move to using voice for not only composing 

text documents, but actually controlling the functions of your computer. While using speech recognition 

software can certainly offer its own challenges, when used successfully, this class of software can:

❖ Increase efficiency. You can most certainly talk faster than you can type. With the proper configura-

tion, Dragon NaturallySpeaking can keep up with your dictation. Even taking into account editing and 

revisions, you should find speech recognition software gives you more extra time than “keyboarding.”

❖ Reduce transcription costs. If you send your dictation out to a transcription service, you may find 

that by using speech recognition, you can not only save the expense of using an outside service, but 

also decrease turnaround time.

❖ Alleviate injuries and stress due to typing. Continued typing often causes stress-related injuries such 

as carpal-tunnel syndrome. If you have a secretary who transcribes your dictation, using Dragon Natu-

rallySpeaking to transcribe your dictation will help your staff stay healthier, happier and more produc-

tive.

As users of DNS, we strongly believe that using speech recognition can dramatically impact your work in 

a positive manner. However, we also personally know that using DNS successfully comes with certain reali-

zations.

TIME COMMITMENT

Our customers often ask about using DNS on a “demo” basis. While it would be nice to provide a short 

trial of the software, we also know it would in most cases be an unsuccessful trial. Using DNS requires train-

ing of the software to understand your voice, and training on your part to learn how best to dictate to DNS 

to achieve maximum results.

For those new to DNS, you should expect to work with DNS for at least a month in order to reach a level 

of maximum accuracy. It is true that today’s DNS is much more accurate and requires less “training” than 

earlier versions. However, just as with anything, the more you use it and the more you learn how it works, 

the better it will perform for you. You want the program to be as accurate as possible in order to reduce the 

amount of time you will spend editing and revising text. Therefore, resolve yourself to investing time initially 
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to “teach” DNS how you speak and write. This Guide will help. Within these pages are the keys to getting 

the most from DNS. As you become more familiar with the basic operations of the software, you may want 

to explore some of its advanced features. This Guide can help you do just that.

HOW DNS WORKS

We have customers who are amazed at the accuracy of DNS. When you think about it, it’s easy to be 

impressed when you consider that a software program on your personal computer can accurately transcribe 

“Two boys went to town, too.” How old were you before you could decide which version of “two/to/too” 

to use in such a phrase?

DNS works by basing its decisions on three key components:

❖ Acoustic Model. A mathematical model of the sound patterns of your language.

❖ Vocabulary. A list of words, each with a text and pronunciation representation.

❖ Language Model. The most complex of the three, a statistical analysis associated with a vocabulary 

that describes the likelihood of words and sequences occurring in your speech.

When you train DNS, you are teaching it how you speak (acoustic model) and how you use words (vo-

cabulary and language model).

DNS is not 100% accurate, however. At least not all the time. Some of the more common reasons DNS 

errs include:

❖ The correct word is not in the vocabulary. DNS Pro contains an extensive vocabulary. DNS Medical 

and Legal include additional specialized vocabularies. You can also add your own words to the DNS 

vocabulary.

❖ What you said sounded very similar to another word or phrase. The clearer you speak, and the more 

DNS learns about how you construct phrases, the more accurate DNS will be in determining which of 

several like-sounding phrases are more likely to be your intended speech.

❖ Other noises, such as your breath, “uh’s”, and background noises were interpreted as words. DNS 

tries to transcribe all it hears. Maintaining a quiet dictation place will certainly help increase accuracy.

CUSTOMIZING DNS

The ultimate power of DNS comes from its ability to adapt over time to your speech. From the initial 

training of your profile through ongoing corrections of mistakes, DNS is learning to be more accurate. As 

Expert Series Mastering Dragon NaturallySpeaking 10 Professional

12 • © MMVIII American Dictation Corporation • All Rights Reserved 



stated earlier, you can add your own vocabulary words, phrases and acronyms. You can also increase accu-

racy by allowing DNS to analyze your documents and e-mails, where it will add to its statistical model of 

word association, learning how you put together words into phrases unique to your writing style.

➡ Improving Accuracy

MULTIPLE DICTATION SOURCES

Most people associate the use of DNS with using a headset microphone, such as the one included with 

each DNS full-box purchase. However, DNS can work with a variety of different input devices, such as 

array microphones, handheld digital dictation devices (e.g., Philips SpeechMike, Olympus DirectRec), USB 

Wireless and Bluetooth headsets (e.g., Plantronics CS-50 USB Wireless headset), and portable digital voice 

recorders (e.g., Olympus DS-5000, Philips DPM 9600). Using these different devices may affect how you 

set up and interact with DNS. This Guide will help you understand how to use these devices within your 

workflow.

➡ Multiple Dictation Sources

THIRD-PARTY EDITING

While you may wish to use DNS to dictate directly into your computer, allowing you to also give com-

mands to control your computer and applications, many of our customers use DNS to help their transcrip-

tionists gain great efficiencies by processing digital dictation voice files you create. In essence, you provide a 

digital voice file to your secretary or transcriptionist who processes it through DNS installed on his or her 

computer. They, then, make the corrections and maintain your user profile on their computer. You’re free 

to continue dictating without spending time revising your work.

This method has been widely successful with physicians who are more productive dictating patient notes 

and allowing others to transcribe their work. They are often times not at or near a computer when they are 

dictating. Third-Party Editing, as a workflow technique, can be useful for any dictator who simply wants to 

dictate and not use DNS to manage their computer or spend time revising the transcribed output.

➡ Third-Party Dictation

USING THIS GUIDE

The first chapters are, of course, focused on the basic use of the software. If you work through the first 
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half of this Guide, you should find that DNS will begin to make your professional work more efficient and 

productive. Don’t feel you have to learn everything in this Guide to enjoy DNS. In fact, many of our cus-

tomers enjoy the benefits of DNS without even touching some of the advanced features of the software. 

However, don’t hesitate to read the introductions to each chapter. You may find that the content discussed 

in a particular chapter may have direct relevancy to your work, or stimulate an idea on how to get more 

from DNS.

ADVANCED TOPICS

This Guide is designed to give individual users of Dragon NaturallySpeaking Professional Series a very 

complete understanding of how to use this powerful software application. While some administrator-level 

topics are presented, it is not the intent of this Guide to provide all the information System Administrators 

may need to manage multiple installations of DNS throughout an enterprise.

If you need information for enterprise management of DNS, consult your Nuance Certified Partner or 

contact American Dictation.

ADDITIONAL ASSISTANCE

If, after using this Guide, you feel you need additional assistance, contact your DNS vendor or American 

Dictation. As a Nuance Gold Certified Partner, we can provide qualified training and support for all DNS 

products. There may be fees or costs associated with our services.

And before you ask, yes, this Guide was written using speech recognition.
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WHAT’S NEW IN DRAGON 10
Dragon NaturallySpeaking 10 represents an improvement over Version 9 in several key areas. The follow-

ing are the most important improvements as touted by Nuance. While you may not experience all of these, 

they do bring to Dragon new conveniences and functionality designed to keep Dragon the market leading 

speech recognition software application. Some of these will be explored in greater detail in later pages.

An additional change is that Nuance has further segmented the Medical version by calling it Dragon 

Medical, not Dragon NaturallySpeaking Medical. We’re not quite sure why they’re separating Medical 

name-wise, but Dragon Medical does have a host of features not found in other professional versions.

Where applicable, we will indicate features unique to Dragon Medical. Otherwise, you can assume that 

features and techniques described in this book are applicable to Professional, Legal and Medical versions of 

Dragon.

DRAGON VOICE SHORTCUTS

In earlier versions of Dragon NaturallySpeaking, you could only give commands from within certain ap-

plications. Of course, you could create macros that would open an application and perform functions. Nu-

ance understood that many users would like to easily command the computer to do the most common 

tasks, such as searching, surfing the Web, or sending e-mail. To that end, Dragon 10 introduces Dragon 

Voice Shortcuts.

DRAGON VOICE SHORTCUTS FOR DESKTOP SEARCH

Now you can use normal speech to command your computer to do a Google Desktop or Microsoft Vista 

search on your computer.

➡ Voice Shortcuts for Desktop Search

DRAGON VOICE SHORTCUTS FOR WEB SEARCH

Even if your Web browser (e.g., Internet Explorer, Firefox, Safari) is closed, you can command your com-

puter to search the Web simply by saying such a common phrase as “Search the Web for Houston Astros.”
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➡ Voice Shortcuts for Web Search

DRAGON VOICE SHORTCUTS FOR E-MAIL AND CALENDAR

Once you have allowed Dragon NaturallySpeaking to learn your Outlook contacts, you can command 

your computer to create e-mail messages and set up appointments even if Outlook is not initially running. 

This should be one of the greater time-savers of the Dragon 10 improvements.

➡ Voice Shortcuts for E-mail and Calendar

IMPROVED AUTO-TRANSCRIPTION

In previous versions, the Auto-Transcribe function would simply create a text file of your dictation. In 

Dragon 10, you can select to have a .DRA file saved along with the text file. The .DRA file contains acoustic 

information that lets you open the transcribed text file and play it back and make corrections, much like 

you do with normal third-party editing functionality.

NEW USER TRAINING OPTIONS

In Dragon NaturallySpeaking 10 there are now three training options for setting up new user profiles:

❖ No Training. With this option, Dragon will still have the user allow Dragon to adapt to the volume and 

quality of the users sound input device.

❖ Short Training. Only about 5 minutes to conduct, Dragon guides a user through one of several pas-

sages. Provides greater initial accuracy than “No Training.”

❖ Special Training. For maximum accuracy, users can select to do Special Training, where they are 

asked to read one of several longer passages. If users have any speech impairments or problems in 

speech, “Special Training” can greatly improve accuracy.

➡ Initial Training Options

REGIONAL ACCENT SUPPORT

English speakers vary widely in how they talk. If you’ve ever traveled across America, you’ve surely recog-

nized regional differences. DNS Professional now includes new acoustic models to meet most non-native 

and USA regional accents:
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❖ General. For speakers whose dialect is not covered by other specific choices.

❖ Australian-accented English.

❖ British-accented English.

❖ Indian-accented English.

❖ Inland Northern US. This covers the region of the US from northern New York through Chicago, oth-

erwise known as the Great Lakes regiona.

❖ SEAsian-accented English.

❖ Southern US. Covers most of the southern US, including Texas.

❖ Spanish-accented English.

ACCURACY TUNING AND DATA COLLECTION

User and System Administrators can configure Dragon to automatically run:

❖ Accuracy Tuning. Adds commonly used word sequences dictated by the user, acoustic data from any 

corrections, and any additional training by the user to the user’s profile. In previous versions, this was 

often referred to as Acoustic Optimization; in Dragon 10 it’s even more powerful and convenient. 

Regular scheduling will insure that your profile is at maximum accuracy.

❖ Data Collection. The quality of Dragon NaturallySpeaking rests largely on the ability of the “engine” 

to accurately predict word combinations based on sound input. Nuance, in an effort to continually 

gather statistical information for future improvements, allows users to regularly send up to 500 MB of 

data to Nuance. No personal information is ever transmitted and participation is purely voluntary.

➡ Accuracy Tuning and Data Collection

IMPROVED WEB COMMANDS AND DICTATION

In previous versions, it sometimes became very difficult, if not impossible, to dictate into Web forms 

without invoking HTML commands. If you dictated a word or phrase that matched an HTML link, for in-

stance, you could find yourself taken to another Web page and all your form entries would be lost.

In Version 10, you now have two options as to how you wish Dragon to respond to commands in Web 

pages:
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❖ Enable Commands in HTML Windows. Allows the use of commands designed specifically for use 

with Web browsers (e.g., Internet Explorer), as well as in certain Microsoft Outlook dialog boxes.

❖ Required “Click” to Select Hyperlinks in HTML Windows. To make a browser understand when you 

wish to click on a link, as opposed to dictating actual content, you can choose to require that you say 

the word CLICK whenever you dictate a link.

In addition, some browsers interpret dictation as single-word HTML commands. In Version 10, some 

single-word commands have been replaced:

Previous Command Version 10 Command

REFRESH REFRESH PAGE

RELOAD RELOAD PAGE

STOP STOP LOADING

HOME GO HOME

NEXT NEXT CONTROL

➡ Web Browsers

VOICE FIELDS IN DRAGONTEMPLATES

We feel this is one of the more exciting development to aid in creating workflow efficiency without ex-

traordinary programming. You can create Text and Graphics commands where the user can navigate be-

tween variable fields (by saying NEXT [VARIABLE/FIELD] or PREVIOUS [VARIABLE/FIELD] and typing or 

dictating a specific value.

➡ Text and Graphics Voice Fields

QUICK VOICE FORMATTING

Right on the heels of Voice Fields in creating greater efficiency is the new Quick Voice formatting feature 

of Dragon NaturallySpeaking 10. There are new commands that reduce the complexity of selecting and 

modifying text:

‣ DELETE [text] / DELETE FROM [text] TO [text] / DELETE [text] THROUGH [text] – deletes 

the specified text or range of text.
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‣ CUT [text] / CUT FROM [text] TO [text] / CUT [text] THROUGH [text] – cuts the specified 

text or range of text.

‣ COPY [text] / COPY FROM [text] TO [text] / COPY [text] THROUGH [text] – copies the 

specified text or range of text.

‣ BOLD [text] / BOLD FROM [text] TO [text] / BOLD [text] THROUGH [text] – bolds the 

specified text or range of text.

‣ ITALICIZE [text] / ITALICIZE FROM [text] TO [text] / ITALICIZE [text] THROUGH [text] – 

italicizes the specified text or range of text.

‣ UNDERLINE [text] / UNDERLINE FROM [text] TO [text] / UNDERLINE [text] THROUGH 

[text] – underlines the specified text or range of text.

‣ SELECT [text] / SELECT FROM [text] TO [text] / SELECT [text] THROUGH [text] / SELECT 

FROM [text] TO [text] – selects the specified text or range of text.

SUPPORT FOR DICTAPHONE POWERMIC (MEDICAL ONLY)

Months ago, Nuance purchased Dictaphone. This brought to Nuance a sales force that had experience 

selling to medical markets. It also brought the hardware Dictaphone had developed, specifically the Pow-

erMic desktop recorder. While other desktop recorders will work well with Dragon, Nuance naturally in-

cluded configuration aids for those using the Dictaphone PowerMic or PowerMic II devices.

MEDICAL FORMATTING

Dragon Medical has a new interface for formatting options pertaining to how such dictated items as 

times, dates, units of measure, and medical acronyms are to be displayed.

➡ Medical Formatting Rules

CORRECTION-ONLY MODE (LEGAL AND MEDICAL ONLY)

In earlier versions of Dragon, if a third-party wanted to correct a dictation (see Correcting Saved Dicta-

tion), the editing party would have to have the author’s profile in order to make corrections to a transcribed 

file. In Correction-Only Mode, the editor can make corrections to the transcription that will contribute to 

the optimization of the author’s profile. In this mode, corrections can only be made by keyboard.
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IMPROVED WORD PROPERTIES DIALOG

The Word Properties dialog in Version 10 has been improved to allow more controls on how DNS for-

mats dates, measurements and acronyms.

AUTO SYSTEM CONFIGURATION

Many times, users of previous versions found optimizing the Dragon settings to match the capabilities of 

their computer to be rather complex and convoluted. With Version 10, the Dragon NaturallySpeaking Pro-

fessional installation process will analyze your computer and make changes to the default settings to opti-

mize software performance. These may include disabling Natural Language Commands or adjusting the 

Speed vs. Accuracy slider. Once installed, users can modify these settings, but initially, these adjustments 

can help improve speed.

There are other changes in Version 10 not specifically listed here, but which are included in this Guide. 

Where possible, we denote Version 10 changes with .

If you’re familiar with earlier versions of DNS Professional, these should be quite evident as you read on. 

For those new to Dragon NaturallySpeaking, you will find Version 10 to be a real time-saver when doing 

creating dictation and controlling your computer by voice.
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WORKFLOW

 When most people think of using speech recognition software, they envision a tool that will allow them 

to speak into a microphone and have their voice converted instantly into text. Dragon NaturallySpeaking 

can do just that and more. DNS cannot only be used to convert voice to print, it can be used to control 

many aspects of your computer. It can also be used as a transcription tool, to give transcriptionists increased 

productivity when processing an author’s dictation.

Before we dive into how Dragon NaturallySpeaking can be used, it’s important to note its limitations:

❖ Dragon NaturallySpeaking cannot be used to interpret conversations or interviews. DNS interprets 

what it hears against a preassigned user profile. DNS cannot distinguish between multiple voices. Fur-

thermore, people engaged in conversation do not speak in a “dictation” style. That is, conversation 

participants do not dictate punctuation or speak in complete sentences. Our tests have shown that 

when trying to use DNS to interpret a conversational interview, the results are very disappointing.

❖ Dragon NaturallySpeaking will make mistakes. Just as we often misunderstand what others say, DNS 

will sometimes do the same. Fortunately, Dragon NaturallySpeaking includes powerful, easy-to-use 

correction tools. Additionally, by properly making corrections using DNS, the software will learn from 

its mistakes and improve its accuracy over time.

❖ Dragon NaturallySpeaking requires patience. We’re often asked if there are demos of the software 

available for evaluation. To get the most from DNS, a significant amount of time is required initially to 

train the software and to learn how to utilize it for maximum productivity. For some, this may take 

only a few days. For others, a few weeks. When evaluating software, most people only spend a few 

minutes. A brief evaluation of Dragon NaturallySpeaking will not adequately reveal its true power.

DIRECT DICTATION

Dragon NaturallySpeaking is usually promoted for use as a direct dictation tool. By “Direct Dictation,” we 

are referring to the practice of using a headset or freestanding microphone, and using DNS to interpret our 

voice instantly. This also allows us to use Dragon NaturallySpeaking to command other aspects of our com-

puter, such as opening applications and saving documents.

Direct dictation, based on experience with our customers, is used by authors who need immediate visual 
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feedback of their dictation. For example, a radiologist who is dictating into a PACs system, will need the 

ability to see what they are dictating, not only to assure accuracy, but so that their dictation is inserted in 

the proper fields.

Using Dragon NaturallySpeaking in a “direct” mode also gives the author the ability to multitask, to move 

between applications, such as e-mail and word processing, by using voice commands.

Much of this Guide contains information pertaining to the use of Dragon NaturallySpeaking as a direct 

dictation application.

➡ Direct Dictation

THIRD-PARTY DICTATION

A large number of our customers are professionals who are already dictating a great portion of their work. 

They have traditionally recorded their dictation on tapes or digital voice recorders, and transferred these 

recordings to a transcriptionist who types by listening to the recordings and using a foot switch to control 

the playback. This methodology has been used for almost 100 years, since the days of Thomas Edison.

One of the often overlooked features of Dragon NaturallySpeaking is its ability to transcribe recordings. 

Where an author prefers to concentrate more on dictating, and less on correcting and formatting, DNS can 

be used by a “third party” to process the voice file, producing a text output.

Simply described, an author records their dictation using a device that produces a digital audio file. The 

third-party editor (e.g., a transcriptionist) imports the voice file into Dragon NaturallySpeaking. The soft-

ware converts the voice to text using a profile trained from the author’s voice. The editor then corrects and 

formats the resulting output. By allowing Dragon NaturallySpeaking to make the “first pass” of the transcrip-

tion, we have noted as much as a 70% decrease in turnaround time. This methodology also reduces repeti-

tive stress injuries, such as carpal tunnel syndrome. It also gives both the author and the editor more time to 

commit to other activities.

The downside of third-party dictation is that it requires more set up and training than direct dictation.

➡ Third-Party Dictation

For those who dictate many, many files each day – radiologists are a good example – DNS provides the 

ability to create an “Auto Transcribe” folder. Digital voice files deposited in such a folder can be automati-

cally transcribed by DNS, producing a text file that can be pasted into a final document.

➡ AutoTranscribe
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ROAMING USERS

The professional versions of Dragon NaturallySpeaking (except for the Small Medical Practice versions) 

allow the software to be set up so that the author can dictate from more than one workstation using the 

same user profile. Since the accuracy of Dragon NaturallySpeaking improves over time as a user profile is 

enhanced by corrections and vocabulary additions, it is better served by using the same user profile every 

time Dragon NaturallySpeaking is used on their behalf.

The feature which allows one user profile to be accessed from multiple workstations is called “Roaming 

Users.”

➡ Roaming Users

 Where roaming users are used, Dragon Medical and Legal 10 versions include the ability to set 

“Correction Only” mode. This mode allows an editor using Dragon to make corrections in saved transcrip-

tions and have those corrections impact the author’s profile. The profile does not have to be trained or 

tuned for the editor’s computer.

➡ Corrections Only Mode

CHOOSING THE RIGHT METHODOLOGY

Each of these workflow methodologies is referred to within this Guide. Since many of the features of 

Dragon NaturallySpeaking apply to more than one workflow, we have tried to note where particular func-

tions and features are applicable to only one or two of these methodologies.

As you go through this Guide, you will soon discover that there are certain advantages and disadvantages 

to each methodology. The good news is, you do not have to limit yourself to only one. You may find that in 

some instances, direct dictation is advantageous (e.g., dictating e-mails), while in others third-party editing 

is more productive.

If you need help in deciding which methodology is most appropriate for your workplace, consult your 

Dragon NaturallySpeaking vendor, or contact American Dictation.
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INSTALLATION

If you have yet to install DNS Professional on your computer, or you are considering buying DNS Profes-

sional, this chapter covers:

❖ Minimum system requirements. What do you need to run DNS on your computer?

❖ Installation procedure. Step-by-step instructions on installing DNS on your personal computer.

Please note that the installation instructions contained herein are taken from instruc-

tions provided by Nuance and from our own experience installing the application. Your 

system may contain software that will interfere with installation. Additionally, as with 

the installation of any software, adding new programs to your computer may change its 

behavior in unexpected ways. If you need assistance in installing DNS on your computer, please 

contact your DNS vendor.

SYSTEM REQUIREMENTS

The following are the minimum requirements you should have in order to use DNS productively:

❖ Intel Pentium 4 (or equivalent AMD processor) 1 GHz processor or greater. Recommended: 2.4 GHz 

(1.6 GHz dual core processor).

❖ 512 MB RAM minimum. 1 GB RAM recommended. 1 GB RAM required for Windows Vista.

❖ 512 KB minimum L2 Cache. 1 GB L2 Cache recommended.

❖  Minimum of 1 GB of free hard disk space for a custom installation. Minimum of 25. GB for 

Dragon Medical.

❖ Windows 2000 or Windows 2000 advanced server (service pack 4 or higher), Windows server 2003, 

Windows XP Pro or Windows XP Home (SP1 or SP2), Windows Vista Home Basic or higher (32-bit 

only). Windows ME and Windows NT are not supported.

❖ Sound card capable of recording, set to 16-bit, 11 kHz for audio recording.

❖  Microsoft® Internet Explorer six or higher.
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❖  DVD drive required for installation.

❖ Nuance approved noise canceling headset microphone, or compatible digital recording device.

❖ An Internet connection for product activation and automatic updates.

Dragon NaturallySpeaking is licensed on a “per individual” basis. You are permitted to 

install the software on more than one computer (for example, on a desktop and a lap-

top computer, or on a work computer and a home computer), although you may not 

use the software concurrently on more than one computer, and you are permitted to 

create multiple voice profiles, so long as each voice profile is for you. If someone else desires to 

create or use another voice profile, however, that person must purchase a separate license for 

Dragon NaturallySpeaking. Volume license agreements are available. Contact American Dictation 

for more information.

INSTALLING DRAGON NATURALLYSPEAKING

Installing DNS is basically straightforward:

1. Turn off any virus protection software and close all other applications.

2. Insert the DNS CD into your DVD drive. Setup should begin automatically. If it doesn’t, navigate to 

your DVD under My Computer and double-click Setup.exe.

When installing on Windows Vista, you may see a message, “A program needs your 

permission to continue.” Click Continue to being the installation.

3. Follow the on-screen instructions.

4. If this is your first installation of DNS, choose “Typical/Complete” for your setup time. This will in-

stall all options and speech files. Click Next  to continue.

5. If you want DNS to launch at system startup, enable QuickStart. This will also add an icon to the 

Windows taskbar.

6. If you need DNS to upgrade user profiles from Version 8 or 9, select “Upgrade existing speech files 

to work with the installation.”

7. Click Finish  to complete the installation. You may be prompted to reboot your computer.
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ACTIVATING DNS

 The first time you start DNS, you will be prompted to activate your copy of Dragon NaturallySpeaking. If 

you do not activate the software, DNS will stop working after starting the program five times.

You must be connected to the Internet to activate the product. Follow the on-screen instructions to acti-

vate the software automatically.

If you make any hardware changes on a machine where DNS is installed, you may be 

prompted to activate again. To preserve your activation status, you can uninstall DNS, 

making sure to keep your user files when prompted, before you make your hardware 

changes. After making changes to your hardware, then reinstall Dragon NaturallySpeak-

ing.
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USER PROFILES

SETTING UP AND MANAGING USERS

 Before you can begin using DNS, you must create a user profile. A user profile is an acoustic analysis of 

your voice that DNS uses to recognize your dictation. User profiles also store any changes you make to the 

vocabulary.

When DNS first starts, you’ll be asked to create your first user profile. Use this opportunity to begin using 

DNS for the first time. Don’t be afraid of making mistakes. You can always create a new user profile if you 

choose not to continue using this initial one.

DICTATION SOURCES

One of the powerful features of DNS Professional, is its ability to allow you to use multiple input devices. 

With the same user profile, you can dictate using a noise canceling headset, a portable digital voice re-

corder, or a desktop microphone. Regardless of what input device you choose to use most often, we sug-

gest you begin using the included headset microphone to create your first user profile. This will give you the 

best opportunity to not only train DNS to understand your voice, but to train yourself on how to use 

Dragon NaturallySpeaking.

Later in this section, you’ll learn how to designate multiple input devices for your user profile.

CREATING YOUR FIRST USER PROFILE

If the create new user dialog is not open, go to

NaturallySpeaking > Manage Users…

Click on New… .  The following dialog box will appear:
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In “Your name,” enter your name. You may want to add a descriptive name, such as “Joe-test profile.”

Next, choose an appropriate language from the pop-up menu:

As you can see, DNS allows for variations of the English language. Choose the one most appropriate.

 Underneath Language is a new pop-up selector for “Accent.” DNS 10 now increases its accuracy by 

matching the speaker to the most appropriate accent.

If you’re not sure if you fall into any of the available accent choices, leave this selection as “General.”
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For your first user profile, it is recommended that you use the included headset for your initial dictation 

source. You can, however, use DNS with a wide variety of input devices:

We will cover some of the other devices, and how to use them with user profiles, later in this Guide.

Next, choose the appropriate vocabulary based on the version of DNS 10 you have installed. For Dragon 

Medical 10, the vocabulary choices are quite extensive. To help you choose the ideal vocabulary based on 

your specialty, see Choosing a Medical Vocabulary.

To continue, click  Next > .

The next screen is helpful information on the positioning of your microphone headset. For best results, 

the microphone should be positioned in front of your mouth no more than 2-3 inches away. Once you 

have a headset comfortably placed, click Next > .

The next two screens allow DNS to adjust its own sound settings for maximum results. Follow the on-

screen instructions, making any adjustments to your microphone if necessary. If DNS has trouble hearing 

you, make sure your headset is plugged into the appropriate input jacks on your computer. You may need 

to also adjust your sound control panel input and output settings for your headset.

INITIAL TRAINING OPTIONS

 Dragon 10 now allows you three choices in terms of training:

❖ No Training. No analysis is done of your voice. Dragon has amazing transcription capabilities without 

training, but you may notice that accuracy is not as high as if you do some training.
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❖ Short Training. Dragon guides you through an approximately 5 minute training exercise to help it 

learn how you speak.

❖ Special Training. Using longer passages, DNS does a more in-depth analysis of how you speak. This 

method is also used to analyze training dictation using a handheld voice recorder.

While, technically, DNS requires “no training,” to set up a user profile, we highly rec-

ommend that you take the few minutes needed to train DNS for your voice. Even doing 

the “Short Training” will not only increase the initial accuracy of Dragon NaturallySpeak-

ing, but will help you learn to speak to the DNS in a pace and style that will also in-

crease its accuracy.

“Short Training” is only available for a user created with a headset microphone. “Special Train-

ing” is required when using other types of input devices.

Upon completion of the training exercise, DNS will compile your user profile. Afterwards, Dragon Natu-

rallySpeaking will give you an opportunity to further increase accuracy by allowing it to analyze any previ-

ous documents you have on your computer, as well as sent e-mails should you wish to use Dragon Natural-

lySpeaking for composing e-mail communications.

VOCABULARY OPTIMIZER

 Allowing DNS to adapt to your writing style can, based on our own personal experience, tremendously 

increase its accuracy when transcribing your dictation. Since DNS bases its interpretations in large part on 

the statistical association of words, learning how you assemble phrases helps DNS interpret your dictation.

In the Vocabulary Optimizer, you can choose to have DNS analyze your documents and/or e-mail. If you 

choose to have your e-mail analyzed, names from your contact book in Microsoft Outlook will be added to 

your vocabulary. The e-mail analysis only works with Microsoft Outlook, Microsoft Outlook Express, or 

Lotus Notes. Furthermore, DNS will only analyze your sent e-mails, as those reflect your writing style.

Using the browse feature, you can choose Microsoft Word, WordPerfect, text, Rich text format and HTML 

files within your Documents folder (i.e., My Documents). The more documents DNS has an opportunity to 

analyze, the more benefit will be derived.

The Vocabulary Optimizer will only scan documents that are larger than 512 bytes and 

are less than 90 days old. If you want to analyze older documents, re-save them to 

create a later modification date.

Depending on the number of documents and e-mails scanned, the optimization process can take a while. 

You can choose to run this function at a later date, but if you can at least have it analyze a few documents 

at this point, you will become more familiar with the process and the results.
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Once the files are scanned, DNS will present you with a list of unknown words, abbreviations and acro-

nyms. You can choose which ones to add to your vocabulary. You may not wish to add all of them, if some 

are only rarely used or represent a unique special use or spelling.

ACCURACY TUNING AND DATA COLLECTION

 With Dragon 10, a new step in the User profile creation process is an inquiry to you as to whether 

or not you wish to have DNS tune your profile on a regular basis and if you wish to have your voice data 

communicated to Nuance to help improve future versions of the DNS speech recognition engine.

ACCURACY TUNING

In order to keep your user profile optimized for accuracy, you can schedule DNS to tune your profile on a 

periodic basis. The default is every week in the early morning hours. By clicking Configure… , you can 

modify this schedule. DNS and your computer must be on and running for this activity to occur. Accuracy 

tuning takes into account corrections and changes you have made to your user profile and re-compiles your 

user profile. If you don’t do this automatically, you can still invoke optimization using the Acoustic Opti-

mizer in the Accuracy Center.

DATA COLLECTION

One of the least-understood new features of DNS is Data Collection. In essence, by configuring and al-

lowing Data Collection, you are sending recognition to Nuance to help them improve future releases of 

Dragon NaturallySpeaking. Nuance assures us that no personal or private information is being conveyed 

during this action. There have been some concerns about vocabulary information, such as proper names 
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(which might be patient names) and the like, but Nuance tells us that the data transferred could not com-

promise HIPAA compliancy.

By allowing Data Collection, you will be helping to improve Dragon in the future; speech recognition 

technology is a continually evolving science and the more real-world information Nuance can gather will 

certainly help. However, if you feel reluctant for any reason to share this information, select “Don’t run 

Data Collecting for this user.”

MANAGING USER PROFILES

If more than one person is using DNS on a single computer, you can create user profiles for each user, 

keeping separate voice and vocabulary information for each. Additionally, you may wish to create different 

user profiles for each type of input device you wish to use (however, you may wish to simply add devices to 

one existing profile for a given user – see the Multiple Dictation Sources for details).

CREATING A NEW USER

To create a new user, go to:

NaturallySpeaking > Manage Users…

Click  New…  to start the New User wizard. Follow the wizard as you did when doing the initial 

training, or as applicable based on the selected input device. For connected devices, such as headsets, mi-

crophones or wireless headsets (connected via USB or Bluetooth), following the training wizard provided. 

For other portable devices, follow the appropriate training wizard, but review the following section for in-

formation important for these types.

OPENING A USER

Once a user profile is created, you can open it for use by going to:

NaturallySpeaking > Open User…

From the list of user profiles shown, choose one and click  Open .

USING HANDHELD RECORDERS

One of the more popular input devices among our customers are the portable digital voice recorders 

from Olympus, Philips and Sony. These devices give the dictator mobility and convenience, while allowing 
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the use of DNS for transcribing the dictations.

 For professional use, based on the experience of our customers and our own internal 

testing, we highly recommend the use of either the Olympus DS-5000, Philips DPM 

9600, or Philips DPM 9500 as portable digital voice recorders. These devices not only 

provide quality recordings, but have proven themselves to be rugged enough to endure 

professional, daily use. The Olympus DS-5000 and Philips DPM 9600 also have the added benefit 

of recording in “DSS Pro” format, giving DNS a higher fidelity recording and thereby better accu-

racy.

For more information on these devices, visit www.AmericanDictation.com.

Creating a user profile for using a digital voice recorder is not the same for each brand or device. Using an 

Olympus recorder is perhaps the easiest to train, as DNS has programming built-in to take your dictated 

training and process it directly. Using a Philips recorder requires you to convert the recording to a format 

that DNS can interpret, then importing it into the training wizard. Not a particularly difficult process, but 

one that nonetheless requires a few extra steps.

The training process for creating a user profile to use a portable voice recorder is as follows:

❖ Select from the setup wizard one of several selected readings. Some are for business, some for teens, 

and others for general. Some are designated “harder,” while some are easier to read.

❖ Either reading from the computer screen, or from a printed copy, dictate at least 16 minutes of the 

reading into a voice recorder. The entire reading may take as long as 30-40 minutes. As with anything 

involving DNS, the more you read, the more accurate the created profile. However, it is possible for 

DNS to create an acceptable acoustic model of your voice from a 16 minute reading. When reading 

the script do not dictate punctuation. Read it as if you were reading it to another person.

❖ Once the dictation is completed, DNS will import the voice file and use it to create your user profile. 

This process can take as long as an hour or more, depending on the speed of your computer and the 

length of the recording. During this process, DNS is comparing the recording to what it knows is in the 

selected reading to create the acoustic profile.

❖ As with the headset training, you will then have an opportunity to allow DNS to analyze your docu-

ments and emails, although if you will be using a handheld recorder for most of your dictation, you 

probably will not be dictating e-mails in the same manner you would if you were dictating directly 

into your computer.
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 One of the best pieces of advice we learned when using DNS was to dictate as if you 

were delivering the nightly news on television. News anchors don’t speak too slow or 

too fast. Their diction is good, and they speak in discernible phrases. Their job is to help 

the viewers understand what they are saying as quickly and easily as possible. Like a 

viewer, DNS wants to easily understand what you say. You can help by imitating the delivery 

style of your favorite news anchor.

You can skip the commercial breaks, too!

USING OLYMPUS RECORDERS

Dragon integrates well with Olympus pro recorders in terms of creating user profiles. We have long used 

Olympus DS-4000 and DS-5000 recorders successfully to dictate using Dragon.

When creating your user profile, select “Olympus DVR” for dictation source. Then, following the wizard, 

record at least 16 minutes of your selected text into your recorder.

The wizard will tell you when to dock your recorder and will instruct you on how to select your profile 

recording and give it to Dragon to process.

If you have your Olympus DSS Player Pro software set to automatically download re-

cordings when your recorder is docked, you will need to turn auto-download off before 

docking your recorder. During the Create User wizard, Dragon will open an “abbrevi-

ated” form of the DSS Player and ask you to select the recording on the recorder for 

processing. If the file is auto-downloaded first, then you will not be able to select it for process-

ing. If you have your DSS Player Pro set to not delete downloaded files from the recorder, then 

you’re okay, but for safety’s sake, turn auto-download off before proceeding.

Once you begin using the Olympus recorder to dictate for DNS, you can select any downloaded voice 

file and click the red dragon icon on the tool bar to send it to DNS for processing. Dragon NaturallySpeak-

ing, however, must already be running and the appropriate user profile chosen.

If it is your job to create a new user profile for an Olympus Digital voice recorder, and 

the author sends you their training file, you can still set up an appropriate user profile 

without access to the DSS Player Pro dictation module. Have the author convert their 

training voice file to a wave file using the dictation module. Instead of selecting the 

Olympus digital voice recorder as an input device when creating a new user profile, select the 

last choice, “Digital recorder using sound file…” Follow the instructions in the new user wizard 

and import the converted voice file when indicated.

For more on processing dictation files from a recorder, see Dictating with a Portable Digital Voice Re-

corder.
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USING PHILIPS RECORDERS

Although SpeechExec software includes a “dragon” icon to send downloaded dictation files to DNS for 

processing, DNS does not communicate with SpeechExec during training. Therefore, the process for train-

ing DNS for use with Philips DPM recorders is different than for Olympus recorders.

1.  For input device, select “Digital recorder using sound file…”

2. After dictating the selected training piece, dock the recorder and download the recording into 

SpeechExec as you normally would with any dictation file.

3. Select the file in your “finished” folder (or other designated folder in SpeechExec) and go to

File > Convert File…

4. In the dialog box, choose PCM Format, 11 or 22 kHz, 16-bit, Mono. Designate a destination to save 

the converted output.

5. In the DNS wizard, you will be asked to import the sound file. Find the converted file you created. 

DNS will then import the file and use it to create your user profile.

Once your profile is created, you can simply select a downloaded file in SpeechExec and click the “bal-

loon” icon for speech recognition. The file will be automatically converted to a DNS compatible format and 

processed.

For more on processing dictation files from a recorder, see Dictating with a Portable Digital Voice Re-

corder.

MULTIPLE INPUT SOURCES

As you begin working with your new DNS user profile, Dragon NaturallySpeaking will continually update 

your profile to reflect corrections and vocabulary additions you make. Over time, DNS will make fewer and 

fewer mistakes when transcribing your dictation. While it is quite feasible to create multiple user profiles – 

one for each input device – improvements made to one user profile would not be applied to the other user 

profiles. In order to maintain one user profile, yet use multiple input devices (e.g., digital voice recorder, 

headset, wireless microphone), it is suggested that you train multiple devices against one user profile. This 

technique is especially useful when using the Roaming User feature, discussed later in this Guide.

Creating alternative input devices for one user profile is an excellent way to extend your 

dictation capabilities while continuing to improve the accuracy of your user profile. You 

could conceivably create multiple input sources for a headset, desktop recorder (like the 

Philips SpeechMike), a handheld recorder, wireless USB headset or array microphone.
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To add an additional dictation input source to an existing user profile:

1. Go to:

NaturallySpeaking > Open User…

2. Click Source , then New .

3. Select a new input device from the list in the dialog box:

4. Click OK .

5. Select the user profile and click Open . If you have not previously trained with the new 

dictation source, the New User wizard appears and you can begin training.

Once you create additional input sources for your user profile, you can select the appropriate device 

prior to transcribing your dictation.
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THE DRAGONBAR

When using Dragon NaturallySpeaking on your computer, a special toolbar will appear at the top of your 

screen. This is called the DragonBar and contains menus and buttons to give you quick and easy access to 

the many features and functions of Dragon NaturallySpeaking.

 The DragonBar can be positioned in different places on your desktop. Its appearance can also be ad-

justed easily by clicking on the Dragon icon on the left, or right clicking anywhere on the DragonBar.

MICROPHONE ICON

 The second icon from the left is a microphone icon. Click this icon to turn the microphone off or on. 

When the icon is red and horizontal, the microphone is off. When the icon appears green and vertical, the 

microphone is on and the program is ready for you to dictate.
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VOLUME DISPLAY

To the right of the microphone icon is the volume display, pro-

viding a visual indication of how well the program is hearing your 

voice. If you are not getting the accuracy you expect, use this indi-

cator to see if the computer and DNS are receiving a sufficient 

volume level.

SELECT-AND-SAY® INDICATOR

The round circle to the right of the volume display is the Select-and-Say indicator. Normally, you 

can dictate and use DNS for commands in any text window of any application. However, you may 

occasionally find an application or a specific window in an application where some voice com-

mands will not work or not work consistently.

 The Select-and-Say Indicator turns green when you are in an application or window where all of Dragon 

NaturallySpeaking’s functionality is supported. When you’re in a nonstandard window (a window that does 

not adhere to normal Windows conventions), this indicator goes out, indicating that you may have some 

difficulty selecting and editing dictated text. When you start dictating into a nonstandard window the 

Dragon bar will display the message, “dictating into a nonstandard window.”

EXTRAS

By clicking the  button on the right end of the Dragon bar, you can display the extras toolbar. This 

second row of buttons are used for playing back previously recorded dictation, making corrections using 

the keyboard, and changing user profiles. The Extras toolbar is particularly helpful when editing someone 

else’s dictation (i.e. Third-Party Dictation).

THE RESULTS BOX

As you dictate, you may notice the small, floating box that displays text or commands after you speak 

them. This shows you what DNS is initially hearing. After Dragon NaturallySpeaking processes what is 

heard, the end results are entered into your document or the command is executed. What is shown in the 

Results Box, therefore, is sometimes different than what is eventually typed or executed. DNS takes what it 
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hears and processes it against the user profile, configuration rules, and known vocabularies to produce the 

end result.

When DNS recognizes that you have spoken a command, the borders of the results box turn blue, except 

when you say dictation commands such as NEW LINE or NEW PARAGRAPH.

Throughout this Guide, when you are being instructed to say a command in DNS, the 

command will be in all caps (as in DELETE THAT). Other parts of instructions that are 

variable – where you can say what you wish – are shown in lowercase, such as in 

MOVE LEFT [number] WORDS.

Dragon NaturallySpeaking allows you to modify the behavior of the Results box to suit your needs:

❖ To prevent the Results box from moving, right click the Results box, click “Anchor,” and use the mouse 

to drag the Results box to wherever you want it. You can also select “Anchor” in the View tab of the 

Options dialog window.

❖ To close the Results box after a recognition, double-click the Results box.

❖ To make the Results box disappear when you are not speaking, right-click the Results box and click 

“Auto Hide.” You can also select “Never show” from the Auto-hide delay list in the View tab of the 

Options dialog window.
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❖ To specify the length of time that the Results box stays open, change the time interval of the Auto-hide 

delay in the View tab of the Options dialog window.
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HELP

The Help menu in DNS presents a quite extensive guide to using Dragon NaturallySpeaking. While we 

feel this Guide is the perfect companion to using DNS, if you’re without this Guide, using the Help menu 

can be a life-saver.

Besides using your mouse to access the Help topics, you can also use voice commands:

‣ GIVE ME HELP – Opens Help window.

‣ CLOSE HELP or QUIT HELP – Closes the Help window.

‣ [MOVE/GO] FORWARD – Displays Help topics.

‣ [VIEW/OPEN] SAMPLE COMMANDS or WHAT CAN I SAY? – Opens the Sample Com-

mands list.
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‣ CLICK [CONTENTS/INDEX/SEARCH] – Selects the Contents, Index or Search tabs in the 

Help window.

‣ Say PRESS TAB KEY four times – Highlights a topic in the Search tab after performing a 

search.

‣ MOVE [UP/DOWN] [1-20] – Move up or down in the Contents, Index list, Search list or 

Select Topic list the given number of times (up to 20).

‣ PRESS ENTER KEY – Opens a topic from the Contents, Index list, Search list, or Select Topic 

list, once it is highlighted. In the Index and Search tabs, you can also say DISPLAY.

SAMPLE COMMANDS WINDOW

When you open the Sample Commands window, you will see a selection of the most useful DNS com-

mands for the current application, including the Windows desktop. If the Sample Commands window is 

active, you can close it by saying CLICK CLOSE (to make the Sample Commands window active, say the 

Open Sample Commands window commands shown before).

If there is no sample list of commands available for the given application, a list of global commands is 

presented.

When this window is open, you can see additional commands that are available to you by clicking the 
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Command Browser at the top of the window. (See Commands for more information on the Command 

Browser.)

NATURAL LANGUAGE COMMANDS

In most cases, you will want Natural Language Commands enabled, particularly if you use the Direct Dic-

tation workflow (see Direct Dictation). This allows you to use voice commands to control many of the 

functions of your most popular applications.

By default, this feature is enabled. To turn it off, click Natural Language Commands  in the Commands 

tab of the Options dialog window.

In the Natural Language Commands dialog window, select the programs with which you wish to use these 

commands.
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In the Sample Commands window, the commands that are available only with Natural Language Com-

mands enabled are shown with an asterisk (*).

During installation, Dragon may choose to disable natural language commands because 

it has determined that your computer lacks sufficient “horsepower.” Natural Language 

Commands require more processing power. If Dragon does disable these, you can turn 

them on using the instructions above and see if they do impact your performance.
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DIRECT DICTATION

Dictating with a headset or hand-held microphone allows you to utilize the full capabilities of Dragon 

NaturallySpeaking to transcribe your voice as well as control many functions on your computer. The effi-

ciency you will gain by using DNS will eventually become commonplace. However, your initial use of this 

application requires you to spend some time learning its many features.

IT STARTS WITH GOOD AUDIO

The position of the microphone as you dictate is extremely important. Your goal is to provide DNS with 

the highest quality audio possible. Of all the input devices you could use, a quality headset, such as the one 

included with the full Dragon NaturallySpeaking Professional package, is perhaps the best to use as it helps 

maintain a consistent distance for the microphone. You may find it more convenient to use a portable digi-

tal voice recorder or a handheld desktop recorder, but if you will be dictating for long periods of time, you 

also will find a headset microphone to ultimately provide you with the most comfort and convenience.

As you begin using DNS with your microphone, take note of the microphone button on the DragonBar. 

When the microphone is on, the color bar indicates the input volume. A yellow color indicates a lower 

than optimum volume; a green bar is for normal volume; and if the volume is too high, the bar color is red. 

Your goal, obviously, is to speak at a level that produces a predominantly green color bar.

USING A HEADSET MICROPHONE

 As previously noted, using a headset microphone is, in most cases, the best input device to use when 

dictating directly into Dragon NaturallySpeaking (if someone else is processing your dictation with DNS, 

refer to the section entitled Third-Party Dictation). For maximum benefit:

❖ Be comfortable. Adjust the headset so that it rests comfortably on your head. Some types of headsets 

fit around the back of your head, or simply hang on your ear. Once you begin using DNS, you may 

want to try different headsets to find one that provides the most comfort and audio quality.

❖ Avoid breathing noises. The headset microphone should be positioned to the side of your mouth to 

avoid distortion that results from breathing sounds.
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❖ Since headset microphones are “noise canceling,” you should make sure that the microphone is 

pointed toward your mouth. The microphone is designed to cut out background noises; therefore, 

look for a mark or arrow on the microphone and use it for positioning.

USING A HANDHELD MICROPHONE

If your microphone of choice is a handheld device, such as the Philips SpeechMike, take note of the fol-

lowing tips:

❖ Be comfortable. Hold the microphone so that it does not create discomfort or strain.

❖ Prevent breath noises. Hold the microphone to the side or below your mouth to avoid picking up 

breathing noises.

❖ Maintain a close distance. Typically, holding the microphone 1-3 inches from your mouth is ideal. The 

distance doesn’t have to be exact, and in some cases – if you have a loud voice, for instance – you 

may find holding the microphone farther away produces better results. Avoid holding a microphone at 

your waist or laying it on your desk.

❖ Desk stands and other devices to hold your microphone may prevent you from maintaining a consis-

tent distance. However, certain array microphones and other input devices can certainly be advanta-

geous if you have limited ability to hold the microphone.

CONTROLLING THE MICROPHONE

 There are two ways to control a microphone: turning it off and on, and putting it to sleep and waking it 

up. The former is controlled by using your mouse or keyboard, the latter by using your voice.

To turn the microphone off and on, do one of the following:

❖ Press the plus key (+) on the numeric keypad.

❖ Click the microphone button  on the Dragon bar.

❖ Click the microphone icon in the Windows taskbar .
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If your keyboard doesn’t 

have a numeric keypad, or 

you’re using a laptop com-

puter which requires the 

use of a function key modifier, you 

may want to “map” the microphone 

on/off to something other than the 

plus key (+). You can map this func-

tion, as well as other keyboard 

“hotkeys” by going to

Tools > Options > HotKeys

Note: “Transfer Text” and “Hidden 

Mode” only are available in Dragon 

Medical.

 To put the microphone asleep, and avoid picking up any voices or noises you may not wish to transcribe, 

say GO TO SLEEP or STOP LISTENING. When asleep, DNS will ignore everything except WAKE UP or 

LISTEN TO ME, which will, of course, signal DNS to begin processing your voice.

 If you use the built-in “switch” in Dragon NaturallySpeaking to turn the microphone on 

– as opposed to using an on/off switch on a connected input device – wait a few sec-

onds before dictating. Dragon NaturallySpeaking needs a couple of seconds to stabilize 

before it can begin processing your voice.

BEGINNING DIRECT DICTATION

If you’ve ever dictated work that was transcribed in a traditional manner by another person, you are al-

ready a long way toward successfully using Dragon NaturallySpeaking. Think of DNS as a transcriptionist 

who would listen to your voice in order to determine not only the words you say, but the context in which 

you say them.
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Dragon NaturallySpeaking has an option to automatically add periods and commas. 

While this generally works fine for some dictation, we have found it much easier to get 

into the habit of dictating all punctuation. It is difficult for DNS to always make the cor-

rect punctuation choices, as there seems to be as many differing opinions regarding the 

use of commas as there are authors. Additionally, this option will not insert any punctuation 

other than periods or commas, such as semi-colons, colons or dashes.

While some transcriptionists may be able to interject the correct punctuation desired, DNS works best if 

you explicitly say most punctuation and capitalization. You don’t have to dictate capitalization for proper 

names or the beginning of sentences.

You should also note that DNS works best when you dictate in phrases – what, in DNS parlance, are 

called “utterances.” By dictating in phrases, Dragon NaturallySpeaking has the best opportunity of under-

standing the context of words. As you dictate you will notice that DNS doesn’t appear to be transcribing 

until you pause. That’s because Dragon NaturallySpeaking is analyzing the entire utterance, rather than the 

individual words spoken. Before you speak, take a moment to compose an entire phrase, utterance, or 

sentence. As you speak, you will notice a small yellow box on the screen that shows the words you are 

dictating. These are the actual words that Dragon NaturallySpeaking is hearing. What you may also notice, 

however, is that the actual text that is transcribed into your document is slightly different than the words 

that flashed within the yellow box. That’s because once DNS captures an entire utterance, it then makes 

adjustments based on context and format.

BASIC DICTATION COMMANDS

 The following commands are the ones most often used by authors. There are many, many more available 

to you. Additionally, you have the ability to create your own commands, using the command browser (see 

Command Browser). For more complete lists of commands, see Command Guides.

For each command shown below, the phrase you speak is quotes (“”). Dictate each command without 

pausing while delivering the command:

‣ NEW LINE – presses the Enter key once

‣ NEW PARAGRAPH  – presses the enter key twice

‣ CAP [word] – types [word] with an initial capital  (“[word]” refers to whatever word you 

dictate at this place in the command, such as CAP trial to produce “Trial”)

‣ CAPS ON – starts typing words with initial capitals

‣ CAPS OFF  – stops typing words with initial capitals
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‣ ALL CAPS [word] – types [word] in all uppercase

‣ ALL CAPS ON – starts typing words in all uppercase

‣ NO CAPS [word] – types [word] in all lowercase

‣ NO CAPS ON – starts typing words in all lowercase

‣ NO CAPS OFF – stops typing words in all lowercase

‣ NO SPACE [word] – does not put a space before [word]

‣ NO SPACE ON – stopped putting spaces between words

‣ NO SPACE OFF – starts putting spaces between words

 To dictate the word “cap,” such as in “baseball cap,” pause after saying “cap.” Other-

wise, DNS will assume it is a command to capitalize whatever follows.

 If you change capitalization or spacing using these commands, DNS will revert to the 

default modes if you click into another part of a document. In other words, changes to 

these modes only affects those words or phrases dictated immediately following the 

command.

PUNCTUATION AND SYMBOLS

To dictate punctuation, say the name of the punctuation, such as PERIOD, or QUESTION MARK. Pause 

briefly before and after the punctuation command so DNS knows to interpret it as punctuation. The same 

process holds for symbols or special characters (e.g., TRADEMARK SIGN).

For a list of punctuation marks and symbols you can dictate, see the Command Guides.

If you are using the UK English, Australian English, Indian English, or Southeast Asian 

(SEAsian) English vocabularies, say “FULL STOP” instead of “PERIOD.”

DRAGONPAD

When you first begin using Dragon NaturallySpeaking, we suggest you begin by dictating into DragonPad 

–  the word processing tool built into DNS. While it may lack the bells and whistles of Microsoft Word, 

DragonPad will help you learn how to dictate and give commands in Dragon NaturallySpeaking.
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To open DragonPad, say OPEN DragonPad, or go to

Tools > DragonPad

Not only is DragonPad a good place to learn DNS, we often use it to do our initial dicta-

tion because of the additional commands and features available. Once we’ve completed 

our first “draft,” we simply cut and paste the dictation into another application. This can 

be particularly helpful if your computer performs better with fewer applications open.

DICTATING INTO APPLICATIONS

With few exceptions, Dragon NaturallySpeaking can type your dictation into any window that allows you 

to type with your keyboard. Therefore, you can transcribe your dictation into a word processor, spread-

sheet, database or other application that allows you to type:

1. Make sure DNS is running and your User Profile is open.

2. Open the application into which you want to dictate.

3. Click the microphone icon on the DragonBar.

4. Click into the window you wish to dictate to make it active.

5. Start dictating.

 When dictating into other applications – other than Dragon NaturallySpeaking – some commands may 

not perform as well as you may expect:

❖ In many programs, DNS sends the text you’re dictating to the application one letter at a time. When 

dictating in a dialog box and the cursor insertion point is not in a text box, this could cause a problem 

if one of the letters dictated matches the access key for an option.
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❖ If you’re having difficulty editing selected 

text, select the text you want to edit and 

say SHOW DICTATION BOX or EDIT 

SELECTION.  When the Dictation Box 

displays, you can dictate and edit text 

using the normal DNS commands. Once 

you’ve completed your dictation and 

editing, say or click “Transfer Text.” The 

created text is then transferred to the 

application.

❖  Since fewer voice commands are nor-

mally available when you dictate into 

other applications, you may find it best to 

correct and format text using your mouse and keyboard.

Dragon NaturallySpeaking does come with additional commands applicable to certain programs. See 

Working With Programs.

 In Dragon Medical, added capabilities have been made to the use of the Dictation 

Box to facilitate the interaction of DNS with EMR (Electronic Medical Records) systems.

Once you have started the Dictation Box, you can open and use other applications while 

continuing to dictate into the Dictation Box. You can review EMR or PACS records, or any other 

applications. Once you decide to transfer your dictation into an application, insert your cursor at 

the point you wish to insert your dictation and say “Transfer Text” (you can also use a hot-key 

command on your keyboard or compatible dictation device).

Additionally, you can operate the Dictation Box in “Hidden Mode,” allowing you to have full use of 

your display while still using the Dictation Box as described above. To invoke “Hidden Mode,” say 

START HIDDEN MODE, HIDDEN MODE ON, or HIDE DICTATION BOX. Your cursor does not 

have to be in the Dictation Box to invoke “Hidden Mode.”

We’re often asked “what applications will work with DNS?” Using the Dictation Box, it’s 

very difficult to find any program with which DNS will not work. In general, if you can 

paste copied text into an application (e.g., field, text box, etc.), you can use the Dicta-

tion Box functionality.

DICTATING SPECIAL WORDS OR PHRASES

Undoubtedly, speech recognition would be infinitely easier if we didn’t have to dictate proper names, 
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acronyms, and other special words and phrases. Dragon NaturallySpeaking, of course, accommodates these 

special cases.

Please note that not all of the special dictation features described in this section will 

work in all other applications. In some cases, you may have to create special com-

mands to produce the same features in other applications. See Commands for more on 

how to create your own commands.

PROPER NAMES AND PLACES

 The vocabulary of Dragon NaturallySpeaking is incredibly extensive. It continues to surprise us how 

many proper names are included. To dictate a proper name, simply say the name. If DNS misinterprets the 

name, you can add it to the vocabulary (see Adding Individual Words).

CAPITALIZATION

To change capitalization of following words, use the following commands:

‣ CAP [letter] – Capitalizes a letter. Say CAP before saying the letter, as in CAP t for “T.”

‣ CAPS ON – Begins typing all following words with initial caps.

‣ CAPS OFF – Stops typing all words with initial caps.

‣ ALL-CAPS [text] – Types the indicated text in all uppercase.

‣ ALL-CAPS ON – Starts typing text in all uppercase.

‣ ALL-CAPS OFF – Stops typing text in all uppercase.

‣ NO-CAPS [text] – Types the given text in all lowercase. Useful if you need to temporarily 

change caps on a few words within a section where all other words are dictated using 

initial caps or uppercase.

‣ NO-CAPS ON – Starts typing words in all lowercase.

‣ NO-CAPS OFF – Stops typing words in all lowercase, returning to the normal method in 

which DNS capitalizes dictated words.

If CAP THAT types the word “that,” you should check and make sure you are not in Dictation Mode. If 

you aren’t, and it still isn’t working, hold down the CTRL key while dictating to force DNS to recognize the 

dictation as a command.
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HYPHENATED AND COMPOUND WORDS

If a word is normally hyphenated, chances are Dragon NaturallySpeaking will insert the hyphen. In cases 

where you wish to insert a hyphen, say HYPHEN.

Where Dragon NaturallySpeaking inserts a hyphen you do not want, select the hyphenated words, and 

say them again. Alternatively, you can say SELECT hyphen, then SPACE BAR.

 To hyphenate the last word you said, say HYPHENATE THAT. You can also select and hyphenate words. 

For example, say SELECT inner space, then say HYPHENATE THAT. Result: inner-space.

To join words into a compound word, say COMPOUND THAT to join the last words you said, or select 

words and say COMPOUND THAT. Spaces, tabs and line breaks between words are removed.

You can also join words by turning “spaces” off. Say SPACES OFF, then dictate the words you wish joined. 

To return to normal, say SPACES ON.

ACRONYMS AND ABBREVIATIONS

Since most common acronyms and abbreviations are already included in the DNS vocabulary, speaking 

them normally may well produce the desired results.

For example, to dictate, “HTML expert needed,” say, H T M L expert needed PERIOD.

Dragon NaturallySpeaking, in many cases, determines the appropriate abbreviation based on context – 

that is, where the word appears in relation to other words. If you dictate “Texas” as part of an address, DNS 

will most likely abbreviate it “TX.” However, if you say “Texas” in another context, DNS will probably spell 

it out. You can force DNS to use alternate forms of words using the Word Properties dialog box.

If the abbreviation or acronym doesn’t exist in the DNS vocabulary, you can add it using the Spell dialog 

window, as you would add any other word.

FORMATTING TEXT

In most programs, you can set a format for style, alignment, font, size, etc. To change the font, size and 

style, you can say any combination of formatting commands. However, you must say them in the order of 

font-size-style. You don’t have to specify all three, but whichever ones you do use must be in that order.

You can use SET SIZE, or SET FONT SIZE. For example:

‣ SET FONT ARIAL ITALICS

‣ SET FONT SIZE 12 POINTS

If you only specify a size, you must say POINTS.
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BULLETED LISTS

If you wish to create a bulleted list (such as this one):

‣ Move the insertion point to the place you wish the list to begin.

‣ Say FORMAT THAT BULLET STYLE.

‣ When ready to begin a new line, say NEW LINE.

‣ When you have finished the last bullet item, say FORMAT THAT BULLET STYLE. This will 

toggle the style, turning the bullet listing format off.

ADDING LINES AND PARAGRAPHS

To add a new line or paragraph, say NEW LINE or NEW PARAGRAPH. Adding a “line” is the same as 

pressing the ENTER key once, and adding a “paragraph” is the same as pressing the ENTER key twice. Add-

ing a new paragraph also capitalizes the next word you dictate.

INTERNET ADDRESSES

E-mail and Web addresses, despite how they are presented, work when typed in all lower case. For ex-

ample, even though we present our company’s Web address as “www.AmericanDictation.com,” you can 

enter “www.americandictation.com” and still call up our Web site. E-mail addresses work similarly.

Therefore, to allow DNS to format e-mail and Web addresses correctly, it’s good form to begin the dicta-

tion with NO CAPS ON, to turn capitalization off.

‣ NO CAPS ON [name] at [domain] dot com NO CAPS OFF – formats an e-mail address as 

“[name]@[domain].com”

‣ NO CAPS ON h t t p w w w dot [domain] dot com NO CAPS OFF – produces “http://www.

[domain].com”

To allow DNS to format Internet addresses, you must have “Web and E-mail Addresses” selected in the 

Formatting tab in the Options dialog window.
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As you normally would, you can say “com,” 

“net,” “org,” and “sys” as words. Others, such 

as “edu,” “gov,” and “mil” are better dictated 

as individual letters.

The most common challenge we’ve experi-

enced in dictating Internet addresses comes 

with the unusual spellings of some domains, 

such as “novuscript” or “novusweb” (two of 

our owned domains). As with any other mis-

recognized word, you can add a domain name 

to your vocabulary (see Adding Individual 

Words). You can also use the “SPELL THAT” 

command to correct addresses, or change to 

“spell mode” and dictate names by individual 

letters.

If you use certain addresses often, consider 

creating a Text and Graphics command (see 

Commands).

Formatting for E-mail and Web addresses is located under Tools > Formatting… in 

Dragon Medical, instead of in the Options dialog window.

If you did not use the Vocabulary Optimizer to analyze your e-mails when you set up 

your User Profile, you can quickly add e-mail addresses to your DNS vocabulary. Run 

the “Increase Accuracy from E-Mail” tool in the Accuracy Center (see Improving Accu-

racy).

RESUMING DICTATION

Anyone used to dictating knows that it is not uncommon to want to change your mind after you have 

dictated a phrase. When this happens, DNS provides a powerful method of going back to a particular point 

and re-dictating your work.

‣ After pausing briefly, say RESUME WITH [word], where [word] is the word or phrase where 

you wish to begin re-dictating.

‣ Dictate.
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For example, if you first dictate, “Meet me at the bookstore for lunch,” but you want to change it to 

“Meet me at the bookstore for coffee,” you would pause after dictating the first phrase, then say RESUME 

WITH bookstore for coffee.”

The RESUME WITH command only revises the last 100 characters that you dictated. You 

cannot go back further and revise. Always remember to pause briefly before saying 

RESUME WITH.

We have found the RESUME WITH convenient with using a hand-held recorder (see Third-Party Dicta-

tion).

NON-STANDARD WINDOWS

In most cases, you can use DNS to dictate into any text window of any application. However, there are 

occasions where some voice commands will not work. When this occurs, you will see “Dictating to a non-

standard window” appear in the DragonBar.

Some of the applications that contain non-standard windows include:

❖ Lotus Notes

❖ Microsoft Access (text fields)

❖ Microsoft PowerPoint (text fields)

❖ Command Prompt (DOS)

❖ Microsoft Windows Desktop

❖ Microsoft Windows Explorer (files and folders window)

❖ Nuance OmniForm

❖ AOL Instant Messenger (text window)

❖ Microsoft Excel control line

❖ Microsoft Outlook (HTML messages if Internet Explorer support is turned off)

If you wish to dictate into a non-standard window, you are limited to the following types of commands:

‣ Select and revise text commands, such as SCRATCH THAT, SELECT [text], CORRECT [text], 

and SPELL THAT.

‣ Format text commands, such as CAP THAT, COMPOUND THAT, and HYPHENATE SELEC-

TION.
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FORMAT THAT NUMBER and FORMAT THAT SPELLED OUT are no longer supported 

in Version 10.

‣ Edit text commands, such as COPY THAT, CUT SELECTION, INSERT BEFORE THAT, and 

PASTE THAT.

‣ Mode commands, such as SPELL MODE ON, START COMMAND MODE, and STOP DIC-

TATION MODE.

‣ Playback dictation and read text commands, such as PLAY THAT BACK, READ PARA-

GRAPH, and PLAY LINE.

‣ Insertion movement commands that point relative to specific text, such as INSERT BEFORE 

[text], and INSERT AFTER [text].

If you are having trouble dictating into a non-standard window, you may want to use the Dictation Box. 

Select the text you want to edit and say, SHOW DICTATION BOX or EDIT SELECTION.

SPELLING

It’s not often, but sometimes Dragon NaturallySpeaking doesn’t contain a particular word in its vocabu-

lary. This is especially true of names and complex words unique to a particular industry.

If you find that your work requires a great number of unique words, you can import 

lists of words into DNS. See Improving Accuracy for more information. Alternatively, 

you can contact us to see if other providers have created specialized vocabularies for 

purchase.

DNS stores words and phrases in the active vocabulary and the back-up dictionary. Unknown words can 

be added to the DNS vocabulary by using the Spell dialog window. If you spell words without using the 

Spell dialog window, DNS will not add them to its vocabulary.
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The active vocabulary contains words that Dragon NaturallySpeaking is most likely to 

recognize on the first try, without requiring you to do anything extra such as correcting 

the words with the correction menu. Active vocabulary words are stored in computer 

memory so they are always available. An interesting note: the number of words in the 

active vocabulary always remains the same. When the words are added, words that have not 

been used recently are removed from the active vocabulary, but remain on the computers disk in 

the back-up dictionary.

You can view the complete listing of the active vocabulary in the Vocabulary Editor dialog win-

dow. For more information on editing the vocabulary, see Improving Accuracy.

If DNS misinterprets a word or phrase, it may not mean that the intended word is not already in its vo-

cabulary. Regardless, if you use the Spell dialog window, the word will be added if missing, or simply cor-

rected if not missing.

SPELLING A WORD OR PHRASE

If you want to add a new word to the vocabulary, say SPELL or SPELL THAT immediately after a recogni-

tion error, followed by the correct letters of the word or words. Speak continuously and quickly, without 

pausing between letters. This will immediately spell the corrected word and add it to the vocabulary (if 

missing).

Alternatively, if you pause after saying SPELL or SPELL THAT, the Spell dialog window will open. Using 

the Spell dialog window gives you the chance to confirm the word you are spelling before entering the 

word into your text. You also have the opportunity to train DNS to understand how you pronounce the 

word (see Training Words in the Spell Dialog Window).

If you wish to spell previously dictated text, select the word or phrase you wish to correct, then say SPELL 

THAT. You can immediately dictate the correct letters or use the Spell dialog window.

Normally, the Spell dialog window does not appear when you use the SPELL command. If you wish to 

have this window appear each time you use a SPELL command, select “Spell commands bring up Spell 

dialog box” in the Correction tab of the Options dialog window.
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If you plan on spelling a large portion of your document, considering changing to “Spell 

Mode”, or clicking

Words > Spell Mode

in the menu bar.

To turn on Spell Mode using your voice, say START SPELL MODE, SPELL MODE ON, or 

SWITCH TO SPELL MODE.

To turn Spell Mode off, say STOP SPELL MODE, SPELL MODE OFF, or SWITCH TO [other] 

MODE. When you turn off Spell Mode, DNS goes to Normal Mode by default.

THE SPELL DIALOG WINDOW

You can use your keyboard or voice to spell words in the Spell dialog window. If you say the letters, you 

can either speak continuously or you can pause between each letter. As you spell out the word, the Spell 

dialog window will display possible alternatives.
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To spell text in the Spell dialog window:

‣ Type or say each letter.

‣ If you see an alternative you want to use, choose it with your mouse or say the choice (e.g., 

CHOOSE 3).

‣ You may have to spell the word completely, as DNS may not find a suitable alternative, par-

ticularly if the word is very unique.

‣ Click OK , or say CLICK OK.

As you use the Spell dialog window, you have certain commands at your disposal:

‣ MOVE [LEFT/RIGHT] [number] [WORDS/CHARACTERS] - Moves your cursor insertion 

point.

‣ SELECT [LAST/NEXT] [number] [WORDS/CHARACTERS] - Selects the number of words or 

characters.

‣ SELECT THAT - Selects the last spoken word or letter, or the complete line of text if there 

has been no previous selection.

‣ DELETE/SCRATCH THAT - Deletes the selected text, or the whole line if there is no selec-

tion.

‣ GO TO [END/BEGINNING] OF LINE - Moves the insertion point to the end or beginning of 

the text.

‣ DELETE [NEXT/PREVIOUS] WORD does not work in the Spell dialog window.

As with any correction function in Dragon NaturallySpeaking, the program searches both the active vo-

cabulary and the backup dictionary for matches. If you spell words that do not appear in either, saving your 

user profile will also add any new words you spelled in the Spell dialog window to the active vocabulary.
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Sometimes, an alternative presented may be close to what you wish to spell. If you want to pull an alter-

native to the text box, but continuing spelling, say SELECT and the number of the alternative. That choice 

will be pulled into the text box where you can continue spelling or editing.

For example, let’s say you’re spelling “webmastering” (assuming you have a good reason for such a 

word!), as you spell “webmaster,” you may find that DNS presents “webmaster” as an alternative when you 

reach “w-e-b-m-a.” If you want, you could say SELECT 1 (if #1 is “webmaster” - alternatives for each user 

may be different depending on how much the vocabularies have been used and altered), and “webmaster” 

would appear in the text box. Then, you could simple say the remaining letters, “i-n-g” to complete your 

desired word.

SPELLING LETTERS, NUMBERS AND CHARACTERS

DNS provides various ways of dictating letters, numbers and special characters:

❖ For letters, you can say the letter, the alpha-bravo equivalent, or LETTER [alpha-bravo]. Example: for 

a, you can say a, alpha, or LETTER alpha.

❖ For numbers, you can say the number, or NUMERAL [number]. Example: for 6, you can say six or 

NUMERAL six. (For zero, you can also say oh.)

❖ Special characters are generally just as you would say them normally in conversation. Example: for the 

“\” character, you can say backslash. In some cases, the name of the character differs according to the 

version of English you have chosen for use with DNS. For non-US/Canada English, you would say add 

sign for the “+” character, instead of plus sign as you would in the US or Canada.

❖ You can dictate two of the same letter by saying DOUBLE before the letter, such as in DOUBLE b for 

“bb.” As you might suspect, you cannot say DOUBLE u to spell two “u’s.” Instead, say DOUBLE LET-

TER u.

‣ To capitalize a letter, say CAP before saying the letter, as in CAP t for “T.”

TRAINING WORDS IN THE SPELL DIALOG WINDOW

As you spell words in the Spell dialog window, DNS learns by matching what it heard against what you 

have spelled. In that way, it corrects itself so that in future uses of the word, DNS is less likely to mis-

recognize the word.

Sometimes, however, you may find that DNS continues to make the same misinterpretation. When that 

happens, you can train DNS to learn how you pronounce a particular word or phrase.

When you have the correct word or phrase in the text box of the Spell dialog window:

1. Say TRAIN or click Train .
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2. When the Train Words dialog window opens, click Go  to begin recording your voice. 

Say the word normally, without any special emphasis and at a normal pace. When you finish saying 

the word or phrase, click Done .

DICTATING NUMBERS

The use of numbers in your dictation presents a special case for interpretation. The Dragon Naturally-

Speaking User Guide contains quite a good section on dictating numbers. What we want to emphasize here 

is that DNS generally responds to numbers as it does with any other dictation, in that if you dictate a num-

ber sequence as you would normally dictate to a transcriptionist, DNS will most likely interpret it correctly.

For example, if you say zero point three zero seven, DNS will interpret it as “0.307.” If you say two fif-

teen a m, you’ll see DNS type it as “2:15 a.m.”

If you plan on spelling a large portion of your document, consider changing to “Num-

bers Mode”, or clicking

Words > Numbers Mode

in the menu bar.

To turn on Numbers Mode using your voice, say START NUMBERS MODE, NUMBERS MODE 

ON, or SWITCH TO NUMBERS MODE.

To turn Numbers Mode off, say STOP NUMBERS MODE, NUMBERS MODE OFF, or SWITCH 

TO [other] MODE. When you turn off Numbers Mode, DNS goes to Normal Mode by default.

Dates, currency and Roman numerals are also well interpreted by Dragon NaturallySpeaking. Addition-

ally, you have the ability to have DNS automatically format numbers, dates and currencies in the Formatting 

tab of the Options dialog window.
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For the sake of helping you quickly get up to speed using numbers, here are some of the more important 

notes regarding number dictating:

❖ DNS formats numbers with 5 or more digits by inserting commas every three digits: 34,678; 

1,984,334. However, DNS does not include a comma on four-digit numbers, such as 4839. If you 

want a comma after the “4” in this example, you have to dictate it, as in four (pause) comma (pause) 

eight three nine.

❖ If you don’t want to switch to Numbers Mode, but you want DNS to explicitly interpret dictated digits 

as numerals instead of text, you can say NUMERAL before you say the number. For example, to have 

DNS type a “7” instead of “seven,” say NUMERAL seven.

❖ The use of the word “and” in dictating a number is optional. For example, to dictate “230,” you can 

say two hundred thirty or two hundred and thirty.

❖ One of the special and powerful features of DNS is that it will format currencies and times according 

to the regional settings of Windows. How you configure Windows regional settings will determine how 

DNS formats currency symbols and number separators.
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MEDICAL FORMATTING RULES

 While all versions of Dragon 10 allow you to generally control how dates, numbers, etc., are to be 

formatted when typed, Dragon Medical 10 gives healthcare providers additional granularity into how cer-

tain items are to be formatted. The formatting choices are greatly expanded when a medical vocabulary is 

chosen for a user profile. 

Administrators can set these rules for all users, although individual users can modify these options for their 

particular needs.

To set your Medical Formatting rules, go to:

Tools > Formatting

Click on the tab that contains the settings you want to configure:

GENERAL TAB

Rule Description Default

Format Dates Controls how DNS formats dates. Dates as 

spoken
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Rule Description Default

Format Times Makes DNS automatically format times, includ-

ing military times.

Yes

Format Common English 

Abbreviations

Inserts the abbreviated forms of common words. 

Examples include: 
❖ “Asst.” for Assistant.

❖ “Corp.” for Corporation

❖ “est.” for established

❖ “comp.” for compilation

❖ “Inst.” for Institute

❖ “Ltd.” for Limited

❖ “vs.” for versus

No

Expand Common English 

Contractions

Expands contractions, such as “it is” for “it’s.” No

Abbreviate Common Eng-

lish Units of Measure

Inserts abbreviated form of units of measure, 

such as:
❖ “lb” for pound

❖ “mm” for millimeter

No

Format Street Addresses Inserts a properly formatted street address. For 

example:

“7446 Trigo Lane

Carlsbad, CA 92009” for “7446 Trigo lane 

Carlsbad California 9 2 oh oh 9”

Yes

Format UK and Canadian 

Postcodes

Properly formats UK and Canadian postcodes. No

Abbreviate Titles Inserts abbreviated versions of any title in the 

default lexicon. (E.g., “Mr.” for Mister, “Dr.” for 

Doctor.)

Yes
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Rule Description Default

Format ISO Currency 

Codes

Inserts currency codes rather than currency 

symbols. For example:
❖ “USD10.00” for “10 dollars”

❖ “EUR50,00” for “50 euros”

No

Format Prices Inserts prices with the proper currency symbol. 

For example:
❖ “$10.00” for “10 dollars”

❖ “€50,00” for “50 euros”

Yes

Format Phone Numbers Inserts telephone numbers in the proper format Yes

Format Other Numbers Inserts properly formatted decimals, negative 

numbers, and fractions.

Yes

Format Web and e-mail 

addresses

Formats Web and e-mail addresses, such as 

“bret@americandictation.com” for “bret at 

american dictation dot com.”

Yes

Prefer 5 million over 

5,000,000

Inserts numbers as a combination of text and 

numerals.

Yes

Format US Social Security 

Numbers

Inserts hyphens in the appropriate location of a 

number that contains 9 digits when pauses are 

used where they hyphens belong.

No

Allow pauses in formatted 

phrases

Allows number and phrase formatting to work 

together if you pause while speaking a number.

No

Insert two spaces after pe-

riod

Adds two spaces after the end of a sentence 

instead of a single space. Not common since 

most fonts today are “proportional spacing” 

fonts.

No

Numbers, if greater than or 

equal to

Inserts numbers as numerals if they are equal to 

or greater than the value you select. If the num-

ber dictated is less than the selected value, the 

number is written out. For example, “one” in-

stead of “1,” but “3” for “3.” Choices are 0, 2, 

10 or 100.

Yes, 

defaults 

to 2
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Rule Description Default

Automatically add commas 

and periods.

Automatically adds commas and periods based 

on pause length and sentence structure.

No

CAPITALIZATION TAB

New options for capitalization in a medical environment control how Dragon Medical 10 handles capi-

talization of dictated words and phrases.

Rule Default

Person name capitalization Standard.

Department name capitalization Title Caps.

Drug name capitalization Standard.

Capitalize the words after a new line Yes

Capitalize “allergy” and “allergies” as “ALLERGY” and “AL-

LERGIES”

No
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Rule Default

Capitalize “against medical advice” as “AGAINST MEDICAL 

ADVICE”

Yes

Expand and capitalize “AMA” as “AGAINST MEDICAL AD-

VICE”

No

Capitalize “code blue” as “CODE BLUE” Yes

Capitalize “code status” as “CODE STATUS” Yes

Capitalize “code S” as “CODE S” Yes

Capitalize “code T” as “CODE T” Yes

Capitalize “do no intubate” and “do not resuscitate” as “DO 

NOT INTUBATE” and “DO NOT RESUSCITATE”

Yes

Expand and capitalize “DNI” and “DNR” as “DO NOT IN-

TUBATE” and “DO NOT RESUSCITATE”

No

Capitalize “durable power of attorney” as “DURABLE 

POWER OF ATTORNEY”

Yes

Capitalize “fish” as “FISH” No

Capitalize “left” and “right” as “LEFT” and “RIGHT” No

Capitalize “living will” as “LIVING WILL” No

Capitalize and expand “NKDA” as “NO KNOWN DRUG AL-

LERGIES”

No

Spell “PO2” and “PC02” as “pO2” and “pCO2” Yes

Spell “RBC/hpf” and “WBC/hpf” as “RBC/HPF” and “WBC/

HPF”

No

Capitalize “trauma alert” as “TRAUMA ALERT” Yes

NUMBERS, UNITS AND DATES TAB

Numbers and units, of course, are common in medical dictation. This tab gives you expanded capability 

for managing how numbers and units (and dates) are to be typed by Dragon.
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Rule Description Default

Treat ambiguous numeric 

strings

Formats any ambiguous strings of numbers as 

either dates or IDs. If you choose “As Dates,” 

you should go to the General Tab and select the 

first check box – “Format Dates” – then select 

your desired format. Do not select “Dates as 

Spoken;” if you do, Dragon will give you 

“12659” instead of “one twenty-six fifty-nine.” 

If, on the other hand, you choose “Month D, 

YYYY” for “Format Dates,” then “one twenty-six, 

fifty-nine” would type as “January 26, 2959.”

If you choose “As IDs,” Dragon converts am-

biguous strings into a series of digits without 

spaces. Dictating “two seven oh nine six six” will 

type “270966.”

As IDs

Rewrite “cc” after a num-

ber as “mL”

Inserts “mL” after a number if the user dictates 

“cc” following a number. E.g., “15 cc” types as 

“15 mL.”

No
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Rule Description Default

Rewrite “U” after a number 

as “units”

Inserts the word “units” after a number if the 

user dictates the “U” followed by a number

No

Write “degree” and “de-

grees” after a number as 

“º” (and abbreviate “Fahr-

enheit” and “Celsius” to 

“F” and “C”)

Inserts correctly formatted temperatures. Yes

Use Roman numerals for 

diabetes types

Inserts Roman numerals for diabetes types. E.g., 

“type II diabetes” for “type 2 diabetes.”

No

Insert a hyphen between a 

number and the word 

“French”

Inserts a hyphen when you say “7 French” to 

describe a type of equipment.

No

Format of expressions in-

volving feet and inches

Formats expressions with feet and inches. Leave 

Un-

changed

Write one digit ordinals 

from “third” to “ninth” into 

hybrid form (“3rd” to “9th”)

Inserts ordinals in hybrid form. No

Insert a space between 

“mm” and “Hg”

Inserts a space between the letters in the abbre-

viations mm and Hg for “millimeter of mercury.”

No

Write “o’clock” as a word Select when the word “o’clock” should be in-

serted.

Never

Format numbers as times 

when followed by phrases 

such as “in the morning”

Inserts numbers as times when followed by 

phrases such as “in the morning” or “at night.” 

E.g., “seven o’clock in the morning” types as 

“7:00 AM”

No

Military time suffix Controls whether the words “hours” or “hrs” is 

inserted after military time. E.g., “eighteen hun-

dred hours” types as “18:00 Hours”

Hrs

Write “%” as “percent” Inserts “percent” instead of “%” No

Write the word “number” 

as “#” prior to numerals

Inserts the hash symbol before a number. E.g., 

“#28” for “number 28.”

Yes
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Rule Description Default

Write single digit + “point” 

in hyphenated form when 

not followed by another 

digit.

Inserts a digit, hyphen, and the word “point” 

when not followed by another digit. E.g., “6-

point” for “6.”

No

Write out “positive” and 

“negative” before numbers 

and for blood types and Rh 

factors

Uses the words “positive” and “negative” for 

blood types and Rh factors. E.g., “negative 3” 

instead of “-3.”

No

Expect temperatures to be 

dictated in Celsius rather 

than Fahrenheit

Types all temperatures as Celsius No

ABBREVIATION TAB

This tab dictates which abbreviations Dragon will expand to full text. Select the rules you prefer.

The following are checked by default:
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Rule

Expand “alk phos” to “alkaline phosphatase”

Expand “bicarb” to “bicarbonate”

Expand “cath” to “catheter”

Expand “chemo” to “chemotherapy”

Expand “C. diff” to “C. difficile”

Expand “E. coli” to “Escherichia coli”

Expand “ex lap” to “exploratory laparoscopy”

Expand “fem-pop” to “femorapopliteal”

Expand “flex sig” to “flexible sigmoidoscopy”

Expand “HPI” to “history of present illness”

Expand “IU” to “international units”

Expand “lap chole” to “laparoscopic cholecystectomy”

Expand “nitro” to “nitroglycerin”

Expand “ObGyn” written “OB/GYN”

Expand “rehab” to “rehabilitation”

Expand “sed rate” to “sedimentation rate”

Expand “subcu” to “subcutaneous”

Expand “T-max” and “T-current” to “MAXIMUM TEMPERATURE” an “CURRENT TEMPERA-

TURE”

MISCELLANEOUS TAB

In addition to all the afore-mentioned formatting options, Dragon gives medical dictators additional for-

matting options collected under the tab “Miscellaneous.”
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Rule Description Default

Treat “paragraph” as a 

paragraph break, not as the 

word

Saying “new paragraph” or “paragraph” inserts 

one new line. De-selecting this will insert two 

lines for either command.

Yes

Treat paragraph breaks as 

equivalent to line breaks

Saying “new paragraph” inserts line breaks 

instead of paragraph breaks. This negates the 

effect of the above option (may seem a bit 

confusing; try different selections to understand 

how these effect your dictation).

No

Insert commas into 

oncology “T N M” 

expressions

Uses commas to separate T N M parameters. 

E.g., “pT1, pN0, M0, R0, G1” instead of “pT1 

pN0 M0 R0 G1”

Yes

Replace “&” with “and” Replaces ampersands with the word “and.” No

Treat “bracket” as 

equivalent to “parenthesis”

Inserts parenthesis “(“ or “)” whenever you say 

the word “bracket.”

No
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Rule Description Default

Write accented characters 

with their non-accented 

forms.

Used non-accented characters instead of 

accented. E.g., “e” instead of “ê.”

No

Write “dash” as Controls how Dragon treats the word “dash” 

when dictated: single hyphen, single hyphen 

surrounded by spaces, double hyphen, or 

double hyphen surrounded by spaces.

Single 

Hyphen

Remove hyphen from 

words starting with “re-,” 

such as “re-create”

Removes the hyphen from the “re-” prefix. Yes

Remove hyphen from 

words ending with “-up,” 

such as “close-up”

Removes the hyphen from the “-up” suffix. Yes

Write “AP” before the word 

diameter as “A-P”

Types “A-P” when you dictate “AP diameter” No

Spell “BI-RADS” as 

“BIRADS”

Type “BI-RADS” when you dictate “BIRADS” No

Spell “calyx” and related 

words with an “i”

Types “calyx” and related words with an “i.” 

E.g., “calix” for “calyx.”

No

Spell “disc” and related 

words with a “k”

Types “disc” and related words with a “k.” E.g., 

“disk” for “disc.”

No

Spell “disfluency” and 

related words with “dys”

Types “disfluency” and related words with “dys.” No

Spell “orthopedics” and 

related words with “ae”

Types “orthopedics” and related words with 

“ae.” E.g., “orthopaedics” instead of 

“orthopedics”

No

Rewrite “dad,” “kid,” 

“mom,” “sib” as “father,” 

“child,” “mother,” “sibling”

Substitutes “father,” “child,” “mother,” and 

“sibling” for “dad,” “kid,” “mom,” and “sib.”

No

Rewrite “off of” as “off” Types “off” when “off of” is dictated. No

Expand dosage 

abbreviations

Types the full word with you dictate a dosage 

abbreviation.

No
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Rule Description Default

Automatically insert second 

letter into vertebra range 

when not dictated.

Check this selection to allow you to dictate a 

range of cervical spine vertebra and have it 

appear formatted with a hyphen. Eg., “C four 

five” typed as “C4-5.”

No

Expert Series Mastering Dragon NaturallySpeaking 10 Professional  

© MMVIII American Dictation Corporation • All Rights Reserved • 75



THIRD-PARTY DICTATION

In many of our customer installations, authors are choosing to focus solely on dictating and leaving the 

processing of their voice in Dragon NaturallySpeaking to a “third party,” such as a secretary or transcription-

ist. Using a portable digital voice recorder gives the dictator more mobility.

Using a third-party to process dictation, however, means that the author is not using Dragon Naturally-

Speaking for other non-dictation purposes, such as controlling computer operations, correcting dictation, or 

revising text. While it is possible for an author to dictate formatting commands, such as capitalization and 

spacing, it is not often used in third-party dictation since there is no immediate visual confirmation that the 

command is understood. Usually, the author limits commands to those relating to punctuation and spelling.

 Since Dragon NaturallySpeaking can recognize only one speaker at a time, you should 

not use DNS to transcribe conversations, interviews, or meetings. Conversation partici-

pants never say punctuation, and cannot DNS discern the difference between two or 

more speakers.

DICTATING WITH A PORTABLE DIGITAL VOICE RECORDER

Just as with using a headset, you will get your best results in Dragon NaturallySpeaking by providing the 

best audio quality possible.

❖ Always hold your portable recorder at a consistent distance from your mouth.

❖ Consider using your headset microphone connected to your portable recorder. This gives you the 

mobility of using a portable recorder, and the benefits relating to a headset.

THE RESTRICTED COMMAND SET

As stated before, most of the DNS voice commands are ineffective because they require visual feedback 

to be useful. The “Restricted Command Set” includes the Dragon NaturallySpeaking commands that are the 

most useful in third-party dictation. In addition to the basic dictation commands listed in this section “Di-

rect Dictation,” the Restricted Command Set includes two additional commands:

‣ SCRATCH THAT will delete the previous utterance.
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‣ RESUME WITH is especially useful when recording dictation. This command allows you to 

backup if you misspeak or change your mind after dictating a phrase. For example, if 

you dictate “send this package on Monday,” you can change the day by dictating RE-

SUME WITH send this package on Tuesday.”

When the third-party transcribes your recording, they can choose to have Dragon NaturallySpeaking ig-

nore all but the restricted command set. By using this setting, DNS will ignore all but the restricted com-

mand set, and prevent potentially damaging misrecognitions (for example, a phrase misinterpreted as "De-

lete All”).

USING DIFFERENT MODES WHILE RECORDING

 By default, DNS transcribes in Normal Mode. For most of your dictation, Normal Mode  will do quite 

well. However, from time to time you may wish to switch to another mode in order to improve the accu-

racy of your dictation. If you wish to dictate a series of numbers, you can switch to Numbers Mode. The 

times when you need to spell a name or acronym, you can switch to Spell Mode. 

 When using a digital voice recorder, switching modes takes extra care. If you switch 

from Normal Mode to another mode, you have to remember to switch back before con-

tinuing your dictation.

‣ [Mode-Name] MODE ON or START [Mode-Name] MODE – Turn a mode on.

‣ [Mode-Name] MODE OFF or  STOP [Mode-Name] MODE – Turn a mode off.

‣ SWITCH TO [Mode-Name] MODE – To switch modes.

 PROCESSING A DIGITAL VOICE FILE

 Once an author has recorded a digital dictation file, the transcriptionist –  or “third-party” –  can process 

the dictation through Dragon NaturallySpeaking. The digital voice file must first be converted to a DNS 

compatible format. The converted file is imported into DNS and interpreted against the author’s profile.

The audio file format that Dragon NaturallySpeaking recognizes is PCM. The digital voice file must first be 

converted to a PCM .WAV file in one of the following formats:

❖ PCM, 11.025 kHz, 16 bit, Mono

❖ PCM, 22.050 kHz, 16 bit, Mono

Once the audio file is in the correct format, go to

Sound > Transcribe Recording …
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in the DNS menu bar.

In the resulting dialog, click Browse  to locate your converted audio file.

To choose what you wish to do with the output, and which set of commands to use, click Advanced… .
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In the Advanced Settings window, you can choose into which window DNS will transcribe your text, and 

to what degree Dragon NaturallySpeaking should respond to commands in the voice file. The transcribed 

text will be output into DragonPad, unless you choose to click into another window already open on your 

computer. For example, if you want DNS to transcribe into Microsoft Word, you must have Word open 

already, and a document open. The window should be arranged on your desktop so that you can click into 

it when ready. To choose to have your dictation transcribed into another window other than DragonPad, 

select “a selected window.”

As briefly discussed, most dictators using a digital voice recorder would choose to limit commands to a 

specific restricted set. In some cases, you may not wish to have DNS recognize any commands, or, if your 

author regularly uses macros and other advanced commands, and is skilled in dictating those commands, 

you may want Dragon NaturallySpeaking to recognize all commands.

After making your choices in the Advanced Settings window, click Transcribe  to begin the voice to 

print process. During the transcription process, refrain from using your mouse or keyboard.

PROCESSING DIGITAL VOICE FILES USING RECORDER SOFTWARE PROGRAMS

The major digital voice recorder manufacturers have included “one step” means of converting the digital 

audio files and passing them on to Dragon NaturallySpeaking for processing. For example, in the Olympus 

DSS Player Pro and Philips SpeechExec Pro software applications, you can highlight the digital voice file you 

wish to transcribe and click the Dragon icon in the toolbar. The voice file is automatically converted to the 
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preferred DNS format and you’re presented with the same Advanced Settings dialog described above.

Of course, DNS must be running on your computer and the appropriate user profile selected prior to 

using the Olympus or Philips software.

You can only process one digital voice file at a time using this method. We do have some customers, 

however, that need the ability to process large numbers of digital voice files in a more rapid fashion. If this 

describes your situation, see

➡ AutoTranscribe

CORRECTING AND REVISING

One of the benefits of using third-party dictation is that the author can concentrate on dictating, while 

someone else can focus on correcting or revising the output. The third-party “editor” can take the tran-

scribed output, make corrections, format the copy and process it otherwise.

With Dragon 10 NaturallySpeaking Legal and Dragon 10 Medical, you can optionally put Dragon into 

“Corrections Only” mode. This gives the editor the ability to make corrections without having to have the 

author’s profile loaded on their computer. This feature works with Roaming Users to allow an editor to 

correct files without using voice corrections.
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CORRECTING ERRORS

It is unrealistic to believe that Dragon NaturallySpeaking will always be 100% accurate. Just as we often 

misinterpret what others say, DNS will as well. DNS will never misspell a word; it will simply insert an incor-

rect word or phrase.

As you use Dragon NaturallySpeaking, your increase in productivity will come as a combination of better 

dictation habits, ongoing “learning” by your user profile, and the efficiency by which you can make correc-

tions.

This chapter deals with making corrections where Dragon NaturallySpeaking has misinterpreted your 

dictation. The process of changing what you dictate –  or “revising text” –  is covered in the next chapter. 

Learning how to correct misinterpretations in DNS is very important. The Pro versions of Dragon Naturally-

Speaking improve accuracy by learning from their mistakes. When you identify and correct a misinterpreta-

tion, DNS “learns.” The more you correct Dragon NaturallySpeaking, the more accurately it will transcribe 

your voice (or that of the selected user profile).

CORRECTING TEXT

To correct errors as you dictate into DNS, use the following methods:

‣ SELECT THAT or CORRECT THAT – Corrects the last thing you said.

‣ CORRECT THAT – Corrects the selected text.

‣ CORRECT [first-word] THROUGH [last-word] – Corrects the phrase beginning with the 

First-Word through the Last-Word.

‣ SCRATCH THAT – Deletes the text you just dictated.

If you get a message in the status bar that there is nothing to correct, select the text you want to correct 

and say CORRECT THAT again.

If you want to dictate the word “correct” at the beginning of a phrase or utterance, either say CORRECT 

and then pause, or hold down Shift while you speak. This way, DNS will recognize the word as a dic-

tated word and not as a command.
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There are three basic methods for correcting misinterpretations in a document: using the keyboard (the 

fastest method), while playing back dictation (most accurate), and using voice commands (hands-free).

CORRECTING TEXT USING THE KEYBOARD

To correct misrecognitions using your keyboard:

1.  Use your mouse to move the insertion point to the beginning of the dictation you want to correct.

2. Press the correction hot-key to display the Correction menu. By default, the hotkey is the minus (-) 

key on the numeric keypad.

3. The first alternative on the correction menu is highlighted.

• If the selected alternative is correct, press the Right Arrow key.

• If one of the other alternatives is correct, press the Down Arrow key until that alternative is high-

lighted and press the Right Arrow key.

• If no alternative is correct, just type the correct text or say SPELL THAT to open the Spell dialog 

box.
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4. Continue until all the text is correct.

Hot keys can help you save time by providing 

a quick short-cut for often-used actions. To 

review or change the hot-key assignments in 

DNS, go to

Tools > Options > Hot Keys

To change a hot-key assignment, click on the name of 

the function (e.g., Microphone on/off…) and press the 

actual key or keys (simultaneously, only) you want to 

use. Be careful, though, as some key combinations are 

already used by Windows or other applications (e.g., 

Control-C for “Copy”).

CORRECTING TEXT WHILE PLAYING BACK DICTATION

To correct text while playing back your dictation:

1. Use your mouse to move the insertion point to the beginning of the dictation you want to correct.

2. Click
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Sound > Play That Back

• Or, click the “Start Playback” button on the Extras toolbar:

3. When the playback of your dictation reaches a recognition error, press the Correction Hot-Key (by 

default, the minus (-) key on the numeric keypad).

4. Use the correction menu as described in the previous section to correct the misinterpretation.

CORRECTING TEXT USING VOICE COMMANDS

As you are dictating, you can avoid reaching for your keyboard by using your voice to give correction-

related commands:

1. Say GO TO BEGINNING OF DOCUMENT.

2. Look for the first misrecognition and say “Select” and the text that is incorrect. The Correction 

Menu appears with a number of alternatives.

• If one alternative is correct, say “Choose” and the number of that alternative (e.g. CHOOSE 

TWO).

• If no alternative is satisfactory, say SPELL THAT, and spell the correct word or words in the Spell 

dialog window. Then, say OK.

THE SPELL DIALOG WINDOW

 The spell dialog box allows you to correct misinterpreted words or phrases, as well as add words to the 

Dragon NaturallySpeaking vocabulary.

You can open the Spell dialog window by saying SPELL or SPELL THAT and pausing. If you want the Spell 
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dialog to open whenever you say a Correction command (e.g., CORRECT THAT), select the option “Cor-

rect commands bring up the Spell dialog box” in the Corrections tab in Options.

It is NOT necessary for the Spell dialog to be open for you to spell words with DNS.

The Spell dialog window contains the 

following:

❖ Text Box. This displays any letters al-

ready selected when you open the Spell 

dialog box or the letters you speak after 

the box is open.

❖ Numbered List of Choices. DNS pre-

sents alternatives that match the letters 

in the Text Box. This list will change as 

the contents of the Text Box changes.

❖ Play Back. Plays the dictation that pro-

duced the text you are correcting. You 

may not remember what was exactly 

dictated; using “Play Back” you can hear what was said so you know what to spell.
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❖ Train  This button opens the “Train Words” dialog window. Here you teach DNS how you 

say the spelled word. When you click Go , speak the word as you normally do. When you 

are satisfied, click Done .

❖ OK  Replaces the selected text in your document with the contents of the Text Box.

❖ Cancel  Closes the Spell dialog window without making any changes in your document.

SPELLING TEXT

In the Spell dialog window, you can enter words using either your keyboard or by saying the letters you 

want. When spelling each letter, you can speak continuously or by pausing after each letter. DNS is fairly 

lenient in this regard.

As you enter letters, the list of alternatives will change as DNS tries to figure out viable choices that begin 

with the letters you have entered. If you see an alternative that matches what you want, you can stop spell-

ing and choose the alternative.

To type or spell text:

1. Type or say the letters of the word or words.

2. If an acceptable alternative appears, choose it by saying CHOOSE [number].

3. If no acceptable alternative appears, spell the entire words or phrase.

4. Say CLICK OK, or click the “OK” button.

The Spell dialog box will close and the text is inserted into your document. If you are using Spell to cor-

rect text, as described before, the text will replace the selected text in your document.

In the Spell dialog window, there are certain commands that will assist you:
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‣ MOVE [Right/Left] [Number] [Words/Characters] – Moves the text insertion point the 

given number of words or characters right or left of its current position. For example, if 

you want to move the insertion point to the left so that it is at the beginning of the word 

prior to the current word, say “Move Left One Word.”

‣ SELECT [Last/Next] [Number] [Words/Characters] – Selects the given number of words or 

characters. If you want, for example, to select the next three characters in the Text Box, 

say “Select Next Three Characters.”

‣ SELECT THAT – Selects the last utterance, whether word or letter, or the whole line of text if 

there has been no previous selection.

‣ DELETE/SCRATCH THAT – Deletes the selected text, or the whole line of text if there has 

been no previous selection.

When you type letters into the spell dialog window, Dragon NaturallySpeaking searches both the active 

vocabulary and the backup dictionary for a matching word. If you have to type the full word before a suit-

able alternative is shown, it is because the word is not in either the active vocabulary or the backup dic-

tionary. When you save your user profile, any word you add in the spell dialog box is added as new words 

to the active vocabulary.

If one of the recognition alternatives is almost correct, you can say SELECT and the number of the alterna-

tive. The alternative text appears in the text box where you can edit it.

The active vocabulary contains the words that Dragon NaturallySpeaking is most likely 

to recognize on the first try, without requiring you to do anything extra such as correct-

ing the words with the correction menu. Active vocabulary words are stored in com-

puter memory so they are always available. An interesting note: the number of words 

in the active vocabulary always remains the same. When the words are added, words that have 

not been used recently are removed from the active vocabulary, but remain on the computer’s 

disk in the back-up dictionary.

You can view the complete listing of the active vocabulary in the Vocabulary Editor dialog win-

dow. For more information on editing the vocabulary, see Improving Accuracy.

CORRECTING SAVED DICTATION

 While Dragon NaturallySpeaking provides both keyboard and voice commands for correcting dictation, 

it is sometimes necessary to make corrections at a later time.

❖ Correcting Your Own Dictation. If you save your dictation, you can open your file later and playback 

and correct the text as if you just dictated it.
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❖ Correcting Someone Else’s Dictation. Described earlier as “Third-Party Dictation,” you can play back 

someone else’s dictation and correct the text to match the original voice file.

❖ Correction Only Mode. With Dragon Medical 10 or Dragon NaturallySpeaking 10 Legal, you can 

configure the Administrative Settings to allow a user to only do corrections to transcribed work. Called 

“Correction Only Mode,” this works well with Roaming Users to allow editors to correct an author’s 

work and improve their user profile, while not requiring that the user’s profile be optimized for the 

audio attributes of the editor’s computer. In Correction Only Mode, the editor can only use keyboard 

commands to make corrections.

In order to playback dictation when correcting, the sound file must be saved with the 

document in Word, WordPerfect or DragonPad. In the Data Tab of the Options window, 

select “Always” or “Ask me” for the “Save recorded dictation with document” prefer-

ence.

CORRECTING YOUR OWN DICTATION

In order to correct your own dictation at a later date, the dragon sound file must be saved along with the 

text document. This allows you to open a text document at a later date, and use the attached voice file to 

make needed corrections. When the file has been reopened, you can make corrections in the same man-

ner you would if you were doing Direct Dictation.

CORRECTING SOMEONE ELSE’S DICTATION

Although it is possible to correct someone else’s dictation using your voice and your user profile, any cor-

rections made to the document will not enhance the author’s profile. For that reason, you should correct 

using the document author’s user profile.

1. Do not use the microphone headset. The DNS microphone  should not be turned on.

2. Open the DragonBar Extras toolbar .

3. Open the user profile of the person whose text you are editing. You can choose the active user pro-

file in the Extras toolbar.

4.  Open the document in DragonPad, or the word processor used to create the document.

5. Begin correcting any errors:

•  Use the buttons on the Extras toolbar to play back the dictation.

• Select the text you want to correct.
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• Press the correction hotkey or click the correction button on the Extras toolbar. The correction 

menu will appear.

• Correct the text using your keyboard.

6. Save the text and the user’s speech files when you’re done.

Third-party software companies have created tools to make third-party editing more 

efficient. One of the most popular is called Transcription Aid. This system includes a 

proprietary foot switch to help increase efficiency. This particular package also prevents 

voice “dropouts” as discussed in the warning sidebar.

While Dragon NaturallySpeaking maintains an audio file connected to the transcribed 

document, some corrections or changes in the text will cause DNS to drop out portions 

of the audio file. It does this in an attempt to maintain a close match between the audio 

file and the printed document. If maintaining the integrity of the voice dictation is im-

portant, it may be prudent to consider add-ons such as Transcription Aid.

With Dragon 10, you can also preserve all the audio data by clicking the “Advanced” button on 

the Data Tab of the Options window. Then, select “Always preserve wave data.” This will elimi-

nate the drop-outs that occur when you edit, add or paste in typing into an edited document.

If you choose to edit someone else’s dictation, there are a couple of important considerations:

❖  If the author is creating the original dictation using DNS, and you wish to have your corrections and 

enhance their user profile, you will have to set up a Roaming User configuration. Both the author and 

the editor must have the same DNS version installed (e.g. legal, medical).

➡ Roaming Users

❖ If the author is creating the original dictation using a digital voice recorder, or otherwise is not using 

DNS to create the initial dictation or document, then only the editor needs to have Dragon Naturally-

Speaking installed. The author can deliver the audio file to the editor, who can, in turn, process the 

voice file through DNS using the author’s profile. Corrections made to the output will serve to en-

hance the author’s profile.

 To make the process of editing a bit easier, make the following selections in the Correction tab of the 

Options dialog window:

❖ Select commands bring up Correction menu.

❖ Automatic playback on Correction.

 These selections will cause DNS to automatically play back the authors voice each time you select text to 

correct.
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CORRECTIONS ONLY MODE

If the Corrections Only Mode is selected in the Miscellaneous tab of the Administrative Settings window, 

you can open and correct another user’s files without running the Audio Setup Wizard or doing any audio 

training. Of course, you can’t correct using your voice, but for many legal and medical situations, Correc-

tions Only Mode is a wonderful way of editing work by numerous authors while also improving their profile 

accuracy. Corrections Only Mode requires to use of Roaming User profiles.

Corrections Only Mode is only available in the Legal and Medical versions of Dragon 

NaturallySpeaking 10.

CORRECTING MIS-INTERPRETED COMMANDS

Sometimes, when dictating directly into Dragon NaturallySpeaking, your commands may not be recog-

nized correctly. Fortunately, when DNS does make mistakes, you can take steps to ensure that DNS recog-

nizes the command correctly in the future.

 When DNS recognizes a command, the Results box contains a blue border. For more on valid com-

mands, see

➡ Commands

If DNS misinterprets your spoken command:

1. Make the window or dialog box containing the mis-recognized command active by clicking on it.

2. Say SCRATCH THAT, UNDO THAT, or UNDO LAST ACTION.

3. Say the command again.

If your command was interpreted as dictation, hold down the Control key as you start to say the com-

mand again. This forces Dragon NaturallySpeaking to recognize what you say as a command.

The UNDO THAT and UNDO LAST ACTION commands are verbal shortcuts for using 

your keyboard to press Control-Z in the active application. Some applications handle 

“Undo” differently.

Of course, to ensure that whatever you dictate is interpreted as a command, you can switch to Command 

Mode.

Occasionally, DNS will continue to misinterpret a spoken command. As with many aspects of Dragon 

NaturallySpeaking, you can train the program to recognize your pronunciation.
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1. Say OPEN COMMAND BROWSER or click

Tools > Command Browser

2.  In the Browse area of the Command Browser, select the Current command context –  the program 

in which the command is available –  from the list.

3. Click Filter… .

4. Enter a keyword for the command you want to train in the Choose Word box and click Add to 

move the word to the “Current list of filter words.” Repeat until you have as many keywords as you 

need to find the command in question.

5. Click Done .

6. If more than one command appears in the list, select the command you were looking for, expand-

ing it with the Optional, Ellipsis, or Refine buttons if necessary.

7. Click Train  or Train Later .

8. Follow the instructions in the Train Words dialog window.

As with any voice training in DNS, speak using your normal voice. Avoid the natural tendency to “overly 

enunciate” when speaking single words and short phrases. This could actually reduce the resulting accuracy.
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REVISING TEXT

The previous chapter dealt with correcting errors based on Dragon NaturallySpeaking’s misinterpretation 

of what was said. It was important to learn how to correct the output, as well as how to increase future 

accuracy.

Once your dictation is converted to text, you may want to edit the output. Beyond correcting any errors, 

you may want to revise your text, to change what was dictated.

As to be expected, DNS makes revising text possible by using your voice.

If you’re editing someone else’s dictation, you can still use your voice to revise text. 

Simply choose your profile and use a headset or other microphone to control the func-

tions relating to revising the output.

Understand, though, that you will not be improving the author’s user profile in this 

mode. Therefore, you should make all misinterpretation corrections using the original author’s 

profile before using your profile for revisions. It may be possible to use the original author’s pro-

file to do revisions; it depends on how well DNS can interpret your voice against the author’s 

profile.

Basically, to revise text, you:

1. Select the text you wish to revise.

2. State the command that changes the typed text or applies a new style or format.

BASIC REVISION COMMANDS

For most revision purposes, the following commands will satisfy your aims:

‣ SCRATCH THAT – Deletes the last utterance or the selected passage.

 You can say SCRATCH THAT up to ten times to delete the last ten utterances, one at 

a time. Alternatively, you can say SCRATCH THAT [number] TIMES to delete the last 

given number of utterances.
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‣ SELECT [text] – Selects the word or phrase ([text]) dictated.

‣ SELECT [text] THROUGH [text] – Selects the passage, inclusive of the words dictated on 

either side of THROUGH. (Outside the US or Canada, say SELECT [text] TO [text].)

‣ [replacement words or phrase] – Changes the selected passage with the words or phrase 

dictated.

‣ RESUME WITH [word] – Backs up the insertion point to the word dictated. Further dictation 

will replace everything following the given word ([word]).

MOVEMENT COMMANDS

When you begin using DNS, you may find proofing the document word-by-word is the best way to de-

tect errors. However, as you use DNS more, and when you get to the point of performing revision work, 

you will want to quickly move to various points within the dictated document.

To move the cursor insertion point:

‣ MOVE [RIGHT/LEFT/FORWARD/BACK] [number/A CHARACTER/number CHARACTERS] 

– The cursor will move ahead or backward the given number of characters. For exam-

ple:

• MOVE RIGHT 4 – Moves the cursor 4 characters to the right.

• MOVE BACK A CHARACTER – Moves the cursor one character backwards, or to the left of its 

current position.

• MOVE FORWARD 12 CHARACTERS – Moves the cursor ahead, or to the right, 12 characters.

‣ MOVE [RIGHT/LEFT/FORWARD/BACK] [A WORD/number WORDS] – The cursor will 

move ahead or backward the given number of words. For example:

• MOVE RIGHT 4 WORDS – Moves the cursor 4 words to the right.

• MOVE BACK A WORD – Moves the cursor one word backwards, or to the left of its current po-

sition.

‣ MOVE [UP/DOWN] [number/number LINES] – The cursor will move up or down the given 

number of lines. For example:

• MOVE UP 2 LINES – Moves the cursor 2 lines above its current position.

• MOVE DOWN 3 – Moves the cursor down 3 lines.

‣ MOVE [UP/DOWN/BACK/FORWARD] [A PARAGRAPH/number LINES] – The cursor will 

move up, down, back or forward the given number of paragraphs or lines. For example:
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• MOVE UP 2 PARAGRAPHS – Moves the cursor 2 paragraphs above its current position.

• MOVE FORWARD A PARAGRAPH – Moves the cursor to the next paragraph.

You should be aware that these commands will not always work in all programs. Those 

that don’t recognize a paragraph, such as NotePad, won’t respond to the paragraph 

commands. For more information about working with Applications, see Working with 

Programs.

You can also move the cursor insertion point before or after a word or phrase:

‣ INSERT BEFORE [text] – Moves the cursor to a point before the given text.

‣ INSERT AFTER [text] – Moves the cursor to a point after the given text.

When giving these commands, do not hesitate in the middle of the command.

To help you move speedily through a document, you can use the following commands:

‣ [GO TO/MOVE TO] [position] – Moves the cursor point to one of the following positions:

• TOP/TOP OF DOCUMENT/BEGINNING OF DOCUMENT/START OF DOCUMENT

• BOTTOM/BOTTOM OF DOCUMENT/END OF DOCUMENT

• BEGINNING OF LINE/START OF LINE

• END OF LINE

These commands, as with the other movement commands, de-select any selected text.

SELECTION COMMANDS

When you want to change existing text, you will use Selection commands to highlight the text you wish to 

change. By selecting the text, you can re-dictate or type what you wish to use to replace the selection.

The default configuration of DNS calls for the Correction Menu to display when you select a word or 

phrase.
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You can turn this feature off by de-selecting “Select commands bring up Correction menu” in the Correc-

tion tab of the Options dialog window.

To select specific characters or words:

‣ SELECT [NEXT/FORWARD/PREVIOUS/BACK/LAST] [CHARACTER/number CHARACTERS/

WORD/number WORDS] – Selects the indicated characters or words, either before or 

after the current cursor insertion point. For example:

• SELECT NEXT WORD – Selects the word immediately after the current cursor position.

• SELECT LAST 4 CHARACTERS – Selects the four characters immediately preceding the current 

cursor position.
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You can select punctuation marks, as well. For example, you can say SELECT comma.

Selecting words or phrases works much as you would expect:

‣ SELECT [text] – Selects the given word or phrase.

‣ SELECT [text] THROUGH [text] – Selects the content represented at the beginning and end 

by the given word or phrases.

To select words or phrases, the target text must be visible on the screen. Also, be care-

ful to remain silent when DNS makes a selection until you are ready to re-dictate, or 

DNS may try to interpret the noise as dictation. If it does insert something incorrect, 

immediately say UNDO THAT.

You can cancel a selection by saying UNSELECT THAT, selecting different text, or moving the insertion 

point to any other position in the document (which will immediately de-select the text).

By default, DNS selects the next instance of the given text following the current cursor position. You can 

reverse this behavior – force DNS to always search for the selection back from the current insertion point – 

by selecting “Select commands search backwards” in the Correction tab of the Options dialog window.

Selecting lines or paragraphs works much the same way as moving the cursor, but, of course, results in a 

selection of text:

‣ SELECT [NEXT/FORWARD/PREVIOUS/BACK] [LINE/number LINES/PARAGRAPH/number 

PARAGRAPHS] – Selects the given number of lines or paragraphs before or after the 

current cursor position. Examples:

• SELECT NEXT 2 LINES – Selects the 2 lines immediately following the current cursor position.

• SELECT PREVIOUS PARAGRAPH – Selects the paragraph preceding the current cursor position.

‣ SELECT [DOCUMENT/ALL] – Selects all text in the document.

As Dragon NaturallySpeaking moves through the document to find matches to your selection command, 

it will stop at the first matching occurrence. If you wish for it to move to the next occurrence, quickly say 

SELECT AGAIN.

Since DNS is using speech recognition to interpret your commands, it is, of course, possible that DNS will 
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not correctly select your intended text. To correct a wrong selection:

❖ Use SELECT [text] AGAIN to have DNS try again. Dragon NaturallySpeaking will then try to find your 

selection using a similar pronunciation, much in the same way it presents alternatives to misinterpreta-

tions in the Spell dialog window.

❖ If DNS continues to miss your intended selection, try using a longer phrase. Sometimes, what you say 

is too short for an accurate interpretation.

❖ You can also select punctuation marks. In fact, if you say SELECT PERIOD, then SELECT AGAIN you 

can move through the document, sentence by sentence.

EDITING SELECTION COMMANDS

Once you have selected the text you wish to revise, you have at your disposal a number of common 

commands you can use to alter the text.

In order to use editing commands, you should be familiar with how to edit text using 

your keyboard. Particularly, you should understand the concepts of Copy, Cut and Paste, 

and how the computer’s “clipboard” temporarily stores Copy and Cut results.

‣ CUT THAT – Cuts the selected text, removing it and storing a copy of it in your computer’s 

“clipboard.”

‣ COPY [THAT/ALL TO CLIPBOARD] – Copies the selected text to the clipboard, leaving the 

selection intact in your document.

‣ PASTE THAT – Replaces the selected text (or inserts at the cursor insertion point if no text is 

selected) with the contents of the clipboard.

‣ [SCRATCH/DELETE] THAT – Removes the selected text.

❖ Deleting specific text works the same way as selecting. For example:

• DELETE NEXT 3 WORDS – Removes the next three words following the current cursor insertion 

point.

• DELETE PREVIOUS PARAGRAPH – Deletes the paragraph immediately preceding the current 

cursor insertion point.

If you delete text and an extra space remains, say DELETE NEXT CHARACTER, DE-

LETE PREVIOUS CHARACTER, or BACKSPACE (depending on which direction you 

wish to go) to delete the space. Spaces are considered “characters.”
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• BACKSPACE – Removes the character immediately preceding the current cursor position.

• BACKSPACE [number] – Removes the given number of characters immediately before the cur-

rent cursor insertion point.

FORMATTING COMMANDS

In most programs, you can format selected text for style, alignment, font, size, etc. There are many sim-

ple, yet powerful, formatting commands available to you. For a handy list, see Command Guides.

Formatting commands can also be used to change the appearance when directly dictat-

ing using DNS. For example, if your last utterance was “San Diego,” you could then say 

UNDERLINE THAT to have DNS underline the words: San Diego.

The following are the commands which allow you to format selected text:

‣ BOLD THAT or FORMAT THAT BOLD – Applies “bold” style.

‣ ITALICIZE THAT or FORMAT THAT ITALICS – Applies “italic” style.

‣ FORMAT THAT BOLD ITALIC or FORMAT THAT BOLD ITALICS – Applies both “bold” and 

“italic” styles.

‣ UNDERLINE THAT or FORMAT THAT UNDERLINE – Applies “underline” style.

‣ FORMAT THAT STRIKEOUT – Applies “strikeout” style.

‣ RESTORE THAT, FORMAT THAT REGULAR, or FORMAT THAT PLAIN – Removes all 

“bold,” “italic,” “underline” and “strikeout” styles.

‣ FORMAT THAT CAPS or FORMAT THAT INITIAL CAPS – Changes selected text to initial 

capitals:

‣ FORMAT THAT CAPS changes “first base” to “First Base.”

‣ FORMAT THAT ALL-CAPS or ALL-CAPS THAT – Changes text to “uppercase.”

‣ FORMAT THAT UPPERCASE changes “first base” to “FIRST BASE.”

‣ FORMAT THAT NO-CAPS or NO-CAPS THAT – Changes text to “lowercase.”

‣ FORMAT THAT LOWERCASE changes “FIRST Base” to “first base.”

‣ FORMAT THAT BULLET STYLE – Adds bulleted style to the selected text.
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‣ FORMAT THAT LEFT ALIGNED or LEFT ALIGN THAT – Left-aligns the selected text.

‣ FORMAT THAT RIGHT ALIGNED or RIGHT ALIGN THAT – Right-aligns the selected text.

‣ FORMAT THAT CENTERED or CENTER THAT – Centers the selected text.

‣ HYPHENATE THAT – Inserts hyphens between the selected words.

‣ COMPOUND THAT – Removes spaces between the selected words.

You can also combine formatting commands. For example, if you say FORMAT THAT CAPS BOLD, both 

initial caps and bold styles are applied to the selected text.

When you use “FORMAT THAT” to align an empty paragraph in DragonPad, the previ-

ous paragraph is aligned, as well. To prevent this, dictate some text into the new para-

graph before applying the command.

As stated earlier, you can have DNS type your dictation as numerals by either switching to Numbers 

Mode, or saying NUMERAL before saying the number. When revising text, you can have DNS convert text 

to numbers, too:

‣ FORMAT THAT NUMBER – Converts selected text to numbers:

• Changes “eighty-eighth” to “88th.”

• Changes “4 hundred thousand” to “400,000.”

‣ FORMAT THAT SPELLED OUT – Converts selected numbers to words:

• Changes “745” to “seven hundred forty-five.”

• Changes “92,000” to “ninety-two thousand.”

If applying either command to a selection that includes both numbers and words, then numbers will be 

re-formatted, leaving the other words in the selection as they were.

To change the font, size and style of selected text, you can say any combination of formatting commands. 

However, you must say them in the order of font-size-style. You don’t have to specify all three, but which-

ever ones you do use must be in that order. Changes will affect the selected text and any text dictated im-

mediately thereafter.

You can use SET SIZE, SET FONT SIZE, or FORMAT THAT. For example:

‣ SET FONT HELVETICA

‣ SET FONT SIZE 10 POINTS

‣ FORMAT THAT TIMES 12 POINTS ITALIC
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If you only specify a size, you must say POINTS.

To affect capitalization of selected text:

‣ CAP THAT – Capitalizes the first letter of each word.

‣ ALL-CAPS THAT – Makes the selected text all uppercase.

‣ NO-CAPS THAT – Makes the selected text all lowercase.

As you revise text, you may need to add new lines or paragraphs. Adding a “line” is the equivalent of 

pressing the ENTER key once; adding a “paragraph” is the same as pressing the ENTER key twice.

‣ NEW LINE – Adds a new line.

‣ NEW PARAGRAPH – Adds a new paragraph. It also capitalizes the new word dictated.
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WORKING WITH PROGRAMS

The ability to work directly with and within applications on your computer represents one of the most 

powerful features of Dragon NaturallySpeaking. Especially useful for those who have limited use of their 

hands or have suffered injuries, such as carpal-tunnel syndrome, using your voice to open programs and 

perform tasks makes DNS an amazing assistant for your work.

In this section, we will cover not only those programs we commonly consider as applications, such as 

Word and Outlook, but also how to work within the Windows operating system.

Before you try to learn how to use Dragon NaturallySpeaking within certain applica-

tions, you should be familiar with using the application. This section assumes that you 

have a good understanding of how a particular application works. For instance, if we 

use the phrase “reply to e-mail” to describe a function in Microsoft Outlook, you should 

understand what they means if you use or plan to use DNS to interact with Outlook.

WORKING IN WINDOWS

When you first log onto Windows (or start up depending on your level of security), you undoubtedly have 

to interact with the Windows Desktop to begin working with your computer. For example, to open an ap-

plication, you may use the Start menu or double-click on a shortcut on your Desktop. Additionally, as you 

may have realized, there are many tasks that are common to all Windows applications, particularly in terms 

of how windows are displayed and manipulated, Save/Open dialog windows, and basic menus. These are 

all features of Windows. Therefore, it is prudent to begin our discussion of how to work with programs by 

learning how to perform basic Windows-related tasks.

Most of the commands given in this section apply to Windows XP. In most cases, these 

will also work in other versions of Windows. However, you may find – especially with 

Vista – that program menus and choices are stated differently. Be prepared to adjust 

the given commands based on what your version of Windows actually uses.

PROGRAMS AND DOCUMENTS

Any programs, folders or documents that appear anywhere in your Start menu or your desktop can be 
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opened using your voice. Say START followed by the name that is in your Start menu or on your desktop to 

open that program, folder or document:

‣ START CONTROL PANEL – Opens the Control Panel.

‣ CLICK START MENU – Opens the Start menu.

To close a program or window (such as a folder window or a document within a program), say CLOSE 

[program name/WINDOW] or SYSTEM MENU (pause) CLOSE.

If you want to access some built-in items in the main section of the Start menu, such as Shut Down, Help 

or Run, you must say CLICK START or CLICK START MENU, then say the menu names you want until you 

reach the program. For example, to start the Find Files or Folders tool, say CLICK START, then FIND FILES 

OR FOLDERS.

WINDOWS

To control active windows with your voice (we’re referring to actual windows on your desktop, not the 

Windows operating system per se):

‣ MAXIMIZE WINDOW – Enlarges the active window to the full height and width of your 

monitor display.

‣ MINIMIZE WINDOW – Reduces the size of the active window to an icon in your task bar.

‣ RESTORE WINDOW – Returns the active window to its original size.

‣ SWITCH TO PREVIOUS WINDOW – Switches to the window that was active just prior to 

activating the current window.

‣ SWITCH TO NEXT WINDOW – Switches to the next open window in the window “queue,” 

which is determined by Windows according to the order in which they were accessed.

‣ SWITCH TO [program/document name] – Switches to the window named by the given 

program or document. For example:

• SWITCH TO MICROSOFT WORD – Switches to make Microsoft Word the active window.

If a program window has both the application name and the document name in the title bar, you can say 

either name.

MENUS

Once you are in an application or window, you can use your voice to open, close and choose items from 

the menus. Some programs don’t allow this, but you should find it available in most common applications. 

To access menus, the window must be active on your desktop; it must be the foremost window and se-
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lected.

‣ CLICK [menu name] – Opens the given menu. You can also, in most cases, just say the 

name of the menu, such as “File” or “Edit.” You must say CLICK in order to open the 

Start menu, though.

‣ CLICK [menu item name] – Selects the stated menu item, such as the “New” item within 

the “File” menu.

‣ CANCEL – Closes an open menu. The equivalent of pressing the ESC key on your keyboard.

As stated, you do not have 

to say CLICK before saying 

the name of a menu. How-

ever, in some cases, not 

saying CLICK may interfere with 

your dictation. For instance, if you 

pause before and after you say 

“file,” then DNS may interpret that 

to mean you want to open the File 

menu. In that case, you may want 

to require that CLICK be used be-

fore a menu name. Select “Require 

‘Click’ to select menus and controls” 

in the Commands tab of the Options 

dialog window.

In Microsoft programs that use expanding menus, some menu items may not be acces-

sible using your voice. For maximum voice control, turn off the expanding menu feature 

in the Customize dialog window of the Microsoft application. Select “Always show full 

menus.”

DIALOG WINDOWS

When using applications, you will use dialog windows from time to time to save or open documents or 

access functions and selections. Once the dialog window is active:
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‣ CLICK [button/option] – Selects the stated button or option name in the same way you 

would click that item with your mouse.

‣ MOVE [UP/DOWN] [number] – Moves your selection in a scrolling list vertically up or 

down the given number of choices. Same as pressing the Up or Down Arrow on your 

keyboard.

‣ MOVE [LEFT/RIGHT] [number] – Moves your selection in a horizontally scrolling list right or 

left the given number of columns. The same as pressing the Left or Right Arrow on your 

keyboard.

‣ PAGE [UP/DOWN] – Moves your selection up or down in the same manner as pressing the 

Page Up or Page Down key on your keyboard.

‣ EXPAND LIST or DROP LIST – Opens a selected list. If the list is not selected, say the name 

of the list. To open the next list, say PRESS TAB, then either EXPAND LIST or DROP 

LIST.

‣ [MOVE TO/GO TO/CLICK] NEXT TAB – Selects the next tab in a dialog window.

‣ [MOVE TO/GO TO/CLICK] PREVIOUS TAB – Selects the previous tab.

If a tab has a shortcut key – an underlined character – you can say CLICK and the 

name of the tab.

KEYBOARD

Controlling the keyboard is possible with Dragon NaturallySpeaking, simply by saying PRESS, PRESS KEY, 

or TYPE followed by the name of the key or key combination you want. For example:

‣ PRESS ENTER

‣ PRESS KEY DOWN ARROW

‣ TYPE FUNCTION 3

You can also use modifiers (Shift, CTRL, ALT) by saying PRESS or TYPE followed by the modifier and any 

other key, such as PRESS SHIFT L.

To move around a dialog window, you can say PRESS TAB, and PRESS ENTER to select items.

To undo a keystroke, say UNDO THAT, rather than SCRATCH THAT.
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 DRAGON VOICE SHORTCUTS

Voice shortcuts allow you to issue commands using your voice regardless of whether the application to be 

used is open or in the foreground. Imagine working in Microsoft Word when you decide you need to do a 

Web search for related information. Instead of opening Internet Explorer and navigating to a search Web 

site, entering the search keywords and waiting for the results, you can simply say “Search the Web for 

[keyword].” Dragon will automatically open your Web browser and perform the search.

Voice shortcuts can be enabled or disabled by going to the Commands Tab of the Options dialog.

VOICE SHORTCUTS FOR DESKTOP SEARCH

You can search your computer, e-mails, documents and Web features using your desktop search. You’re 
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required to have one of two supported desktop search software programs running on your computer:

❖ Google Desktop

❖ Microsoft Vista Search

If you’re not using Microsoft Vista (or even if you are), you may want to consider in-

stalling the free Google Desktop, which “makes searching your computer as easy as 

searching the web with Google.”

➡ Google Desktop

‣ SEARCH [THE] COMPUTER FOR [THE] [keyword(s)] – Searches your computer for all 

items with the spoken keyword(s).

‣ SEARCH EMAIL FOR [THE] [keyword(s)] – Finds all indexed e-mails with the spoken key-

word(s).

‣ FIND [AN] EMAIL [ABOUT/ON] [THE] [keyword(s)] – Finds the top-ranked e-mail with the 

keyword(s). Only displays one e-mail message.

‣ SEARCH [THE] [DOCUMENTS/FILES] FOR [THE] [keyword(s)] – Finds indexed documents 

having the spoken keyword(s).

‣ SEARCH [THE] [WEB HISTORY/FAVORITES/BOOKMARKS] FOR [THE] [keyword(s)] – 

Displays search results of the indicated category (Web history, favorites, bookmarks) 

having the spoken keyword(s).

VOICE SHORTCUTS FOR WEB SEARCH

Whenever you wish to search the Internet, you can invoke a Web search using your voice regardless of 

whether or not your browser is open.

The Web browser that will open depends on the browser you have chosen as your de-

fault. For security reasons, speed, and ease of use, we recommend either Apple Safari 

for Windows or Mozilla Firefox. To make one of these your default browser, go to the 

Options menu of either and select to make it your default browser.

➡ Apple Safari

➡ Mozilla Firefox
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For some unknown reason, Nuance has decided that the search engine Voice Shortcuts 

for Web Search is to use is Microsoft’s LiveSearch. While a capable search engine, many 

prefer Google or Yahoo. To change your default search page, go to Start Menu > Con-

trol Panel > Internet Options.

Click on “Settings” in the box titled “Search.” Chances are only LiveSearch is displayed. If so, 

click in the link at the bottom that says “Find More Providers…” This will open a link in your 

browser that will allow you to add more search sites. Note: this feature only works in Internet 

Explorer, so if you have another browser set as your default, open Internet Explorer and paste 

“http://www.microsoft.com/windows/ie/searchguide/en-en/default.mspx?dcsref=http://

runonce.msn.com/runonce2.aspx” in the Address bar.

‣ SEARCH THE WEB FOR [THE] [keyword(s)] – Opens your default browser and displays the 

search results using your spoken keyword(s).

‣ SEARCH [WEB SITE] FOR [THE] [keyword(s)] – Searches the spoken Web site for the spo-

ken keyword(s). Dragon supports the following Web sites:
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• AOL

• AltaVista

• Ask

• eBay

• Amazon

• About

• Answers

• Creative Commons

• Google

• MSN

• Wikipedia

• Yahoo

• YouTube

‣ FIND A [WEB SITE/SITE/WEB PAGE] [ON/ABOUT/FOR] [THE] [keyword(s)] – Displays 

Googles top-ranked page for the spoken keyword(s).

‣ SEARCH [VIDEO/MOVIES/IMAGES/PICTURES/PHOTOS/NEWS/EVENTS/PRODUCTS/ 

SHOPS/MAPS/PLACES] FOR [THE] [keyword(s)] – Your default browser will display the 

results of your spoken keyword(s) for the spoken category.

VOICE SHORTCUTS FOR E-MAIL AND CALENDAR

Using your voice, you can control your default e-mail and calendar program using natural-style com-

mands.

Before using Voice Shortcuts for E-mail and Calendar, you must run the Increase Accuracy 

from E-mail tool. This teaches Dragon your e-mail contacts.

‣ SEND [AN] [EMAIL/MAIL/MESSAGE] TO [name(s)] – A new e-mail will open with the e-

mail addresses of your spoken name(s) in the “To” field.

‣ SEND [AN] [EMAIL/MAIL/MESSAGE] [ABOUT/ON] [subject] – Creates a new e-mail mes-

sage with your spoken subject in the “Subject” field.
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‣ [SCHEDULE/CREATE/BOOK] [(A) MEETING/(AN) APPOINTMENT] WITH [name(s)] – 

Creates a new appointment with the spoken name(s) as attendees. Only works with 

Microsoft Outlook.

‣ FIND AN EMAIL ABOUT [keyword(s)] – Searches your existing e-mails for one that contains 

the spoken keyword(s). See Voice Shortcuts for Desktop Search for more information.

MOUSE MOVEMENTS

Using DNS to move the mouse pointer is perhaps one of the least-used features, at least based on our 

experience, because it generally takes longer to dictate and have the computer respond, than it does for 

one to reach over and move the mouse.

However, we do find that being able to control the mouse movements is an extremely beneficial tech-

nique for those who need assistance in controlling the location of the mouse pointer. We have trained users 

who have physical limitations using a mouse to achieve extraordinary dexterity using voice commands.

In general, you can control the movement of the mouse pointer in one of three ways:

❖ Telling the mouse to move a short distance up, down, left, or right.

❖ Telling the mouse to begin moving at a particular speed until you tell it to stop.

❖ Using an overlay grid to tell the mouse into what section of the screen to move.

Later, we will discuss clicking and dragging the mouse, but for now, let’s explore these three methods.

MOVING SHORT DISTANCES

To move the mouse a short distance of 1 to 10 units (each unit is undefined by DNS, but appears to be 

only a few pixels on the screen):

‣ MOUSE [UP/DOWN/LEFT/RIGHT] [1-10] – Moves the pointer the stated number of units.

This command can help you position the pointer in very small increments. For example, the other mouse 

movement commands discussed in this section can help you move the mouse close to your destination. 

However, you may need to move the mouse slightly to position it directly where you wish.

CONTINUOUS MOVEMENT

You can begin moving the mouse across your screen until you tell it to stop. Additionally, you can tell your 

computer how fast to move the mouse.
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‣ MOVE MOUSE (or MOUSE MOVE) [UP/DOWN/LEFT/RIGHT/UPPER LEFT/LOWER LEFT/

UPPER RIGHT/LOWER RIGHT] [FASTER/VERY FAST/MUCH FASTER/SLOWER/VERY 

SLOW/MUCH SLOWER] – Begins moving the mouse in the direction, and at the speed 

dictated. Speed is optional.

‣ STOP or CANCEL – Stops the movement of the mouse.

By default, the speed of the mouse movement is 2 on a scale of 1 to 25. This can be adjusted by clicking 

the Speed button in the Commands tab of the Options dialog window.

MOUSEGRID

We consider the MouseGrid to be one of the more elegantly useful features of Dragon NaturallySpeaking, 

insofar that you choose to control the mouse movements with DNS.

Basically, by saying MOUSE GRID, DNS overlays your screen with 9 equally-divided cells or regions (to 

put the overlay only on your current, active window, say MOUSE GRID WINDOW).

After you say the number of the grid into which you wish to move the pointer, the selected grid cell di-

vides again into 9 cells. Say the next number of the second grid cell and it divides yet again into 9 cells. And 

so on, and so on, until you get the grid overlaying the area you wish the mouse pointer to move.
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Once you have the target grid displayed, say GO to end the MouseGrid command. To undo the last 

MouseGrid command, say UNDO THAT. CANCEL will close the MouseGrid. The MouseGrid will also dis-

appear when the microphone is turned off, or if you give the command GO TO SLEEP.

CLICKING AND DRAGGING

Again, if you have the ability to use your mouse, you may find it more efficient to use the actual mouse. 

However, if you need or want to control mouse clicking and dragging with your voice:

‣ MOUSE CLICK – Clicks at the mouse pointer position.

‣ MOUSE DOUBLE-CLICK – Clicks twice at the pointer position.

‣ MOUSE RIGHT-CLICK – Right-clicks the mouse at the pointer position.

‣ MOUSE LEFT-CLICK – Left-clicks the mouse.

Dragging the mouse is very similar to using the Continuous mouse movement commands:

‣ DRAG MOUSE (or MOUSE DRAG) [UP/DOWN/LEFT/RIGHT/UPPER LEFT/LOWER LEFT/

UPPER RIGHT/LOWER RIGHT] [FASTER/VERY FAST/MUCH FASTER/SLOWER/VERY 

SLOW/MUCH SLOWER] – Begins dragging the mouse and its selected item in the di-

rection, and at the speed dictated. Speed is optional.

‣ Use CONTROL MOUSE DRAG to do a copy-drag (paste a copy of the selected item at the 

end destination).

‣ STOP or CANCEL – Stops the movement of the mouse.

You can also use MouseGrid commands to drag an object to a new location. First, you have to “mark” or 

select the item you want to drag by choosing it using the MouseGrid commands. Then, use the MouseGrid 

to designate the new destination and move or copy the item to the new destination.

❖ Position the mouse pointer by voice and say MARK. Examples:
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• MOUSEGRID 3 4 1 MARK

• MOUSEGRID WINDOW 7 4 8 MARK

❖ Position the mouse pointer again and say DRAG (to move), SHIFT-DRAG (to move multiple objects), 

or CONTROL-DRAG (to copy the item). For example:

• MOUSEGRID 3 8 DRAG

• MOUSEGRID WINDOW 9 3 4 CONTROL-DRAG

APPLICATIONS

It’s difficult to discuss all the possible uses of Dragon NaturallySpeaking in all possible applications. Gen-

erally, DNS works to a great degree with all applications. However, there are particular and unique features 

that DNS offers for selected, popular applications that deserve special attention. These are called “Natural 

Language Commands.” To use them, you must enable Natural Language Commands in the Commands Tab 

of the Options dialog window (it is selected by default).

Don’t forget that you can view the most common applicable commands when in any 

application by opening the Sample Commands window. Say WHAT CAN I SAY? to 

open the window. You can click “Command Browser” at the top of the window to see 

even more available commands.

In this section we will cover aspects of how DNS provides unique control and functionality within certain 

popular applications. For a complete list of commands and functions included for selected applications, 

refer to the Command Browser listing discussed in “Commands.”

The applications discussed in this section include functionality only present in DNS Pro-

fessional, Legal and Medical. If you’re using a lesser version, as with many of the fea-

tures included in this Guide, you may find that these application commands are not 

available to you.
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MICROSOFT OFFICE 2007 RIBBON INTERFACE

With the introduction of Microsoft Office 2007, the traditional menus and toolbars were replaced with 

the “Ribbon” interface. Nuance responded to this change with the 9.5 update to DNS Professional, which 

includes support for the Ribbon interface.

The MS Office Ribbon interface groups commands into sets of “tabs.” Each tab displays the commands 

that are most relevant for the current tasks being performed in the application.

To use the Ribbon interface, say the name of the Ribbon menu:

‣ HOME – Accesses the Home menu. You can use other menu names in place of HOME. 

Once a menu is accessed, you can simply say the name of the function you wish to 

select.

Since the name of menu functions in the Ribbon interface are not always evident, you 

can move the mouse over a function and its name will be revealed.

‣ OFFICE BUTTON – Accesses the Office button , which replaced the traditional File 

menu in older versions of Office.
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NATURAL LANGUAGE COMMANDS

DNS includes a large number of Natural Language Commands for use with the programs listed in this 

section. These pre-programmed commands allow you to access features and functions without having to 

navigate the sometimes lengthy Windows menu hierarchy.

As with any commands, if the command you give doesn’t result in the actions you an-

ticipated, say UNDO THAT to undo the action. You may have to try some commands 

more than once to learn how to say it so that DNS interprets it correctly.

For many of the following applications, you can find a list of common commands in the Command 

Guides. The following applications have Natural Language Commands built into DNS:

❖ Microsoft Word – Most versions.

❖ Corel WordPerfect.

❖ Internet Explorer.

❖ Mozilla Firefox.

❖ Microsoft PowerPoint.

❖ Microsoft Outlook.

❖ Microsoft Excel.
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❖ Microsoft InfoPath.

❖ Several E-mail Programs (see E-Mail Applications).

Natural Language Commands are also in place to help you work in other applications, such as word 

processing programs, e-mail programs, etc.

The list of possible commands in many applications is quite extensive. Many times, we 

have discovered the ability to use a particular command simply by giving it a try. We 

can never memorize all the possible commands, but having the UNDO THAT command 

at our disposal makes it safe to try different possibilities.

One way to know if a command is possible or not is to look at the Results box. If you say a 

phrase that doesn’t produce an action, look at the Results box. If the box does not have a blue 

border, DNS did not recognize it as a command.

E-MAIL APPLICATIONS

Dragon NaturallySpeaking Professional provides Natural Language Command support for the following e-

mail applications:

❖ America OnLine – Versions 8 and 9.

❖ Microsoft Outlook Express – Versions 5, 5.5 and 6.

❖ Microsoft Outlook – Versions 2000, 2002, 2003 and 2007.

❖ Lotus Notes – Versions 6 and 7.

❖ Mozilla Thunderbird.

For these programs, the following commands may be used in addition to most normal DNS commands 

relating to formatting, movement, etc.:

‣ START MAIL – Opens your default e-mail program. You can alternatively open a non-default 

program by using the START [program name] command, or navigating the Start Menu 

to the application.

‣ CHECK FOR MAIL – Checks for new messages by querying your mail server.

‣ OPEN MAIL – Opens the selected message for viewing (use the normal list movement com-

mands for selecting a particular message in your “Inbox” or other folder).

‣ NEW MAIL – Creates a new e-mail message to compose.
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‣ REPLY TO MAIL or REPLY – Replies to the sender of the current message.

‣ REPLY TO ALL – Creates a reply message to the sender and all recipients of the message, 

including those in the “cc:” field.

‣ FORWARD MAIL – Forwards the current message.

‣ PRINT MAIL – Sends the current message to the printer. In some configurations, this may 

open the Print dialog window. You can then use voice controls and/or your keyboard 

and mouse to complete the printing process.

‣ DELETE MAIL – Deletes the current message, usually sending it to the Recycle Bin.

‣ SEND MAIL – Sends the current message once you are ready to send it to the recipient(s).

‣ CLOSE MAIL – Closes the active e-mail window, but does not close the e-mail program.

‣ SEND MAIL NOW – AOL only. Sends the current message immediately.

‣ SEND MAIL LATER – AOL only. Sets the current message to be sent at a later time.

Navigating within a mail message is quite easy with DNS. Mail messages are really comprised of “fields” 

or sections of content. For instance, each message has a “To” field, where the recipient e-mail address goes, 

and a “Subject” field. There are also fields for “CC” and “BCC.” The main content of an e-mail message 

goes into the “Body” field.

To move your cursor to any of these fields, say GO TO and the name of the field. For example:

‣ GO TO TO FIELD – Moves to the “To” field.

‣ GO TO BODY FIELD – Moves to the “Body” field.

You can also move between fields by using GO TO with FIRST FIELD, PREVIOUS FIELD, NEXT FIELD, or 

LAST FIELD. As usual, AOL has its own special needs: use GO TO SEND TO FIELD to go to the “Send To” 

(or “To”) field, and GO TO COPY TO FIELD to go to the “Copy To” (or “CC”) field.

You can say E-MAIL, MESSAGE, or MEMO in place of MAIL in each of the preceding 

commands.

A great way to add e-mail addresses of your contacts – those to whom you have sent e-mails – is to allow 

DNS to scan your sent e-mails for addresses. In doing so, DNS also analyzes your e-mail writing style to 

better adapt its language model to your style.

Dragon NaturallySpeaking can add contact names from Microsoft Outlook, Microsoft Outlook Express 

and Lotus Notes only. To add contact names from these applications to your DNS vocabulary:
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1. Go to

Tools > Accuracy Center …

2. In the Accuracy Center, click or say INCREASE ACCURACY FROM E-MAIL.

3. Click Next  in the Increase Accuracy from E-mail wizard.

4. Select the e-mail programs you want to scan from the list.

5. If you want DNS to analyze your e-mail writing style to increase accuracy, select “Improve my 

speech files from my e-mail writing style.”

6. If you’ve run this wizard before, you can select to have it only analyze e-mails written since the last 

scan.

7. Click Next . The wizard will begin scanning the selected e-mail programs.

8. Once the scan is complete, you will be presented with a list of contacts to add to the vocabulary. 

Select the ones you wish to add and click Next .

9. On the “Train Words” screen, you are given the opportunity to train DNS on how you pronounce 

any of the new names. If you feel you would like to train any – particularly ones that are not normal 

words – check those names and click Next .

10. Use the Train Words dialog window to train the selected names.

11. When training is complete, DNS will process the changes into your user profile.

Nicknames can be added using this process if your e-mail program supports nicknames.
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Do not use this wizard if you compose e-mails in a foreign language. DNS will try to 

analyze those e-mails and could well result in a significant reduction in future accuracy.

WEB BROWSERS

Since many of us use the Internet daily, it is helpful to learn how to use DNS to “surf” the Net. Dragon 

NaturallySpeaking includes Natural Language Commands for use with Microsoft Internet Explorer and 

Mozilla Firefox 2.x.

Before using either of these Web browsers, you should make note of the following:

❖ To use Explorer commands, the “Enable commands in HTML windows” must be selected in the 

Commands tab of the Options dialog window.

❖  In order to differentiate between dictation and commands for following links, you can choose to 

have DNS require that you dictate the word CLICK to select a hyperlink (e.g., CLICK 

AMERICANDICTATION.COM).

❖ You will not be able to select toolbar icons, applets (Java or ActiveX), History items, Search, or Chan-

nels using your voice.

❖ You can use Explorer commands in other applications that run within a HTML browser, such as HTML-

based Help (such as the Help in DNS), and Outlook.

❖ In some Windows versions, you can control Explorer dialog windows and menus if you have “Use 

Active Accessibility for menu and dialog control” selected in the Miscellaneous tab of the Options 

dialog window.
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❖ Likewise, if Microsoft Active Accessibility is not installed on your computer, either install it before using 

DNS commands in Explorer, or make sure you have DNS open before you open Internet Explorer.

WEB NAVIGATION

Navigating within Explorer and Firefox browser windows works very much as you would expect with any 

other application. To help you quickly begin using a Web browser with DNS, learn the following com-

mands:

‣ GO TO ADDRESS BAR – Moves the cursor insertion to the Address box (sometimes called 

“Location” or “Go to” – unlabeled in Explorer 7).

‣ CLICK GO or GO THERE – Tells the browser to go to the address shown in the Address box.

‣ REFRESH PAGE or RELOAD PAGE – Refreshes the current page shown in the browser.

‣ CLICK [button name] – Follows a link or clicks a button on a Web page. You can also say 

the number of the button link shown on the page if there are multiple buttons.

‣ CLICK TEXT LINK – A very interesting function: it adds numbers to all links on the page. 

Then, simply say the number of the link you want to follow (see Working with Web 

Pages).

‣ STOP LOADING – Stops loading and rendering the current Web page.

‣ GO BACK – Same as clicking the “Back” button in the browser: reloads the previous Web 

page.

‣ GO FORWARD – Reloads the next Web page viewed after the current page, if there is one.
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‣ GO HOME – Reloads your default Home page (not the Home page of the current Web site, 

but the one you have set up in your browser Options).

FOLLOWING LINKS & CLICKING BUTTONS

You can follow any link you can see within the browser window. If you want to see more links on a page, 

use the PAGE UP and PAGE DOWN commands to scroll the page.

To follow a link or text button, simply say the name of the link. You can also say CLICK followed by the 

text of the link or button (or part of it). A red arrow  shows the link or button that is being activated.

If more than one link matches your command, a series of numbered markers appear next to the matches:

❖ A Red marker  points to the first match. It also indicates the link that will be followed when you 

say CLICK THAT, THAT ONE, or CLICK THAT ONE.

❖ Green markers  point to other matches. If you wish to follow one of these links, say CHOOSE and 

the number of the marker. You can also simply say the number of the choice.

Many Web sites use images for links. Obviously, DNS cannot interpret images or text as part of the image. 

However, you can say CLICK and the name of the image, which can be revealed by moving the mouse 

over the image. If you want to remain completely “mouse-less,” say IMAGE to place markers next to all 

visible graphic links. Then, as with link markers, say the number of the marker you wish to click (or say 

CHOOSE and the marker number).

Markers and arrows for selections do not appear in secure documents – those whose 

Web address generally begins with “https://” or for which a secure padlock icon in your 

browser appears. Secure sites encrypt all communications between their server and 

your computer to protect confidential information, such as credit card or personal in-

formation entries.

WORKING WITH WEB PAGES IN INTERNET EXPLORER

After learning how to navigate the World Wide Web using your voice, you can begin interacting with the 

Web pages you view. Since DNS is, at its core, a text dictation and editing tool, you can use it to complete 

on-line forms.

‣ CLICK TYPE TEXT, CLICK TEXT FIELD or CLICK EDIT BOX – Shows all the text fields on 

the current page, numbered. Say the number of one of the markers to move the mouse 

insertion point to that field.

‣ CLICK CHECK BOX or CLICK RADIO BUTTON – Selects a check box or radio button on a 

page. If more than one exists, you can either say the name of the box/button (e.g., 
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CLICK NEXT DAY SHIPPING) or choose one of the numbered markers (e.g., CHOOSE 

3).

‣ CLICK LIST BOX or CLICK LIST – Selects a list or drop-down menu on a Web page. If more 

than one list is visible, numbered markers will appear. Use the CHOOSE command to 

select the list you want.

‣ SHOW CHOICES, DROP LIST, or EXPAND LIST – Opens a selected list to show all the 

choices. To make a selection in a list, use the MOVE [UP/DOWN] command until the 

choice you want is highlighted. Then say HIDE CHOICES.

EXPLORER 7 COMMANDS

In addition to the commands noted in this section, DNS provides additional commands unique to Micro-

soft Internet Explorer 7:

❖ Using tabs:

• OPEN [NEW/LAST/NEXT/PREVIOUS] TAB

• CLOSE TAB

• SWITCH TO THE [LAST/NEXT/PREVIOUS] TAB

• VIEW THE [NEXT/LAST/PREVIOUS] TAB

• VIEW THE [1st-8th] TAB

❖ Using Quick tabs:

• [DISPLAY/HIDE/UNHIDE/OPEN/SHOW/VIEW] QUICK TABS

• TURN QUICK TABS [ON/OFF]

❖ Using RSS Feeds

• [OPEN/CLOSE/SHOW/DISPLAY/VIEW/HIDE/UNHIDE/TOGGLE] FEEDS

• SWITCH TO FEEDS

FIREFOX

The following tab commands are unique to Mozilla Firefox:

‣ [ADD/OPEN] A NEW TAB

‣ CLICK THE [NEXT/PREVIOUS] TAB
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‣ GO TO THE [NEXT/PREVIOUS] TAB

‣ CLOSE TAB

‣ SWITCH TO THE LAST TAB

Using DNS with Web browsers can, at first, be a bit frustrating as you’re using Dragon 

to both command and control the application (Internet Explorer or Firefox) and dictat-

ing content into address bars and text fields. Don’t forget to use the “What Can I Say?” 

command to see a list of available commands when working with Dragon.

LOTUS NOTES

In addition to the general e-mail commands given earlier, if you use Lotus Notes, you may need to learn 

how to move within and format text for Lotus Notes.

MOVING IN LOTUS NOTES

‣ MOVE TO TAB [1-10] – Moves to the specified task button and displays its document or 

view.

‣ NEXT UNREAD E-MAIL – Opens the next unread e-mail message.

‣ OPEN DOCUMENT – Opens a selected document.

‣ CLOSE DOCUMENT – Closes the active document.

‣ CLICK [button name] – Activates the specified button on the action page. Saying CLICK is 

optional.

‣ REFRESH VIEW

FORMATTING TEXT

When formatting text in Lotus Notes, the Text Properties dialog window must be opened first. To open 

this window, say FORMAT THAT.

Once open, you can use the following formatting commands:

‣ BOLD THAT, FORMAT THAT BOLD, or SET FONT BOLD – Applies “bold” style. If already 

bold, it removes, or “toggles,” the bold style.
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‣ ITALICIZE THAT, FORMAT THAT ITALICS, or SET FONT ITALICS – Toggles the “italics” 

style.

‣ UNDERLINE THAT, FORMAT THAT UNDERLINE, or SET FONT UNDERLINE – Toggles the 

“underline” style.

‣ RESTORE THAT, FORMAT THAT REGULAR, or SET FONT REGULAR – Removes bold, ital-

ics or underline styles.

‣ [LEFT/RIGHT] ALIGN THAT or FORMAT THAT [LEFT/RIGHT] ALIGNED – Aligns the text 

in the current Notes text object either left or right.

‣ CENTER THAT or FORMAT THAT CENTERED – Aligns the current text object as centered.

If you start a command with SET FONT, then all text selected and any subsequent dictation is also re-

styled.

If you have trouble editing dictation in any application, you can always use the “Dicta-

tion Box.” Select the text you wish to edit and say SHOW DICTATION BOX or EDIT 

SELECTION.

POWERPOINT

The Natural Language commands provided by DNS for Microsoft PowerPoint fall into five categories: new 

presentations, title slides, slides, finishing, and viewing. As with most applications, other commands related 

to formatting and editing are also available to you.

NEW PRESENTATIONS

To create a new presentation:

1. OPEN NEW PRESETATION

2. CLICK OK

To choose and open a PowerPoint template:

1. CLICK FORMAT

2. CLICK APPLY DESIGN TEMPLATE

3. Navigate using commands such as MOVE [UP/DOWN] [number] to move to the location of the 

template you want to use in the list of available templates.
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4. CLICK APPLY

TITLE SLIDES

To enter a title:

1. Start with a New Presentation.

2. Dictate the title you want.

To format the title:

1. SELECT ALL

2. SET FONT TO [font name] [font size in points]

To enter and format a sub-title:

1. MOUSEGRID WINDOW

2. Use the MouseGrid to position the mouse pointer over the sub-title area.

3. MOUSE CLICK

4. Dictate the sub-title text.

5. SELECT ALL

6. SET SELECTION TO TITLE CASE, if you wish.

To enter the current date in the footer:

1. INSERT DATE

2. UPDATE AUTOMATICALLY

3. Dictate any additional text you want in the footer area.

4. APPLY or APPLY TO ALL

SLIDES

To add a new slide to your opened presentation:

1. INSERT NEW SLIDE

2. OK

3. Dictate the title text for the slide.
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To format the slide text:

1. SELECT ALL

2. [DECREASE/INCREASE] FONT SIZE TO [number] POINTS

3. SET TEXT COLOR TO [color]

To create a list in the sub-title window:

1. MOUSEGRID WINDOW

2. Use MouseGrid to position the mouse pointer over the sub-title area.

3. MOUSE CLICK

4. Dictate the text of the first item.

5. SELECT ALL

6. BULLET THE SELECTION

7. NEW PARAGRAPH

8. Dictate the text of the second item.

9. To add additional items, say NEW PARAGRAPH.

To create another slide:

1. NEW SLIDE

FINISHING

To number the slides:

1. NUMBER ALL SLIDES

To check your spelling:

1. CHECK SPELLING

2. Say the name of the button you wish to click in the Spelling dialog window. For instance, say 

CHANGE to accept the suggested correction.

To create a Web page:

1. SAVE PRESENTATION AS A WEB PAGE

To print your presentation:
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1. PRINT PRESENTATION

2. Make any desired changes in the Print dialog window.

3. OK

VIEWING

The following are commands you can use to control the viewing of a PowerPoint presentation using your 

voice:

‣ VIEW SLIDE – Displays a particular slide.

‣ CLICK VIEW, then NORMAL – Closes the slide view.

‣ TOGGLE THE RULER OFF – Turns off the ruler display.

‣ ZOOM TO [number] PERCENT – Zooms the view to whatever percentage you dictate for 

[number].

‣ FIT TO PAGE

‣ BEGIN SLIDE SHOW – Starts the viewing of the slides.

‣ PRESS ENTER – Displays the next slide.

‣ MOUSE CLICK – Exits the slide show.

‣ PREVIEW THE PRESENTATION AS HTML – Opens Internet Explorer and displays the pres-

entation as a Web page.

‣ SWITCH TO MICROSOFT POWERPOINT – Switches back to PowerPoint from Internet 

Explorer (or any other application you have active).

OUTLOOK

Microsoft Outlook works differently than Microsoft Outlook Express. In order to provide you with robust 

controls of this sophisticate messaging application, Dragon NaturallySpeaking includes a number of special 

Natural Language commands.

READING AND SENDING E-MAIL

To read your e-mail:

1. START MICROSOFT OUTLOOK
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2. GO TO INBOX

3. CHECK FOR NEW MAIL

4. OPEN MAIL MESSAGE to read the first unread e-mail message.

5. VIEW NEXT UNREAD MESSAGE

To reply to a message:

1. REPLY TO MESSAGE or REPLY TO THIS MESSAGE replies to the message sender. To reply to all 

recipients of the message, use REPLY TO ALL

2. Dictate your reply.

3. SEND MESSAGE

To create a new message:

1. CREATE E-MAIL

2. Dictate the recipient address(es).

3. SUBJECT

4. Dictate the message subject.

5. TEXT FIELD or MOVE TO TEXT

6. Dictate the text of the message.

7. SEND MESSAGE

When reading e-mails, you can also use the following commands:

‣ MARK THE MESSAGE AS UNREAD

‣ COPY THIS MESSAGE TO A FOLDER

‣ FLAG MESSAGE FOR FOLLOW-UP

‣ CLOSE ALL ITEMS

APPOINTMENTS

The following are commands related to creating appointments in Outlook.

To open your calendar:

1. START MICROSOFT OUTLOOK, if not already open.
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2. VIEW CALENDAR

To create a new event:

1. COMPOSE NEW ALL DAY EVENT

2. Dictate the subject of the appointment.

3. SET START TIME TO [day]

4. PRESS TAB KEY

5. Dictate any information you want included in the event.

6. INVITE PEOPLE TO THIS EVENT

7. Dictate the e-mail addresses of all the people you want to invite.

8. SEND THIS APPOINTMENT

Other Calendar commands:

‣ MAKE THIS AN ONLINE EVENT

‣ SET REMINDER ON

‣ SHOW TIME AS TENTATIVE

‣ DECLINE THIS EVENT

‣ MARK THIS APPOINTMENT AS UNREAD

‣ FORWARD THIS APPOINTMENT

CONTACTS

To add new contacts to Outlook, use the following command sequences.

To open your Address Book:

1. START MICROSOFT OUTLOOK if not already open.

2. VIEW ADDRESS BOOK

To create a new contact:

1. CREATE NEW CONTACT

2. Dictate the name of the contact in the Full Name text box.
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3. PRESS ALT YANKEE, which is the equivalent of pressing ALT-Y to open the Company field.

4. Dictate a company name.

5. CLICK BUSINESS to open the telephone number field.

6. Dictate a telephone number. If “phone numbers” is selected in the Formatting Tab of the Option 

dialog window, DNS will format the number in a standard telephone format.

7. SAVE AND CLOSE THIS to save the new contact.

NOTES

If you want to add notes in Outlook, the following commands can be used.

To open the Outlook note pad:

1. START MICROSOFT OUTLOOK if not already open and active.

2. OPEN NEW NOTE

To create and format a new note:

1. Dictate the content of your new note.

2. Set text alignment, using [RIGHT/LEFT] ALIGN THIS or [JUSTIFY/CENTER] THIS

3. Set the text style, if you wish, using SET THIS [text property], referring to any font style or size.

4. FIND A WORD to perform a search.

To send a note as an e-mail message:

1. FORWARD THE NOTE

2. Dictate the e-mail address of your recipient.

3. GO TO CC FIELD, if desired, and dictate any additional recipient e-mail addresses.

4. GO TO SUBJECT FIELD
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5. Dictate the subject of the e-mail.

6. SEND MESSAGE

OTHER OUTLOOK COMMANDS

For the most part, you can use the same commands you use with Internet Explorer to navigate and inter-

act with the various dialog windows of Outlook. For example, you can use TYPE TEXT to show all the pos-

sible input places.

For help, see Working with Web Pages.

OUTLOOK EXPRESS

You can use several voice commands with Outlook Express. In general, they are similar to any other e-

mail program commands.

Command for reading e-mail messages:

‣ CHECK FOR NEW MAIL

‣ OPEN MESSAGE

‣ SORT INBOX [ASCENDING/DESCENDING]

‣ GO TO NEXT UNREAD MESSAGE

‣ MARK MESSAGE AS UNREAD

‣ GO TO PREVIOUS MESSAGE

‣ DELETE MESSAGE

‣ CLOSE THE MESSAGE WINDOW

Commands for creating and sending e-mail messages:

‣ CREATE MESSAGE

‣ GO TO ADDRESS BOOK

‣ GO TO SUBJECT

‣ MOVE TO TEXT FIELD

‣ SEND MESSAGE
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Commands for replying to an e-mail message:

‣ REPLY TO AUTHOR

‣ REPLY TO ALL

‣ SEND MAIL

Other commands:

‣ GO TO THE OUTBOX FOLDER

‣ FORWARD THE MESSAGE

EXCEL

Microsoft Excel presents a more unique situation since it is not a word processor. It doesn’t present fields 

in the same way a Web page or Outlook does. It does require a certain degree of patience to learn how 

best to interact with it using your voice. However, once mastered, using DNS with Excel can be very effi-

cient.

MODES

If you’re used to editing in Excel, you know that you can either edit directly into a cell, or if you double-

click on a cell, you can use line breaks and create multi-line entries. The following is a description of these 

two modes and how DNS interacts with each:

❖ Quick Edition Mode. By selecting a cell with your mouse, any subsequent content you enter will re-

place what is in the cell. You can also format the contents for font, size, style, etc. Once you have se-

lected a cell, you can dictate your desired contents.

Select-and-Say – the ability to dictate content using your voice – is available when you 

select a cell as long as you do not first use your keyboard to enter content. If you do 

use your keyboard first, you cannot dictate the remaining content. However, if you re-

turn to such a cell later, you will be able to dictate content, provided you do not again 

use your keyboard first.

❖ Full Edition Mode. If you select a cell and say EDIT CELL or PRESS F2, the cell will open for editing. 

Line commands, such as NEW LINE are allowed in this mode.

BASIC EXCEL COMMANDS

To create a new spreadsheet:
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1. START MICROSOFT EXCEL

2. CREATE NEW FILE or CREATE NEW WORKBOOK

To open a previously saved spreadsheet:

1. OPEN FILE or OPEN DOCUMENT

2. [file name]

3. CLICK OPEN

To close a spreadsheet, use CLOSE FILE or CLOSE DOCUMENT.

To save a spreadsheet file:

1. SAVE FILE

2. Dictate a file name, if not already previously saved.

3. CLICK SAVE

To save a spreadsheet in HTML format:

1. SAVE FILE AS WEB PAGE

2. CLICK SAVE

3. CLICK CONTINUE if a dialog window appears warning of a format loss.

To rename a spreadsheet, use RENAME THE WORKSHEET.

To move to another open spreadsheet, use GO TO THE [NEXT/PREVIOUS] WORKSHEET.

To set margins:

‣ SET TOP AND BOTTOM MARGINS TO [number]

‣ SET RIGHT MARGIN TO [number]

To set printing area:

‣ FIT TO [number] PAGES WIDE

‣ FIT TO [number] PAGES TALL

To enlarge or reduce the spreadsheet view, use ZOOM TO [number] PERCENT.

To change the display, use any of the following commands:

‣ [HIDE/UNHIDE] THIS [ROW/COLUMN]
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‣ [HIDE/SHOW] THE DRAWING TOOLBAR

‣ [HIDE/UNHIDE] THE FORMULAS IN THIS [ROW/COLUMN]

To print a range of pages, you can use any of the following:

‣ PRINT WORKBOOK

‣ PRINT THE SELECTION

‣ PRINT COLUMN [number] TO COLUMN [number]

‣ PRINT NEXT [number] ROWS

To preview a printout, use GO TO PRINT BREAK PREVIEW.

To print part of a page:

1. SET PRINT AREA TO SELECTION or SET PRINT AREA TO THE [FIRST/NEXT/PREVIOUS] [num-

ber] [ROWS/COLUMNS]

2. PRINT THE SELECTION

MOVING WITHIN A SPREADSHEET

To move your selection within a spreadsheet, the following commands may be used:

‣ [NEXT/PREVIOUS] [ROW/COLUMN]

‣ START OF [THIS/NEXT/PREVIOUS] [ROW/COLUMN]

‣ [ROW/COLUMN] [number/letter]

If the column you are moving to includes two or more letters, use the alpha-bravo form 

of the letter. For example, to go to Column EF, say COLUMN ECHO FOXTROT.

‣ START OF [ROW/COLUMN]

‣ [NEXT/PREVIOUS] CELL IN THE [ROW/COLUMN]

‣ NEW LINE – Creates a new line with a cell.

‣ APPLY – Completes a cell entry and stays in the cell.

‣ PRESS ENTER – Completes a cell entry and moves down one cell. Quick Edition mode only.

‣ PRESS ESCAPE or CANCEL – Cancels a cell entry and remains in the cell.
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FORMATTING

Besides formatting cell content, you have commands available to help you format the spreadsheet at the 

row and column level.

‣ SET COLUMN WIDTH TO [number] or SET WIDTH TO [number] IN COLUMN [letter]

‣ SET ROW HEIGHT TO [number] IN THIS ROW or SET HEIGHT TO [number] IN THE 

[FIRST/NEXT/PREVIOUS] [number] ROWS

‣ SHADE THIS [ROW/COLUMN]

‣ APPLY PATTERN TO [CURRENT/THIS] [ROW/COLUMN]

‣ CENTER THE [NEXT/PREVIOUS] [number] [ROWS/COLUMNS]

‣ INDENT THE [NEXT/PREVIOUS] [number] [ROWS/COLUMNS]

‣ [BOLD/ITALICIZE] THIS [ROW/COLUMN/CELL]

SPREADSHEET CONTENTS

As you work with the content of the spreadsheet, you may find the following commands helpful:

‣ [SUM/AVERAGE] THE VALUES [ON THE RIGHT/ON THE LEFT/ABOVE/BELOW] – Sums or 

averages a column or row of numbers.

‣ SORT THE SELECTION – Sorts a row or column of numbers.

‣ SET THIS [ROW/COLUMN/CELL] TO FRACTIONS IN [number] – Changes the contents of 

a row, column or cell from decimals to fractions.

‣ [LOCK/UNLOCK] THIS [ROW/COLUMN/CELL] – Locks or unlocks the contents of a row, 

column or cell.

‣ FILL THIS CELL [UP/DOWN/LEFT/RIGHT] [number] [CELLS/ROWS/COLUMNS] – Fills 

cells, rows or columns.

‣ CLEAR ALL FROM THIS [ROW/COLUMN/CELL] – Deletes the contents of a cell, row or 

column.

‣ HIDE THIS [ROW/COLUMN/CELL] – Hides the contents of a cell, row or column.
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INFOPATH

DNS provides basic operation commands for use with Microsoft InfoPath.

FORMS

‣ OPEN FORM

‣ SAVE FORM

‣ CLOSE FORM

‣ EXPORT TO [WEB/EXCEL/PDF]

‣ FILL OUT FORM

‣ RUN SPELL CHECK

‣ OPEN INFOPATH HELP

TABLES

‣ INSERT SECTION – Inserts a new section.

‣ INSERT A TABLE ROW – Inserts a new row into a table.

MOVING WITHIN INFOPATH

‣ CLICK [name of text or list box] – Moves to a name text or list box.

‣ CLICK [name] – Adds numbered pointers to all fields, where more than one text box or list 

box has the same name. To select one, use CHOOSE [number].

‣ GO TO [NEXT/PREVIOUS] FIELD
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COMMANDS

Outside of its ability to convert speech into text, Dragon NaturallySpeaking’s ability to interpret spoken 

commands is perhaps its greatest power. Not only does DNS Professional come with a great number of 

commands to help you work with DNS and other applications, it comes with the ability to allow you to 

create new commands that meet your individual needs.

In our experience, DNS commands make the Professional series worth every penny. The challenge – and 

one purpose of this Guide – is to learn how to put the power of DNS commands to use.

Some possible reasons to manage commands:

❖ Build a template for inputing specific information. Build commands that allow you to dictate informa-

tion into specific areas of the template.

❖ Create a macro to insert your name and title by simply saying MY SIGNATURE (since the creation of a 

macro – in essence – creates a command, these will be shown as commands in this Guide).

❖ Say a command and have your computer open Firefox or Internet Explorer and go to a particular Web 

page.

In short, just about anything you do on your computer can be programmed as a command in DNS.

We know that learning commands can seem like a daunting task, best left to “te-

chies.” However, we also know that, like you, we had to dig in and work through the 

process. It does take some time to learn about commands. The good news is that 

you don’t have to learn but the very basic tools and functions in order to reap huge 

benefits in efficiency and accuracy.

Don’t be afraid to charge ahead. You should, though, be prepared to spend a couple of unin-

terrupted hours to initially cover the basic material.

COMMAND BROWSER

All commands are accessed using the Command Browser. This DNS tool gives you access to all recog-

nized voice commands, as well as any custom commands you add. The Command Browser is your primary 
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interface with commands. You can use the Command Browser to:

❖ View and train commands

❖ Create and modify commands

❖ Import and export commands

❖ Change the availability of commands

MODES

There are three primary Command Browser modes:

❖ Browse. Allows you to view and search for specific commands.

❖ Script. Allows you to create, edit, copy and preview commands.

❖ Manage. Allows you to import, export, delete and edit custom commands.

ACCESSING THE COMMAND BROWSER

To open the Command Browser, you can

1. Go to

Tools > Command Browser …

2. Say OPEN COMMAND BROWSER or START COMMAND BROWSER

3. Click on “Launch Command Browser” in the Accuracy Center (see Improving Accuracy for infor-

mation about the Accuracy Center)

When the Command Browser opens, it shows a list of Global Commands. These are commands available 

in every application.
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FINDING COMMANDS

In Browse mode, you can find specific commands:

❖ Select the application in the Context list to see only those applicable commands. For instance, if you 

want to only see commands you can use in Microsoft Word 2003, select “Microsoft Word 2003” from 

the list.

❖ Use the “Only Available” and “Include Global” buttons to limit the commands shown:

• Only Available. Shows only those applications installed on your computer for which there are 

voice commands available in your version of Dragon NaturallySpeaking.

When “Only Available” is unselected, you can see the vast number of applications for 

which DNS provides built-in commands. Quite impressive, particularly with the Profes-

sional version.

What you may not realize is that you can create your own custom commands for appli-

cations not on this default list.

Read on.

• Include Global. When selected, you will see all Global Commands, even when choosing an ap-

plication in the Context list. For example, if you choose “Microsoft Word 2003” and you have 

“Include Global” selected, you will see all the built-in commands for Word and all the global 

commands which work with all applications. Therefore, if you want to see every command you 

can use when interacting with a particular application, select “Include Global.”

Once you have narrowed the list according to application, you can scroll through the list of available 

commands. Of course, for many applications – and particularly if you include Global commands – you 

may wish to “filter” the list to show only those commands related to what you are seeking:

1. Click “Filter” or CLICK FILTER to display the Filter dialog window.
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2. Type or dictate one word of the command you are seeking into the “Choose word” text box. If the 

word exists, it will show on the left column. If it doesn’t show, it means there is no command that 

uses that word.

3. To add the selected word to your filter list, press the spacebar or click Add .

4. Continue adding words to the filter list until you feel you have enough specificity to limit the results 

to your needs.

5. Click or say DONE or press Enter  or ENTER.

6. You will be shown a display of the commands that contain all the words on your list.

Filtering can be a powerful tool. You’ll see filters appear in many applications, as it helps 

assist the user in narrowing large lists of information.

Filtering is a bit different from searching. Searching is used more for finding all matches 

that contain any of the search terms, many times ranked in terms of how close the 

results match the search words. Filtering usually shows a subset of items from a list, narrowed 

by those items that match all the filter terms. Additionally, filtering is usually a “continual” func-

tion, meaning that if you change any of the items in the filtered list in such a manner that it no 

longer meets the filtering criteria, it will not appear in the filtered list after the changes are 

saved.

We encourage you to spend some time with filters in all applications that use them, in which you 

manage large lists of information. You may find filters to be your “new best friend.”

VIEWING COMMANDS

Later in this chapter, we’ll cover how to manage custom commands. For now, let’s discuss how to view 

the details of any built-in command, such as those you may have seen when using filters as previously dis-

cussed.

In Browse mode, once you have selected a command whose details you want to view, one or more of the 

following icons may become active on the left side of the Command Browser:

❖  – Allows you to expand optional command statements. Optional statements are those 

you do not have to say when using the command. You’ll see optional statements shown with brackets 

([]). For example, you can say ADD WORD, ADD A WORD, ADD NEW WORD, or ADD A NEW 

WORD. “A” and “new” are shown in brackets because they are optional for use.

❖  – Or statements are those used to show that you can say any of the items shown, 

separated by a vertical bar (|). Can be used to show you different commands that can be used for the 
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same action. For example, it can show you that you can use either CLOSE, QUIT, or EXIT with 

DRAGON NATURALLY SPEAKING, DRAGON NATSPEAK,  DRAGONBAR, NATSPEAK,  OR NATU-

RALLYSPEAKING to quit DNS. Each time you click the “Or” button, the command is separated for 

each iteration.

❖  – The ellipsis, or (…), indicates that more than one command can begin or end with a 

particular word. If you click on the ellipsis button multiple times, you can expand a complex com-

mand to see all its iterations.

❖  – One of the most powerful ways of viewing how a command can be used in different 

ways, the “Refine” button expands any command into all it’s possible versions.

❖  – Resets any expanded view to the normal, compressed view.

TRAINING COMMANDS

As discussed before, you may find that DNS continues to misinterpret a particular command. It’s not un-

heard of to find that in some unique case, DNS simply cannot interpret the way you pronounce a com-

mand. In that case, you can easily use the Command Browser to train DNS.

❖ Open the Command Browser.

❖ Find the command you wish to train (see Finding Commands earlier in this section).

❖ Click (or say) one of the following that appear in the left column of the Command Browser:

•  – Brings up the Train Words dialog window so you can immediately train the 

selected command.

•  – Adds the selected command to a list for later training. When you choose this 

button, you will see the Train List button become available.

•  – Opens the Train Words dialog window showing the list of commands you 

added using the Train Later button.

If you close the Command Browser before training the commands in your Training list, 

the list will be cleared.
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CUSTOM COMMANDS

Now, seriously, how good would Dragon NaturallySpeaking be without the ability to create your own 

custom commands? Not very.

We do “custom” activities on our computers every day. Whether it’s opening a Word template, going to 

our favorite sports team’s Web site, or sending an on-line payment to the credit card company (ugh!), we 

have tasks we do again and again. DNS makes it possible for us to create commands that when spoken will 

instruct the computer to perform a given task or series of tasks.

VIEWING CUSTOM COMMANDS

To begin with, let’s explore custom commands already in place. Nuance is kind enough to “pre-load” 

DNS with a few custom commands to help us get started.

❖ Open the Command Browser.

❖ Click the Script button . This displays the custom commands by “Grammar.” The default 

scripts shown are Global Commands.

❖ To view a different Grammar, use the pop-up list.

❖ Beside each custom script is an icon that indicates the type of command:

•  is a Text and Graphics command. These commands enter text and/or graphics at the in-

sertion point in your document.

•  is a recorded “macro,” meaning a sequence of mouse and keyboard actions that are 

replicated when this type of command is activated.

•  is a Step-by-Step command. These commands perform sequential menu and keyboard 

actions.

•  is an Advanced Scripting command. For those users familiar with programming languages 

such as Visual Basic, complex commands can be created to perform just about any function pos-

sible on a computer.
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The explanation of programming languages, such as Visual Basic, are outside the scope 

of this Guide. WAY outside. If you’re interested in learning Visual Basic, visit your favor-

ite bookstore. There are many books available. Also check local colleges for courses.

❖ Expand any command by clicking on the plus sign (+) to the left of the command.

• The name of the command (e.g., “sample signature”) is what you say to invoke that command.

• Any variable value – something you say depending on the the situation – is shown in brackets 

(<>).

As an example, let’s take a look at one of the sample commands provided with the installation of DNS 

Professional:

This command means that you can say SAMPLE SCRIPT [1-10] and any of a list of values. By expanding 

the command

 

we can see that it is allowing us to say SAMPLE SCRIPT [1-10] [ELEPHANTS/GIRAFFES/HORSES/

RABBITS/SNAKES].

Now, this is an Advanced Script, but we use it as an example to illustrate the different parts of an ex-

panded view of a custom command. We will now show you how to create your own custom commands.

CREATING COMMANDS

Here’s where we begin learning how to create custom commands to help you be more productive with 

Dragon NaturallySpeaking. As previously stated, custom commands give you unprecedented abilities to 

increase efficiency by teaching DNS how to perform repetitive tasks by simply saying the name of the 

command.

MYCOMMANDS EDITOR

Creating custom commands begins with learning how to use the MyCommands Editor.

To invoke the MyCommands Editor, do any of the following:
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‣ Go to

Tools > Add New Command

‣ Say ADD NEW COMMAND or ADD COMMAND

‣ Click the  button in the Command Browser. Then click the  or 

 buttons.

•  will allow you to create a command from scratch.

•  copies a selected command, allowing you to create a new command by simply 

editing an existing command.

•  will also invoke the MyCommands Editor for altering an existing command.

Let’s review the different parts of the MyCommands Editor window:

❖ MyCommand Name. Gives your command the actual word or phrase that will be dictated to invoke 

the command. Once a name is entered, you can use the  button to teach DNS how you 

pronounce the command name. Angle brackets (<>) in the name are used to insert variables (see 

Name Editor for information on how to create variables).
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There are certain limitations on how you can name a command. After all, it must be one 

you can dictate. A command name cannot be more than 200 characters. It can contain 

spaces, periods, apostrophes, hyphens, numbers and letters, but it cannot contain 

other symbols (e.g., *, @, #, $, %, or _).

❖ Description. Enter an optional description of the command, such as “Opens Solitaire.”

❖ Group. The group list contains, by default, two groups: “User-defined” and “Dragon.” You can use 

these groups for locating your custom commands in the Command Browser. To create your own 

groups, type over “User-defined” and a new group list will be created.

You can use groups to help segregate your custom commands. Initially, you may not have so 

many to categorize, but as you learn to build (and love!) custom commands, you may want to 

group them according to purpose, such as “signatures,” “Excel macros,” or “Boilerplate.”

❖ Availability. The chosen radio-button indicates when the command is available for use:

• Global – The custom command is available in every application you use on your computer.

• Application-specific – The command is available only for a specified application. Selecting this 

option causes a list of currently open applications to appear. If the application you want is not on 

the list (i.e., it is not open on your computer), you can use  to locate the target appli-

cation on your computer.

• Window-specific – When you select this choice, the window now shows you a list of open appli-

cations and windows. If you don’t see the application and window you wish to use, you have to 

close the MyCommands Editor, open the desired application and window, and then return to the 

MyCommands Editor.
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You can create multiple commands with the same name – but having different out-

comes – if each command is window-specific.

❖ Recognizable in States. States refers to different states of a window, an advanced scripting capability.

❖ Name Editor. The Name Editor allows you to edit the name of the Command to include variables. See 

Name Editor.

❖ Save. As it implies, it saves your command.

❖ Cancel. Click to close the MyCommands Editor without saving any changes you made.

❖ Create New. Creates a new command by duplicating the currently open command. This only works 

with custom commands.

❖ Help. As with most dialog windows in DNS, you can click to get help specific to the MyCommands 

Editor window.

NAME EDITOR

You may want to create commands which include variables in the name, such as INSERT [1-5] PARA-

GRAPHS. Which, as we have learned, means saying the command with any number, from one to five, as 

the number of new paragraphs you wish to insert at the current insertion point.

You can insert variables directly in the MyCommand Name text box, and the Name Editor will be invoked 

when it detects angle brackets (<>), which you would insert to denote a variable list. However, clicking on 

 will bring up the Name Editor dialog window.
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Using our current example – creating a command to insert one to five paragraphs – you would do the 

following:

1. Type Insert  into the MyCommand Name field.

2. Click Insert List…  to bring up the “Insert List” dialog window. It may default to a “1to10” list. 

The dialog window provides a drop-down menu of existing lists.

3. To create your custom list of “one to five,” begin typing the name of your new list in the “List name” 

text box: 1to5

4. The “List contents” will be empty. Enter the following words, each on a separate line the “List con-

tents” text box:

• one

• two

• three

• four

• five

5. Click OK  to save your new list. You should now see “Insert <1to5>” displayed in the 

“MyCommand Name:” text field.
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6. Add Paragraphs to the command name.

7. Click OK . Now you can see your new command name, with the background dimmed. 

This indicates that the command name can only be edited using the Name Editor. You can invoke 

the Name Editor by clicking into the command name and typing (as well as clicking 

).

At this point, another example of the sophistication of DNS reveals itself. Consider that now you have this 

new command, you want to train DNS on how you will pronounce it. As you can see, you have created a 

command for which there are five possible versions (e.g., INSERT ONE PARAGRAPH, INSERT TWO 

PARAGRAPHS, etc.).

8. Click . You can see that DNS now presents you with the Train Words dialog window:

9. Each variation is displayed, and if you click Go , you can pronounce each variation in 

sequence.

As usual, DNS provides you with all the tools necessary to not only get more done, but get it done with 

greater accuracy. 

TEXT AND GRAPHICS COMMANDS

When you create a new command, the default Command Type is Text and Graphics ( ). These com-

mands are perfect for routine insertions such as addresses, company logos, and e-mail signatures.
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The parts of the MyCommands Editor that pertain to Text and Graphics commands are:

❖ Content. This contains what will be inserted when you invoke the command. This can be text and/or 

graphics. Graphics can be pasted from other programs, using Copy / Paste.

❖ Toolbar. The icons below the Content area can be used to style what you type in the Content area. 

You can also use common keyboard shortcuts such as CTL-b for bold or CTL-u for underline.

❖  Variable. You can insert a variable field into a Text and Graphics command to allow you to dic-

tate specific values.

➡ Text and Graphics Voice Fields

❖ Plain Text. You can have the text you enter for your command retain whatever font you choose as you 

create the command, or adopt the font style and size of the text preceding it in your document. If you 

want your command to be styled just like the text into which it is inserted, check this box.

DNS provides a sample Text and Graphics command called “sample signature.” To learn 

from this sample, open it in the Command Browser and see how it was constructed.

Additionally, open a word-processing document or DragonPad and dictate SAMPLE 

SIGNATURE. The contents of this sample command will be inserted at the place your 

cursor is positioned in your open document.
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CREATING A TEXT AND GRAPHICS COMMAND

To create a Text and Graphics command is about as easy as creating a WordPad document:

1. Open the MyCommands Editor:

• Say ADD NEW COMMAND,

• Click

Tools > Add New Command

• Or click  from the Script mode of the Command Browser.

2. Confirm that “  Text and Graphics” is the chosen Command Type. Click on the drop-down list, if 

necessary, to select Text and Graphics

3. Type the name of your command in the MyCommand Name text box.

4. If you wish to teach DNS your pronunciation, click Train… .

5. Optionally, enter a description of your command in the Description text field.

6. Use the Group list to choose whether your new command is to be a Dragon command, or one of 

your own-named group. You can choose another group you have already created, or click into the 

Group field to type and create a new User-defined group.

7. Click the appropriate radio button for your new command’s availability: Global, Application-

specific, or Window-specific.

8. Type or dictate what you would like to appear when you invoke your command. You can generally 

type and format the text just as you would in any word-processing program.

• You can copy formatted copy from another program.

• Bitmap images can be created in other programs and pasted into the Content area.

• Whenever pasting text or bitmap images into the Content area, select the “Formatted Text” op-

tion to preserve the way the bitmap or text was formatted in the source document.

9. Once you’re finished creating your command, click Save .

Text and Graphics commands create text in “rich text” format, like files ending in “.RTF.” 

Rich text formatting means that formatting information is retained.

Some programs cannot accept RTF text (e.g., NotePad). In these cases, your text will 

be inserted as “plain text” without retaining your formatting.
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TEXT AND GRAPHICS VOICE FIELDS

 While advanced scripting commands can give you advanced template manipulation, a great number 

of situations where you need to be able to modify specific information in a “boilerplate” can be handled 

quite well using this new feature of Dragon 10.

In essence, in a Text and Graphics Command, you can place variables which you can change as you dic-

tate.

For example, if you create a Text and Graphics Command to insert the phrase “The patient’s temperature 

is 98.6,” but you want to be able to modify the temperature shown, you can create:

The patient’s temperature is [default value].

The variable is enclosed with “delimiters,” in this case the brackets ([ ]). These delimiters (which can be 

changed in the Command Tab of the Options dialog window) tells the command that this value can be 

dictated.

If you want the default value (if you do not change the value while dictating) to 98.6, you can change the 

command to read:

The patient’s temperature is [98.6].

If you name this command “Patient Temperature,” then when you dictate Patient Temperature, the fol-

lowing would be typed:

The patient’s temperature is [98.6].

At this point, you have two options:

❖ Leave the default value. If you want “98.6” to remain, dictate CLEAR DELIMITING CHARACTERS to 

remove the brackets.

❖ Change the variable value. Select the variable with your mouse, or dictate NEXT [VARIABLE/FIELD]. 

Then dictate the value you wish to include. When you change this value, the delimiters will be auto-

matically removed.

Once you get the hang of using variables in Text and Graphics Commands, you’ll find a 

thousand and one uses! It can be a powerful way of inserting boilerplate content into a 

report while giving you the capability of easily changing the variable content.

While dictating [NEXT/PREVIOUS] [VARIABLE/FIELD] may be convenient enough, 

the Dictaphone PowerMic II desktop recorder has buttons that can be assigned to these com-

mands as well, increasing your ability to easily navigate between the variables.
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You can only use the [NEXT/PREVIOUS] [VARIABLE/FIELD] commands in applica-

tions where all of Dragon’s functionality is supported. Use the Select and Say Indicator to 

help you determine if you are in an application or window where all Dragon functionality 

is available.

MACRO COMMANDS

To create a Macro command, you record a sequence of mouse movements and keystrokes. Dictating a 

Macro command invokes these actions in the sequence you recorded. Macro commands can be powerful 

tools for performing repetitive tasks such as creating a new document or switching users.

In general, you create a Macro command by having DNS record your actions on the screen. Afterwards, 

you can insert additional keystrokes and mouse movements, as well as edit recorded actions, to fine-tune 

your command. Using the Macro recorder takes a bit of practice, as you learn its particular quirks:

❖ Macros record your mouse movements based on the resolution of your monitor and the position of 

items in your menus and desktop. If you change your monitor resolution or the position of items, your 

macro may not work as intended. Where possible, use keystroke equivalents for computer actions, 

instead. Depend as little on mouse movements and more on keystrokes.

❖ Sometimes, actions on your computer don’t happen immediately, such as when you open the Start 

menu. If so, you may need to record your macro including pauses.

❖ The resulting command script can be quite lengthy and difficult to edit. It might be easier to simply re-

record your macro.

❖ When recording a macro, whatever you type is recorded into the macro. This includes any sensitive 

information you have typed such as credit card numbers and passwords. Take care that you do not 

compromise your own security by including these in macros.

The Macro command functionality in DNS is not perfect nor extensive, but it can many times fill your 

needs for a quick, simple way of creating a command – particularly if you are not skilled in Advanced 

Scripting Commands.

When you choose to create a Macro command, the MyCommands Editor changes when you select “  

Macro Recorder” from the Command Type drop-down list:

❖ Actions. When you record a macro, the resulting sequence of mouse movements and keystrokes will 

be added to this box.

❖  Click to begin recording your macro sequence. A floating recorder window will appear in 

the lower-left corner of your screen.
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❖  will begin playing your macro. This is useful in testing your recorded macro.

❖ Insert…  invokes the Macro Recorder Action dialog window, where you can add a step into 

your recorded macro.

❖ Edit…  opens the Macro Recorder Action dialog window so you can make any adjustments to 

the selected step.

❖ Delete  will delete a selected sequence step.

CREATING A MACRO COMMAND

To create a Macro command, you follow the same steps as Creating a Text and Graphic Command, ex-

cept that instead of entering text and graphics, you click .

1. The MyCommands Editor window disappears.

2. A floating record palette appears in the lower-left corner of your screen.

3. Perform the actions you want as part of your new macro command.

4. When you are finished, click the  Stop Recording button on the palette to end your recording 

session.

5. To play back your macro before returning to the MyCommand Editor, click the  Play button.

6. If you wish to re-record your macro, click the  Record button. Doing so will replace anything 

previously recorded.

7. During recording, if you wish to pause the recording (e.g., if a pop-up window suddenly interferes 

with your process), click the  Pause button. To resume, click the  Record button again.

8. When you’re satisfied with your recording, click the “X” in the upper corner of the record palette to 

close it and return to the MyCommands Editor window. You have to use the  Stop button first 

before closing the record palette.
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When we create macros, especially long ones or those requiring unfamiliar keystrokes, 

we often write out the steps we want to take before actually recording the macro.

MODIFYING A MACRO COMMAND

After recording, you may find you wish to add, edit or delete steps in your macro command.

‣ Insert. To insert a step, select a step in the macro and click Insert… . Your new step 

will be inserted before your selected step. To add a step to the end of the macro, click 

the blank area at the end of the sequence before clicking Insert… .

• The Macro Recorder Action window gives you the ability to create a macro step for any type of 

keyboard or mouse action listed in the “Action Type” drop-down list.

• Key Down / Key Up actions allow you to enter one keystroke from your keyboard. Shift, 

CTRL and other like keystrokes count as one macro step.

If you are trying to use a macro to input repetitive text, consider using two commands 

instead of one: a Macro Command for positioning your cursor into the correct text area, 

and a Text and Graphics Command for entering the text. Editing the text in a Text and 

Graphics Command is much easier than editing each letter step of a Macro Command.

Another good alternative is using a Step-by-Step Command.

• The other mouse-related actions require that you enter an X/Y coordinate for where the mouse is 

to be positioned. DNS uses coordinates to not only indicate where the mouse cursor is posi-

tioned, but to control the speed of the mouse movement by recording multiple coordinate points 

along the path of the recorded mouse movement.

‣ Edit. To edit a step, select a step and click Edit… . When you have finished editing 

the step, click OK  to save your changes and return to the MyCommands 

Editor window.
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Since macros record movements and keystrokes relative to the computer on which they are recorded, 

there is only one included sample with the standard DNS installation.

1. In the Command Browser, click the  button.

2. In the Grammer drop-down list at the top of the Command Browser, select “Microsoft Paint.” You 

will see in the list of commands, one called “sample action.”

3. To see this command in action, open Microsoft Paint on your computer. Dictate SAMPLE ACTION. 

Watch as DNS controls your mouse and keyboard to draw a smiley face. This may not work in Vista.

STEP-BY-STEP COMMANDS

Where Macros record actual mouse movements and keystrokes, Step-by-Step commands allow you to 

build a series of actions to activate menus and keystroke commands that control applications. Each step of 

the sequence can be one of the following:

❖ Send keystrokes. Used primarily for actions such as directional, function and special-purpose keys.

❖ Open applications. Sends a command to open an application or a document.

❖ Wait. Specifies a pause in the script to allow the computer actions to get to a certain point before 

proceeding.

❖ Type text. Inserts a string of pre-determined text.

❖ Send keys. Submits a sequence of keystrokes, including key combinations (e.g., CTRL-V).

❖ Stop Listening / Microphone On / Microphone Off. Controls sleep and microphone on/off for 

Dragon NaturallySpeaking.

The MyCommands Editor, as with other command types, changes its layout when you choose a  Step-

by-Step command.

❖ Steps. Shows each step in the sequence.

❖ New Step. Choose a step type from the drop-down menu, then click on Insert…  to add a new 

step to the sequence.
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❖ Edit…  allows you to edit a step selected in the “Steps” box.

❖ Copy  will make a copy of the selected step.

❖ Paste  adds any copied step above a selected step.

❖ Delete  deletes the selected step.

❖ Move Up  and Move Down  moves a selected step to another position in the sequence.

CREATING A STEP-BY-STEP COMMAND

The creation of a Step-by-Step command is quite straightforward. Unfortunately, there is no way to test 

your work as you create the command as there is with a recorded macro. If you note your actions as you 

perform the sequence outside of the Command Browser, you can then use those notes to construct your 

new Step-by-Step command.

The new command is built by choosing from one of eight different step types and entering any necessary 

parameters for the particular step.

‣ Keystrokes. These act as if you pressed a particular key or key sequence. If you want more 

than one key or key sequence pressed, use the “Send Keys” step type (following).

‣ Open (application). Opens an indicated application or document. If the application or 

document is already open, this step would switch to make it active.

Expert Series Mastering Dragon NaturallySpeaking 10 Professional  

© MMVIII American Dictation Corporation • All Rights Reserved • 155



• Target – The path and name of the desired application or document. Click 

Browse…  to use the Open dialog window to locate a target application or 

document.

• Arguments – Some applications may required additional information. For example, if 

you were going to the American Dictation Web site and this step opened the Fire-

fox browser, you could use http://www.AmericanDictation.com as 

the argument.

• Start in – The directory in which the application or document should open.

The “Start in” argument is only used by advanced Windows users. In cases where an 

item doesn’t sound familiar, you should begin by not entering or guessing. Leaving it 

blank will usually work and will avoid accidentally entering a parameter that could be 

harmful to the operation of your computer.

• Run – Selects whether the application or document should run in normal, maximized or 

minimized window mode.

Some applications will only run in the window mode they were using before you invoked 

a Step-by-Step command. Any “Run” steps in your command for that application will 

therefore be ignored.

‣ Wait. Inserting a “Wait” step causes the operation of the command to pause for a given pe-

riod of time. You may find it necessary, for example, to pause your script to allow an 

application to open or a network connection to become active.
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• You can set the length of the wait period by entering a number, clicking the up/down 

arrows, or moving the slider. The maximum allowable wait time is 2,500 millisec-

onds or 2 ½ seconds.

If you experience inconsistent results using a Step-by-Step command, Nuance suggests 

that you try adding “Wait” steps of 2,500 ms between each keyboard action step.

‣ Type Text. Use this step to have the command insert a string of characters at the cursor inser-

tion point. This step is often used to enter words or phrases that will be inserted into 

forms or spreadsheets.

• Enter the string of characters you wish DNS to type. You can only use alphanumeric 

characters found on the keyboard.

‣ Send Keys. With “Send Keys,” you can use a sequence of keys – including CTRL, ALT 

and SHIFT key sequences – as a step in your command.
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• You can create a sequence by entering keys that are represented on the keyboard (e.g., 

a, B, &).

• You can also enter sequences by using non-printing keys enclosed in curly brackets ({}). 

For example, if you wanted to send the sequence “Insert s” you would enter {IN-

SERT s}. The following is a table of “reserved words” that are used with this 

command:

BACKSPACE {BACKSPACE} or {BS}

BREAK {BREAK}

CAPS LOCK {CAPSLOCK}

SCROLL LOCK {SCROLLLOCK}

LEFT ARROW {LEFT}

RIGHT ARROW {RIGHT}

UP ARROW {UP}

DOWN ARROW {DOWN}

DELETE or DEL {DELETE} or {DEL}

INSERT {INSERT}

HOME {HOME}

END {END}

PAGE UP {PGUP}

PAGE DOWN {PGDN}

RETURN {RETURN}

ENTER {ENTER}

ESC {ESCAPE} or {ESC}

HELP {HELP}

TAB {TAB}

F1-F24 {F1} through {F24}

NUMPAD 0 {NUMPAD0} or {NP0}

NUMPAD 1 {NUMPAD1} or {NP1}

NUMPAD 2 {NUMPAD2} or {NP2}

NUMPAD 3 {NUMPAD3} or {NP3}

NUMPAD 4 {NUMPAD4} or {NP4}
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NUMPAD 5 {NUMPAD5} or {NP5}

NUMPAD 6 {NUMPAD6} or {NP6}

NUMPAD 7 {NUMPAD7} or {NP7}

NUMPAD 8 {NUMPAD8} or {NP8}

NUMPAD 9 {NUMPAD9} or {NP9}

ADD {ADD}

SUBTRACT {SUBTRACT}

MULTIPLY {MULTIPLY}

DIVIDE {DIVIDE}

DECIMAL {DECIMAL}

SEPARATOR {SEPARATOR}

SPACE {SPACE}

SELECT {SELECT}

PRINT {PRINT}

EXECUTE {EXECUTE} or {EXEC}

SNAPSHOT {SNAPSHOT}

CANCEL {CANCEL}

WINDOWS {WINDOWS} or {WIN}

APPLICATIONS {APPLICATIONS} or {APPS}

LEFT BUTTON {LBUTTON} or {LBTN}

RIGHT BUTTON {RBUTTON} or {RBTN}

MIDDLE BUTTON {MBUTTON} or {MBTN}

CLEAR {CLEAR}

• If you are using one of the following key modifiers, use the shown reserved character:

SHIFT + (plus sign)

CTRL ^ (caret)

ALT % (percent sign)

• For example, use ^V for CTRL-V.
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• If you want a key to repeat, you can append the number of repeats to the key, such as 

in {RETURN 4} to cause the RETURN key to be repeated four times.

‣ Stop Listening. Puts the DNS microphone to sleep.

‣ Microphone Off. Turns off the DNS microphone.

‣ Microphone On. Turns on the DNS microphone.

You can find a sample of a Step-by-Step command in the Command Browser, called 

“sample steps.” This simple command opens NotePad and inserts several words and 

moves the cursor to different lines in the document. This example shows almost all the 

step types and is good for reviewing how a Step-by-Step command works.

ADVANCED SCRIPTING COMMANDS

While any true “Master” of Dragon NaturallySpeaking would almost certainly employ advance scripting 

techniques, the creation of advanced scripting requires an advanced knowledge of scripting languages and 

programming techniques that fill volumes – certainly more than can be covered in this Guide.

Advanced Scripting commands can be built to control just about every aspect of your computer using 

your voice. Creating these commands, however, requires a working knowledge of Visual Basic, a program-

ming language built to help you interact with applications, documents, windows, menus and much, much 

more.

If you wish to delve into Advanced Scripting, you should check with your local college 

about courses in Visual Basic, or check out the many books available at your local book-

store.

STRUCTURED COMMANDS

As with Advanced Scripting Commands, Structured Commands provide a powerful extension to DNS 

Professional, Medical and Legal versions. Structured commands are extensive ways of creating templates 

that allow you to set values of variables in text blocks based on voice input.

Due to the highly advanced nature of this type of command, it is not covered in this Guide. If you’re not 

familiar with advanced scripting techniques, you should consult with a DNS expert who can help you cre-

ate the templates you may require.
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 USING TEMPLATES

After warning you about the complexity of using Advanced Scripting and Structured commands, we 

would like to help you address a situation that we have encountered with many of our own professional 

customers: how to use templates with DNS.

Physicians often use templates for their reports, dictating only those parts which are unique for each case. 

Some physicians have a couple of different templates, such as “H&P” (History and Physical) or “Notes.” 

Others we have worked with use as many as sixty or seventy different report templates.

Attorneys use boilerplate content and templates all the time, since so many legal documents contain very 

similar language.

Therefore, if you’re using DNS to gain efficiency, it stands to reason that you will want to retain the effi-

ciency you have in using templates. In this chapter, we want to offer you two ways of using simple com-

mands to speed up your dictation process using templates and boilerplate content.

There remain cases where complex scripting must be employed to fully maximize effi-

ciency with voice commands. However, we do feel the methods described herein pre-

sent great alternatives, especially for those just beginning to master Dragon Naturally-

Speaking Professional.

BOILERPLATE COMMANDS

Perhaps the easiest way of using the same text over and over again is to create Text and Graphics com-

mands that will insert boilerplate copy at the current insertion point. For instance, if you commonly use a 

particular clause or section in your legal documents, you can create a Text and Graphics command that 

when dictated will insert your copy.

1. Simply create a new Text and Graphics command, giving it a unique name you can remember. Use 

Train…  if you wish to teach DNS how you pronounce the command. 

2. Open a document that contains the text you wish to use. Select the text and copy it.

3. Put your cursor in the Contents field of your new command and paste your copied text.

4. Add any styling you wish and save the command.

Whenever you are in a document where you wish that text inserted, simply dictate the name of the 

command, remembering to pause slightly before and after dictating the command so DNS knows it is a 

command and not literal text to be inserted.
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FIND AND REPLACE

One oncologist we worked with uses over 70 Word templates, each for a particular type of cancer or 

procedure. In each template, much of the copy is constant for each patient. However, since each case is 

different, he does have to dictate unique items such as patient name, current or observed condition, pre-

scriptions, treatments, etc.

Instead of spending lots of our time and his money scripting advanced commands, we simply had him 

take each template and insert a unique word or phrase at each point where he wished to dictate a unique 

part of the report.

For example, where the patient name was to be inserted, he typed “Patient Name Info.” Where he 

wanted to dictate his evaluation, he inserted “Evaluation Info.” The important thing was that each insertion 

was named as a phrase very unlikely to be used at any time in his reports. You could use any memorable 

phrase that is unique. He could have just as well used “Macaroni Name” and “Evaluation Summersault.”

After opening the template he wishes to use, he begins by saying SELECT PATIENT NAME INFO. This 

command highlights “Patient Name Info.” By then dictating the patient’s name, the selected text is replaced 

by his dictation. Next, he might dictate SELECT EVALUATION INFO, and then dictate what he wishes to 

replace the selected text (in this case, “Evaluation Info”).

VOICE FIELDS IN TEXT AND GRAPHICS COMMANDS

As discussed earlier, a new and very powerful means of providing boilerplates with variable fields is the 

use of Voice Fields in Text and Graphics commands. Once you master this relatively easy concept, you’ll no 

doubt find it an indispensable part of your workflow.

➡ Text and Graphics Voice Fields
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IMPROVING ACCURACY

Did anyone ever tell you that nothing is perfect in this world? Well, it does hold true for Dragon Natural-

lySpeaking. We are constantly asked “how accurate is it?” It’s an objective answer, not a subjective one.

The accuracy of DNS is affected by many different factors:

❖ Microphone or digital recorder quality and position.

❖ Your speaking clarity and style.

❖ Your use of vocabulary.

❖ Your writing and composition style.

❖ A variety of different settings within DNS.

Accuracy is often a question of compromises, as much as technical specifications. For instance, if you 

were trying to get a small child to understand you, would you talk fast or would you slow down to make 

sure each word was absorbed and understood? After speaking carefully to that child, you could probably 

speed up your speaking pattern as the child began to better understand your vocabulary, tone and inflec-

tion.

DNS is very much like a small child. It has to learn to understand you. You have to learn how to talk to 

DNS.

In this chapter, we will explore the ways you can improve the accuracy of Dragon NaturallySpeaking. 

What you must realize is that the most important tactic for improving accuracy, however, is practice.

IMPROVING YOUR DELIVERY

There are two important parts to your delivery: your recording device and how well you speak. While 

you want speech recognition to work with as little impact on how you currently work, you may find you 

need to make some adjustments if you wish to fully maximize DNS’s ability to understand you as clearly as 

possible.

The most important advice we can give you at this point is: Be Consistent. Try to position your recording 

devise the same way each time you dictate, and try to dictate using the same volume and pace as when 
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you created your user profile.

To review our guidelines for using various input devices, see

➡ Direct Dictation / Using a Headset Microphone

➡ Direct Dictation / Using a Handheld Microphone

➡ Third-Party Dictation / Dictating with a Portable Digital Voice Recorder

SPEAKING CLEARLY

For some dictators, the challenge in improving accuracy comes with learning to speak more clearly. Some 

erroneously equate this with having an accent; however, DNS is quite adept at understanding very pro-

nounced accents. What is more important is that you speak using your normal voice, but with the most 

clarity possible.

Nuance suggests the following for optimizing speech recognition accuracy:

❖ Speak continuously and enunciate each and every word.

❖ Speak in long phrases rather than in short phrases or individual words.

❖ Speak at your normal speed.

❖ Do not mumble or slur your words.

❖ Try not to say “um” or “uh.” Pause silently instead.

One of the best pieces of advice we ever heard – and one we constantly pass on to our 

customers – is to speak as if you are a newscaster. It doesn’t mean you have to speak 

with the emphatic, staccato cadence of the legendary Walter Cronkite; it does suggest 

that you speak with the clarity and enunciation you would use if you were hired to read 

the nightly news.

ACCURACY CENTER

Since the quest to achieve maximum accuracy is so important to users of speech recognition, Dragon 

NaturallySpeaking has a whole tool set devoted solely to helping you increase your dictation accuracy, 

called the “Accuracy Center.” This is a central location for accessing the many tools to help you.
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To open the Accuracy Center, do one of the following:

‣ Go to

Tools > Accuracy Center

‣ Say START ACCURACY CENTER

The Accuracy Center window is actually a window of links – like links on a Web page – that open up 

various accuracy-related tools. To open any link

‣ Click on the link, or

‣ Begin dictating the first few words of the link.

THE ACCURACY ASSISTANT

To help you when you feel you’re having accuracy problems or inconsistencies, DNS provides a small 

self-help tool called the “Accuracy Assistant.”

To open the Accuracy Assistant from the Accuracy Center:

1. Click or say WHICH TOOL SHOULD I USE?

2. In the Accuracy Assistant window, click or say the link that best addresses the problem you’re hav-

ing.

The resulting window will provide you with steps to take to cure the problem you’re having. The Accu-

racy Assistant is a good place to start, particularly if you don’t have this Guide handy.
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IMPROVING ACOUSTICS

As we’ve explained earlier, part of DNS’s ability to understand your dictation is the audio quality of your 

speech. In the Accuracy Center, there are three tools designed to help you maximize the audio quality of 

your dictation.

One tool directly addresses the fidelity of the audio input from a microphone. The other two tools deal 

with the “Acoustic Model” Dragon NaturallySpeaking creates and uses to match your voice against what it 

knows about how you sound when you speak.

AUDIO SETTINGS

Sometimes, especially if you switch microphone types, you may need to double-check and make sure 

DNS is hearing you well. There are two attributes relating to sound quality:

❖ Volume. Of course, if DNS cannot hear you loudly enough, it will not gather enough acoustic infor-

mation to adequately translate your speech into text.

❖ Signal-to-Noise Ratio. All reproduced sound includes a certain amount of “noise” such as the inher-

ent hum of electronic devices. If you listen closely when no music is playing on your home stereo, for 

example, you may be able to detect a low level of noise. For your home stereo, the ratio of the music 

you hear and this underlying noise is called the Signal-to-Noise (S/N) ratio. As with any sound repro-

duction, DNS would like the highest ratio possible so that it hears more of your voice and less of the 

“noise.” Usually, a S/N ratio of 18 or more appears to be sufficient for DNS.

To check your audio settings:

1. Click or say CHECK YOUR AUDIO SETTINGS.

2. Follow the instructions shown, which should be familiar to you as they are the same as when you 

first created your User profile.

If DNS cannot adjust your computer’s volume or finds the S/N ratio is too low, it will let you know. Al-

though in some cases there are few adjustments you can make without outside technical assistance, there 

are other steps you can take that may remedy these problems:

❖ Check your Sound Control Panel settings. Make sure you have the correct device and input port or 

jack selected. Adjust the master volume and other controls, testing each time to see if it improves with 

DNS. You may also find you simply need to speak louder.

❖ Use a better microphone. The headset that is included with a full-box version of DNS should be 

quite sufficient for your use. However, if you’re using another microphone that is not optimized for 

speech recognition, you may find it is picking up too much extraneous noise which would affect your 

S/N ratio. Try upgrading to a better headset or standalone microphone. Don’t assume that any micro-

phone that works with your computer will be of sufficient quality for speech recognition.
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”Check your audio settings” works for Direct Dictation purposes. However, if you’re 

using a digital voice recorder or other device for Third-Party Dictation, adjusting 

audio settings will have no effect.

If you feel audio quality is an issue when using a recorder, make sure you have the 

recorder “Record Mode” set to its highest quality setting. Adjust how you hold the recorder, and 

avoid the use of noise-canceling microphone devices that may filter out too much sound.

ACOUSTIC AND LANGUAGE MODEL OPTIMIZER

As you make corrections in Dragon NaturallySpeaking, whether by typing or training, DNS stores this 

information and uses it to continually improve its accuracy. Periodically, it is helpful to let DNS take this 

accumulated data and “re-compile” your user profile. By doing so, you’re allowing DNS to further increase 

accuracy by taking all the corrections you’ve made and making a more in-depth analysis of the acoustic 

differences between what it thinks you say and what you corrected.

Additionally, by using the Acoustic and Language Model Optimizer, you are helping DNS update the sta-

tistical information that it uses to predict word context. That is, what words are most appropriate given the 

context in which they occur.

Word context means, for DNS, what word or homonym is the best choice based on what 

other words are dictated around the given word. For example, the ability of DNS to 

accurately transcribe “Two boys went to town, too” is due to the fact that DNS knows 

which version of “two/to/too” is appropriate based on the word’s proximity to other 

words, and the context of the total phrase.

Word context is a highly sophisticated attribute of DNS that helps make it the tremendous tool it 

is.

For the Acoustic and Language Model Optimizer to work properly, DNS stores corrections in an archive. 

This archive can store up to 180 minutes of corrections. Before you begin using the Acoustic and Language 

Model Optimizer, make sure that “Store corrections in archive” is selected in the Data tab of the Options 

dialog window.
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You can also adjust the size of the archive downward from 180 minutes if you’re concerned about hard 

drive space.

We consider using the Acoustic and Language Model Optimizer vitally important, par-

ticularly in the beginning use of DNS. The more you can help DNS learn how you speak, 

the faster you will achieve maximum efficiency.

If you are dictating using a Roaming User, optimization can only take place from the 

“master roaming user.”

To run the Acoustic and Language Model Optimizer from the Accuracy Center:

1. Click or say RUN THE ACOUSTIC AND LANGUAGE MODEL OPTIMIZER.
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2. In the Acoustic and Language Model Optimizer window, select either or both of the shown choices.

• Select “Perform Acoustic Optimization” to have DNS analyze the corrections and train-

ing you have made to adjust how it interprets your speech.

• Select “Language Model Optimization” to have DNS analyze your writing style and con-

tent.

Nuance highly recommends that you check both selections when running the Acoustic 

and Language Model Optimizer, particularly in your early use of the software. Checking 

both will not hurt anything, even if there is no related data available at that time.

If you do attempt to run the Optimizer before you have trained any corrections, you 

may get an error message saying that there is not enough data to process. Don’t worry about 

this error; just return at a later date and run the Optimizer.

3. Click Go  or say GO.

4. You may be asked to save your current user files. Unless you have made recent corrections you do 

not specifically want to retain, click Yes .

5. The Optimizer will begin analyzing the data. Depending on the number of corrections and dicta-

tions completed since the last optimization, this process could take quite a while. The Optimizer, 

after a while, will indicate an estimated time until completion. This time is dependent on many 

factors, including computer speed, size of data to be analyzed, etc.

6. When the Optimizer has completed its analysis, click Done . The Optimizer will ask you if 

you would like to save you speech files. Click Yes .
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You can help the Optimizer by training multiple word phrases more so than individual 

words. How you pronounce a single word many times differs from how you pronounce a 

word as part of a phrase.

SCHEDULING THE ACOUSTIC AND LANGUAGE MODEL OPTIMIZER

Optimizing your user profile can sometimes take an hour or more, depending on the number of correc-

tions you have made since the last optimization. To help you maintain optimization without taxing your 

computer, DNS provides a means of scheduling optimization.

❖ You can schedule an optimization session to begin after hours, when your computer is not being used 

for other purposes.

❖ You can schedule optimizations for one or more users on a regular basis. This is especially beneficial 

during the first weeks of use to insure that your user profiles are as accurate as possible.

If you are using DNS regularly, we recommend running the Acoustic and Language 

Model Optimizer at least once a week during the first month, then monthly thereafter. 

You can run it more frequently if you wish, as long as it is a period of time sufficient to 

process a number of corrections that have been saved. In other words, there is no need 

to run it too frequently, as there may not be enough data available for DNS to process.

You can also create more than one scheduled task for a user. For instance, you may wish to run 

the Acoustic Optimizer weekly (if you make numerous training corrections) and the Language 

Model Optimizer monthly (if you don’t make many vocabulary changes). You may also wish to 

create optimizations for different input devices and vocabularies.

There are two ways to open the Optimizer Scheduler:

‣ With the Accuracy Center open, click or say SCHEDULE ACOUSTIC AND LANGUAGE 

MODEL OPTIMIZER TO RUN LATER.

‣ Go to

Start > Dragon NaturallySpeaking 9.5 > Dragon NaturallySpeaking Tools > Acoustic and Lan-
guage Model Optimizer
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To create a schedule for the Optimizer:

1. Click  in the tool bar of the Optimizer window or go to

File > New Task 

2. Enter your Windows user name and password in the dialog box that appears.

You must provide a fully-qualified Windows domain and login name. See your Adminis-

trator if you do not know this information. Additionally, you must use a password to 

create an Optimizer Scheduler task. If you do not have a password, one must be cre-

ated before proceeding.

Note: this window will not appear if you are using Windows ME.
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3. Make your selections in the “Select Frequency” window:

• Optimization – Select which optimization you wish to have performed. In most cases, 

you will leave both selected.

• User Name – Select a user name from the drop-down list. You can also select multiple 

users by clicking Multiple Users  and using the resulting window to add more users 

to the task.

• Dictation Source – Choose the input device from the drop-down window.

• Vocabulary – Choose which vocabulary you wish to use for optimization.

• Select Frequency and Start Date & Time – Choose how often you wish to run the 

scheduled task and at what date and time you wish the first occurrence.

• Enabled – Check to make the scheduled task active. If you choose to discontinue a task 

in the future, you can de-select this item and still retain the task information in the 

event you wish to re-activate it at some time in the future.

4. Click OK  to save your scheduled task.

GENERAL TRAINING

Occasionally, it is helpful to “re-train” DNS to your voice. Some of the more common reasons include:
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❖ Modified dictation style. After you use DNS for a while, you may find you have adjusted how you 

dictate. You may have learned to enunciate better, or you have changed the speed in which you dic-

tate. It’s not uncommon for folks who may have read the initial training dialog quickly, yet find that 

when they’re composing their dictation, they begin to speak more slowly.

❖ Environmental change. When you create your user profile, you should train DNS in the usual envi-

ronment in which you will be using the software. If later you change your preferred location – maybe 

you’ve moved into another office – or if the current environment become more or less noisy, you may 

find your accuracy changes.

❖ Equipment change. You change your microphone or recording device.

When any change occurs that could affect how DNS hears you, you should perform General Training 

once again (in some versions this is called “Perform additional training”).

1. In the Accuracy Center, click or say PERFORM GENERAL TRAINING.

2. Follow the same instructions you did when you first did the training.

3. At the conclusion, click Finish .

You can train as little or as much as you wish. However, you should train for a minimum 

of 3 to 6 minutes, according to Nuance. The longer you train, however, the more likely 

your accuracy will improve.

RECOGNITION MODES

In most cases, you will be dictating in Normal Mode, meaning that you can dictate text and commands. 

However, you may wish to switch recognition modes to direct DNS to interpret your dictation according to 

strict rules to minimize misinterpretation. Switching modes is quite easy, and can help when you’re faced 

with dictating larger sections of text, numbers or commands.

NORMAL MODE

Normal Mode is the most versatile of the DNS modes, as Dragon NaturallySpeaking can in most cases 

interpret text, numbers and commands. In Normal Mode, commands are distinguished from dictation by 

analyzing what is spoken between pauses. If you pause before and after a command, DNS tries to match 

what is said against known commands, and if it finds a match activates the command.

Expert Series Mastering Dragon NaturallySpeaking 10 Professional  

© MMVIII American Dictation Corporation • All Rights Reserved • 173



You can adjust the interval of pauses 

to suit your dictation style. Go to

Tools > Options > Commands

Use the slider to adjust your pause interval 

from 1/10th of a section to one second.

You should try and choose an interval that is 

more accommodating to your dictation speed: 

if you speak slowly, you should use a longer 

interval; if you dictate quickly, you can use a 

shorter interval.

If you find that DNS is consistently typing in-

stead of activating your commands, you 

should adjust your pause interval.

As an example, in the following, the word “time” is bolded in the dictation:

Now is the time for all good men [pause] PERIOD [pause] SELECT time [pause] BOLD THAT [pause]

Yields: Now is the time for all good men

To switch to Normal Mode when dictating in another mode, say any of the following:

‣ SWITCH TO NORMAL MODE

‣ START NORMAL MODE

‣ NORMAL MODE ON

You can also go to

Words > Normal Mode

DICTATION MODE

Sometimes, particularly if you are using pauses while you dictate and don’t want or need commands in-

terpreted, you can use Dictation Mode. Nothing but dictation is interpreted.

This mode is also useful if you wish to dictate without watching your computer monitor.

To switch to Dictation Mode when dictating in another mode, say any of the following:

‣ SWITCH TO DICTATION MODE
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‣ START DICTATION MODE

‣ DICTATION MODE ON

You can also go to

Words > Dictation Mode

Alternatively, you temporarily switch to Dictation Mode by holding down the SHIFT key as you dictate.

COMMAND MODE

The opposite of Dictation Mode, Command Mode instructs DNS to interpret all dictation as commands. 

This can be helpful if you’re using Dragon NaturallySpeaking to give several commands in a row, such as 

when working in your Desktop.

To switch to Command Mode when dictating in another mode, say any of the following:

‣ SWITCH TO COMMAND MODE

‣ START COMMAND MODE

‣ COMMAND MODE ON

You can also go to

Words > Command Mode

Alternatively, you temporarily switch to Command Mode by holding down the CTRL key as you dictate.

As with most “Hot Keys” used in DNS, you can change the keys you hold down for 

switching temporarily to Dictation and Command modes by going to

Tools > Options > Hot Keys

SPELL MODE

When needing to dictate a string of letters, numbers or symbols, it can be helpful to switch to Spell Mode. 

We have found this mode particularly helpful when:

❖ Dictating Web or e-mail addresses.

❖ Dictating strings of non-sensical letters, such as serial numbers or software registration keys.

In Spell Mode, you can also dictate spaces and backspaces.

To switch to Spell Mode when dictating in another mode, say any of the following:
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‣ SWITCH TO SPELL MODE

‣ START SPELL MODE

‣ SPELL MODE ON

You can also go to

Words > Spell Mode

NUMBERS MODE

As Spelling Mode is helpful when dictating letters, Numbers Mode is useful when dictating numbers, such 

as when entering values in a spreadsheet. You can also dictate movement commands, such as UP, DOWN, 

and TAB.

To switch to Numbers Mode when dictating in another mode, say any of the following:

‣ SWITCH TO NUMBERS MODE

‣ START NUMBERS MODE

‣ NUMBERS MODE ON

You can also go to

Words > Numbers Mode

TEACHING DNS

In earlier chapters of this Guide, we covered various ways of making corrections that DNS Professional 

would analyze to increase your accuracy in later dictations. Various ways of teaching DNS have been previ-

ously covered:

➡ Correcting Mis-Interpreted Commands

➡ Correcting Text

PERSONALIZING YOUR VOCABULARY

A good deal of DNS’s accuracy in interpreting your dictation is based on vocabulary. Dragon Naturally-

Speaking Professional comes with a very extensive vocabulary. However, there will undoubtedly be words 

and contexts that you use that are unfamiliar to DNS.
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You can personalize the DNS vocabulary in several different ways. Before we discuss each method, you 

should be aware that:

❖ If you make changes to a vocabulary you do not want to keep, you can either create a new vocabulary 

or restore your user files from a backup copy.

❖ You should save your user files after adding new words or the new words will not be saved into the 

active vocabulary.

 ADDING INDIVIDUAL WORDS

 If Dragon NaturallySpeaking continually misinterprets a word, it may be that the word is not in the DNS 

active vocabulary. To add an individual word to the DNS vocabulary:

1. Open the Accuracy Center.

2. Click or say ADD A SINGLE WORD TO YOUR VOCABULARY.

3. Spell or type the word you want to add. You can use your voice to spell.

4. If you want to train the pronunciation of a new word, select “I want to train the pronunciation of 

the word.”

5. Click Add .

ADDING WORDS FROM DOCUMENTS

As you begin using Dragon NaturallySpeaking, you can easily add multiple words to the active vocabulary 

by allowing DNS to discover new words and phrases from your existing documents. This means that DNS 

can learn the words you use and in what context you use them by analyzing documents you have already 

written before using Dragon NaturallySpeaking.

Before using this tool, you’ll achieve the best results if you prepare the documents by removing unneces-

sary formatting. You should take each document you wish to have analyzed and convert it to plain text 

using the following guidelines:

❖ Separate each paragraph with a blank line.
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❖ Remove tables and bullet lists. Content in these items will be processed but probably do not include 

enough usable information for determining your writing style.

❖ Convert multiple columns to a single column.

❖ Convert captions to text if they contain relevant information. Otherwise, they will be ignored.

❖ Remove formatting styles, such as bold or italics.

❖ Remove all graphics.

❖ If headers, footers, and titles contain relevant information, move the copy into the body of the docu-

ment. Otherwise, remove these items.

❖ Remove duplicate information where possible.

To add words from documents:

1. Open the Accuracy Center.

2. Click or say ADD WORDS TO THE VOCABULARY.

3. Select the items you wish to have DNS analyze and click Next > .
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4.  Use Add Folder…   or Add Document…  to select the documents or folder of documents to 

analyze.

5. Click Next > . 

6. DNS will analyze your documents, putting a checkmark beside each document completed. Click 

Next > . 

7. DNS displays a list of unknown words. You can use check or un-check words you wish to add or 

not add, respectively, to your vocabulary. Click Next >  when you have finished proofing the 

list of words.

One of the more unique ways Dragon NaturallySpeaking learns vocabulary is through 

the use of the “spoken form.” For each word in the “Add Words to Vocabulary,” DNS 

allows you to enter how the new word is to be spoken. This is not training in the sense 

of teaching DNS how you pronounce a word; it is more for how you would dictate a 

particular word or phrase that is not evident.

For example, the acronym “AWOL” is generally pronounced “a-wall.” Another, “SCSI” (a com-

puter hardware term) is pronounced “scuzzie.”

Let’s also, as an example, assume that you want DNS to type “YuVu” whenever you say “you 

view” as a phrase. When you select “YuVu” in the list of words to be added, you can click “Edit” 

and enter “you view” in the text field labeled “Spoken form.”

8. In the next window, you can select which words you would like to train how to pronounce. Check 

those you wish to train and click Train… . Once the training is completed, click 

Next > .

DNS will then spend some time adapting your writing style by enhancing its statistical analysis of the 
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words you use and in what context you use them.

9. When this process is completed, click Next > .

10. DNS will present you with a present you with a summary of the words added to your vocabulary. If 

you are satisfied, you can click Finish .

11. Unless you do not want to add the words and writing adaptation to your profile, you should proba-

bly take this opportunity to save your profile:

NaturallySpeaking > Save User Files

ADDING WORDS FROM LISTS

If you deal with product, categories, or other lists of words that are unlikely to be in the DNS vocabulary, 

you can add them by importing them into Dragon NaturallySpeaking.

To prepare your list:

1. Create a text document for your new words.

2. Enter each word or phrase on a separate line. If you wish to include the Spoken Form for a word, 

follow the word with a backslash (\) and the spoken form. For example, if you want “John F. Ken-

nedy” to be typed whenever you say “JFK,” put “John F. Kennedy\JFK” on a single line in your 

document.

3. Save the document as a text (.TXT) file.

If you have more than one list to import, consider putting them into a new folder on your computer.

To add your words lists:

1. Open the Accuracy Center.
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2. Click or say ADD A LIST OF WORDS TO YOUR VOCABULARY.

3. Follow the instructions on the resulting wizard to add your words.

TRAINING SPECIFIC WORDS

While DNS does a formidable job of learning how you speak, there are certain cases where you may 

need to teach DNS how you pronounce certain words in your vocabulary.

To train DNS how you say a specific word, command or acronym:

1. Say WORDS (pause) TRAIN, or go to

Words > Train

2. Type the word you wish to train.

3. Click Train... .

4. Click Go  and say the word or phrase. When you pause, DNS will automatically stop 

recording.

5. Click Done  when completed.

Alternatively, you can use the Vocabulary Editor to train words already existing in your chosen vocabu-
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lary.

VOCABULARY EDITOR

The Vocabulary Editor gives you powerful tools for improving the accuracy and output of your dictation. 

To open the Vocabulary editor:

‣ Say OPEN VOCABULARY EDITOR, or

‣ Go to 

Words >  View/Edit…

The editor shows a list of words as they are written when transcribed by DNS in the first column. The 

second column shows how the word is spoken – that is, what you are to say in order to invoke the written 

form in the left column. Where the written form and the spoken form are alike, no value is usually shown 

in the right column.

When you first open the Vocabulary Editor, the first word shown is “a.” While the scroll 

bar on the right looks as though the Vocabulary Editor is at the top of the list, it is not. 

Scrolling up will reveal all the DNS commands, such as “New-Paragraph,” followed by 

special characters, suffixes, and much more.
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You can use the drop-down “Display:” menu at the bottom of 

this window to focus on certain sub-sets of words. For instance, if 

you feel DNS is misinterpreting how you pronounce numbers or 

certain words containing numbers, you can narrow the vocabulary 

to only show words containing digits.

A red star (  ) next to a word in the list means the word has 

been added to the list - a “custom” word.

A blue star (  ) is a word in which the properties have been 

changed (see Word Properties).

A green star (  ) is a word that was moved to the active vocabulary due to a correction.

”Temporary Words” – one of the choices in the “Display:” drop-down menu – are words 

added to your vocabulary from e-mails to which you are replying.

If you select an e-mail in Outlook or Outlook Express to reply, DNS finds new, unknown 

words in the original e-mail. If you use these words in your reply message, DNS will 

add these words as “temporary.” Since they are new words to your vocabulary, you might want 

to take the opportunity to train DNS on how your pronounce them.

Once you dictate a temporary word in an e-mail message you compose, the word is added per-

manently to your vocabulary, since DNS assumes this is a word you may wish again in the fu-

ture.

WORD PROPERTIES

 With Version 10, you have tremendous vocabulary formatting options, called “Word Properties.” In 

the Vocabulary Editor, you can highlight a word in the first column and click Properties…  to open the 

Word Properties dialog box.
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Certain dictation commands – such as ALL-CAPS-ON, NO-SPACE-ON, ROMAN-

NUMERAL – cannot be modified in the Word Properties dialog. If a chosen word cannot 

be modified, the “OK” button will be grayed out and cannot be clicked.

SPOKEN FORM

In some cases, what is spoken is different than what is written by DNS. In these cases, the Spoken Form 

will be shown as different. If not, it will be shown as the same as the Written Form. With inline commands 

(e.g., New Paragraph), there is no Written Form, only a spoken form.

WRITTEN FORM

This shows what is typed when the Spoken Form is dictated.

NORMAL FORMATTING

This section of the Word Properties dialog allows you to specify certain spacing and capitalization options 

for the chosen word:

❖ Insert [value] space before and [value] space after. Inserts the specified number of spaces before 

and after the word or phrase.

❖ Precede by [value] and follow with [value]. Inserts the specified spacing before and after. Choices 

include (nothing), New Line, New Paragraph and Tab.
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❖ Format the next word with [value]. Specifies how the word following the chosen word will be capi-

talized.

❖ Format preceding numbers [value] and following numbers [value]. When numbers come before or 

after the chosen word, you can specify if they will be treated according to normal DNS formatting 

rules or always as numerals.

❖ Lower case in titles. Many times, articles, such as “a,” “an,” and “the” are parts of a title or otherwise 

capitalized phrase. This selection forces the word to be set in lower case if it appears in the middle of 

a title, yet capitalized if at the beginning (e.g., “To Kill a Mockingbird,” or “The Taming of the Shrew”).

ALTERNATE FORMS

If an alternate form(s) of a word exists, it will be shown in this field(s). Alternates are used when you dic-

tate the same word twice. For instance, if you dictate “Texas,” then DNS will type “Texas.” If you select 

“Texas” and say it again, DNS will change it to “TX,” the alternate form.

You can force DNS to always use the alternate form by selecting the checkbox next to “Use alternate writ-

ten form…”

The Special…  button inserts white space instead of the word you say. For instance, if you want DNS 

to insert a tab, new line or new paragraph for the word dictated, select one of the items in this menu.

Format…  allows you to configure special formatting for the alternate form, just as you can with the 

primary form of the spoken word.

For selected alternate forms, you can also choose to have this form used only in certain cases where it 

appears before, between or after numbers.

MANAGING VOCABULARIES

Dragon NaturallySpeaking vocabularies are files that contain a word list and a language model. The word 

list includes information on each word, while the language model contains usage information about the 

words in the list. DNS not only works to recognize a spoken word, but determines which word is best 

based on its context.

When you created your user profile, you chose which vocabulary to use from among the following types:

❖ General (US English). This large vocabulary provides excellent recognition accuracy for general, busi-

ness and professional dictation purposes.
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❖ Commands Only. This is a “restricted” vocabulary containing only commands. Useful only in those 

cases where DNS will not be used for dictation.

Avoid adding custom words to a “Commands Only” vocabulary. Any future updates to 

DNS will not retain any custom word additions.

❖ Teens (US English only). This large vocabulary contains words used more by students and provides 

better accuracy for higher-pitched voices, such as those for children ages 11 to 18.

❖ Legal. The legal vocabulary that comes with DNS Legal Professional is a large vocabulary containing 

specialized words and phrases germane to the legal profession. It does a better job of handling items 

such as legal citations.

❖ Medical. With DNS Medical, you can also select from almost 80 specialty vocabularies. 

In addition to these Nuance-supplied vocabularies, there are third-party vocabularies available for pur-

chase. These usually provide even greater specialization.

CREATING NEW VOCABULARIES

From time to time, we have had customers who have wanted to use different specialty vocabularies to 

match the type of dictation they are doing. For instance, a cardiologist who also writes novels in her spare 

time, may find that switching to a General vocabulary for her off-duty writing may serve her better.

To create a new vocabulary in Dragon NaturallySpeaking:

1. Go to

NaturallySpeaking > Manage Vocabularies
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2. Click New… .

3. From the “Based on” drop-down list, choose the vocabulary to use. Those in the list that begin with 

“Base” are unmodified vocabularies that came with DNS.

4. Enter a descriptive name for the vocabulary. The name can contain up to 128 characters, including 

spaces.

5. Click OK .

6. Before using the new vocabulary, you may want to customize it using the Add Words from Docu-

ments or Add Words from Lists tools.

Vocabularies you create are saved with your user profile. If you create several vocabularies, you may find 

it a bit difficult to manage, as corrections you make in one will not update the others in your profile.

However, to make it easier to open DNS with a particular vocabulary, you can make shortcuts:

1. Right-Click the DNS shortcut on your Windows desktop and click “Properties” in the pop-up 

menu.

2. Click the Shortcut tab in the Properties window.

3. In the Target (or Command Line) text box, add /user and the name of the user at the end of the 

path. For example:

"C:\Program Files\Nuance\NaturallySpeaking9\Program\natspeak.exe /user Bret”

4. To specify a particular vocabulary, follow the user name with /vocabulary and the name of the 

vocabulary, as in:

"C:\Program Files\Nuance\NaturallySpeaking9\Program\natspeak.exe /user Bret /vo-

cabulary Legal-Large”

If the name of the user or the vocabulary contains a space, enclose the user’s name 

and/or the vocabulary in quotes, as in “Bret Williams” or “Medical Cardiology.”
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5. Click OK  to save your changes to the shortcut. You can add the shortcut to your Start 

menu by dragging it over the Start button on your Windows taskbar.

If you want to keep your DNS shortcut as is – to open DNS in default mode – then you 

may want to make a copy of the shortcut and paste it on your Desktop, thereby creat-

ing a new shortcut. Then, modify the new copy as explained to create a unique user/

vocabulary combination. Be sure and change the name of the shortcut to make it easy 

to identify.

OTHER VOCABULARY FUNCTIONS

As you probably noticed in the Manage Vocabularies window, you can also:

❖ Delete Vocabularies. You can only delete an inactive vocabulary – one not currently in use.

NEVER delete a vocabulary from the DNS Users directory. Always use the “Delete Vo-

cabulary” function to avoid confusing Dragon NaturallySpeaking.

❖ Rename Vocabularies. You can rename a vocabulary using up to 128 characters, including spaces.

❖ Import Vocabularies. Used to import DNS-exported vocabularies.

Importing vocabularies is not the same as importing words. The “Import Vocabulary” 

function is often used to move a modified vocabulary from one computer to another, 

such as might be the case when a person buys a new computer and needs to re-install 

DNS on the new machine.
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❖ Export Vocabularies. Saves a copy of the selected vocabulary in a format that can be imported into 

DNS. Exported vocabularies consist of four files named for the vocabulary, but having different file 

extensions.

If you’re concerned that modifying a vocabulary might not end up producing the results 

you desired, consider exporting the vocabulary first as a copy that could be imported 

back into DNS at a later date, returning you to a point previous to your modifications.
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ROAMING USERS

As you’ve learned so far, to use Dragon NaturallySpeaking on one PC requires that you create a user pro-

file and train it for each input device you plan to use. In most cases, this will be sufficient to meet the needs 

of most DNS users. However, in many installations, dictators needs to use DNS from different workstations, 

sometimes using different types of input devices.

A typical case is that of a radiology department. Radiologists dictate their evaluations of x-rays and other 

imaging records. A doctor may need to review films at different workstations throughout the facility. The 

radiologist might be using a Philips SpeechMike at one workstation, a desktop microphone at another, and 

a headset at yet another.

To eliminate the need for the doctor to train user profiles at each individual workstation – not to mention 

the fact that each profile will have different levels of accuracy as corrections are made – DNS Professional 

series provides for the creation of “Roaming Users,” server-based user profiles that can be accessed from 

multiple locations.

Roaming Users is also helpful for dictators who use DNS at the office and at home, yet wish to maintain 

one user profile. If a user takes a laptop computer on the road, they can use and maintain the same user 

profile they do at the office.

The configuration and set-up of Roaming Users is NOT for the faint of heart, particularly 

if you do not have administrative management of your servers. Due to the configuration 

needs of Roaming Users, much of the language in this section is fairly technical. If you 

are not an advanced Windows user or administrator, we highly recommend that you find 

a qualified Dragon Certified Partner to assist you in configuring and managing Roaming Users.

MASTER AND LOCAL ROAMING USERS

The Roaming User feature is a “server-client” based tool. Each user has a Master Roaming User configura-

tion that is stored on a server accessible by all the necessary workstations via a local (LAN) or wide-area 

(WAN) network.

When a user accesses a Master Roaming User file, a copy of that configuration is copied to the user’s 

workstation. This configuration – the Local Roaming User – is a copy of the user’s master profile. Any cor-
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rections are gathered on the local workstation while DNS is being used, and then synchronized with the 

Master Roaming User file when DNS is exited and the user files are saved.

It is important to note that every workstation from which a Roaming User configuration 

is accessed must have a full license for Dragon NaturallySpeaking. Although a copy of 

DNS Professional will support Roaming Users, you cannot use the same license on mul-

tiple workstations to access the same Roaming User file.

NETWORK LOCATIONS

Each workstation that is using the Roaming Users feature must be able to access the Master Roaming User 

files via a network, whether a local network or over the Internet. The great thing about Roaming Users is 

that it supports a variety of different network access methods:

❖ Mapped Drives. You can set up a directory on a shared network drive and assign a mapped drive 

letter to that directory.

❖ UNC Paths. Universal Naming Convention paths can be used to direct users to the storage directory.

❖ VPN. For Mapped Drives or UNC Paths, remote users can have secure access using a Virtual Private 

Network connection to the local network server.

❖ HTTP. Master Roaming User profiles can be served via a WebDAV (Web-based Distributed Authoring 

and Versioning) server from a local or Internet server.

❖ SSL HTTP (HTTPS). For maximum security, particularly when using this feature over a WAN, you can 

access this feature using a WebDAV server with SSL encryption.

You cannot create a non-Roaming user on a HTTP or HTTPS server. You can, however, 

use both Roaming and non-Roaming users on a shared drive via Mapped Drive or UNC 

Path.

If warranted, you can set up multiple network locations and multiple means of accessing the shared direc-

tory. For instance, you might have users in your facility share by Mapped Drives, while the “road-warriors” 

would use HTTPS. Both could access the same or different directories on the server, depending on your 

particular needs.

WEBDAV SERVERS

In today’s world, it’s not uncommon for professionals to work outside of the office. While VPN’s are 

common, the most versatile type of Roaming User access is via HTTP or HTTPS. Nuance calls this “Internet 
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Roaming.”

Internet Roaming with Dragon NaturallySpeaking is supported on:

❖ Microsoft Internet Information Services (IIS) 6.0

❖ Apache HTTP Server 2.0.54 or higher

Additionally, each server must be running a WebDAV application. WebDAV is required to access and 

secure user profiles on the Web server. A WebDAV application is available for free from www.webdav.org.

There are additional items to note when using WebDAV on the aforementioned servers if you are going to 

use Roaming Users:

❖ With Internet Information Server 6.0:

• Digest authentication through a proxy is not supported.

• If you are running IIS 6.0 and have not installed the WebDAV component, use Add/Remove Pro-

grams and run the Windows Components Wizard (check your IIS documentation for details).

❖ With Apache HTTP Server 2.0.54 and higher:

• Redirects must be turned on when using Digest authentication.

• Ensure that the server has WebDAV turned on.

CONFIGURING THE ROAMING USER FEATURE

Before you can begin configuring individual computers to use Roaming Users, you must set up the shared 

Master Roaming User network location. Once the network location is set up and configured, all participat-

ing workstations can be configured for Roaming Users.

To begin configuring a Roaming User workstation, open Dragon NaturallySpeaking and complete the 

following process.

CLOSE OPEN USERS

You cannot initiate Roaming Users if a user profile is open.

1. Close any open user profile files in DNS:

NaturallySpeaking > Close User
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TURN ON ROAMING USERS

1. Go to

Tools > Administrative Settings

2. On the Roaming tab, select “Enable.”

MASTER ROAMING USER LOCATION

For each Roaming User to access the Master Roaming User files, the shared location must be specified at 

each workstation.

1. Still on the Roaming tab, click Add . This will display the Roaming User Network Location 

window.
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2. Enter a Display Name. The Display Name is used in the Roaming tab and in the Open User win-

dow.

3. Define the location of the Master Roaming User network storage:

Mapped Drives and UNC Paths. Under “Network Location,” enter the address of the mapped drive or 

UNC path. Alternatively, click Browse…  to find the drive or path. You can also create a new directory 

on the target location, if necessary.

Although the network location (Mapped Drive, UNC Path, HTTPS, etc.) might be the 

same for all users, based on the size of your organization, you may want to segregate 

your users by department or type. By dividing up your users among different sub-

directories, you reduce the number of Roaming User profiles accessible on a given 

workstation. For example, at a workstation in Cardiology, you might only want the Roaming User 

profiles for Cardiologists to be accessible.

• Intranet and Internet Connections. Under Network Location, enter the URL or ad-

dress of your HTTP or HTTPS server. Use the “HTTP Settings” and “SSL Settings” 

windows to provide further specifications regarding your connection. You can also 

use this window to test your connection.

The technical issues surrounding configuration of Web servers is beyond the scope of 

this Guide. If you need assistance in configuring your workstation for Roaming Users via 

HTTP or HTTPS, and you encounter errors, please see your server administrator for 

assistance or contact your Nuance Certified Partner.

LOCAL ROAMING USER LOCATION

When a user accesses their Master Roaming User files, DNS makes a copy of the profile on the local 

workstation, called the “Local Roaming User.”

‣ In the Administrative Settings window, you can either accept the default location by clicking 

OK , or

‣ Change the default location for the Local Roaming User:

• Use the Browse for Folder window to open a location to store the Local Roaming User. 

Here, DNS will store all corrections or changes to the acoustic data made during 

the user’s session.

• If the directory you want to use does not exist, click Make New Folder . Use an ap-

propriate name for the new folder. Select the new folder and click OK .
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ROAMING USER OPTIONS

While in the Administrative Settings window, you will find there are several options available to you for 

customizing the Roaming User configuration:

❖ Allow non-Roaming User to be Opened. If you want users on a workstation to only use their Roam-

ing User accounts, de-select this item. Selecting this item allows a user to create and use a non-

Roaming User profile.

If you are using Roaming Users in an organization, you should most likely NOT allow 

non-Roaming Users. This prevents a user from accidentally creating or using a non-

Roaming user, thereby insuring that all modifications to a user’s profile are made to the 

Master Roaming User profile.

❖ Merge contents of vocdelta.dat into network user when file is full. The “vocdelta.dat” file is the 

local file that contains the changes made to the user profile during the user’s dictation session. DNS 

can copy the contents of this file to the Master Roaming User profile without running the Acoustic and 

Language Model Optimizer by selecting this item. Additionally, when selected, this item causes DNS 

to monitor the size of the vocdelta.dat file. When it reaches 90% of its 500MB maximum size, it will 

automatically copy the contents of the vocdelta.dat file to a local cache file, then to the Master Roam-

ing User profile. Afterwards, it deletes the contents of the vocdelta.dat file. Depending on the size of 

this file, opening a local Roaming User can take some time as this is when this operation occurs.

❖ Access network at user open/close only. To limit network traffic, particularly if you experience slow-

downs, selecting this item limits synchronization changes between the Local Roaming User and the 

Master Roaming User. Unselected, the synchronization occurs whenever a user profile is switched, 

closed or saved; selected, the synchronization only occurs when DNS is opened or closed.

❖ Ask before breaking locks on network users (recommended for UNC and mapped drives). When 

a Master Roaming User file is accessed, the file is locked to prevent access by other users. Occasion-

ally, the lock will become “stuck” and not release when the user profile is closed. While a locked file 

can be over-ridden, by selecting this item you will be alerting the user that a lock is about to be bro-

ken and give the user the option to cancel or proceed. Breaking a lock may indicate that a network 

problem exists; therefore, Nuance recommends that you leave this item checked so that you will be 

warned of any potential problem. This option only affects users accessing the Master User Roaming 

file via Mapped Drive or UNC Path; it has no effect for users accessing via HTTP/S.

❖ Set audio levels on each machine (recommended). If your roaming users will be using different 

workstations or using the same workstation in different locations (e.g., laptop), it is entirely possible 

that the acoustics of the session could vary between setups. This option will prompt a user to check 

their audio settings before each new Roaming User session, thus helping to insure the highest quality 

possible which, of course, affects accuracy.
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Yet another powerful feature of DNS: if DNS detects a significant difference between 

setups used by a Roaming User, DNS will prompt the user to run “Check your audio 

settings,” even though the “Set audio levels on each machine” item is not selected.

❖ Copy Dragon Log to Network. To help with possible diagnosis of problems, you can select this item 

so that DNS will copy the Dragon.log file from the Local Roaming User location to the Master Roam-

ing User location when DNS synchronizes both locations.

❖ Always copy acoustic information to network. When this item is checked, corrections made to the 

acoustic data of a Roaming User will be copied to the Master Roaming User location to be automati-

cally synchronized when the Master Roaming User is opened from another workstation location. Oth-

erwise, the acoustic data will not update the Master Roaming User profile until you run the Acoustic 

and Language Model Optimizer.

❖ Conserve archive size on network. .DRA files are very important in helping DNS improve the acous-

tic model for a user. These files are used by the Acoustic and Language Model Optimizer to analyze 

and compile the user profile. For maximum accuracy, leave this item unchecked, giving DNS copies of 

the .DRA files created on the local workstations. However, if disk space and network bandwidth are 

tight, you can select this item to keep the .DRA files from being copied to the server.

❖ Disk space reserved for network archive. To keep the Roaming User feature from potentially over-

taking your entire server hard drive, you may wish to limit the size of the directory that stores all the 

acoustic information used by the Acoustic and Language Model Optimizer. By default, the size is 

500MB which on many of today’s machines is not a significant size. However, if you do need to con-

serve space, you can reduce this number. The size of this directory will cause Dragon.log and .DRA 

files to cease being copied to the server once this maximum is reached.

CREATING A ROAMING USER

Now that the Roaming User feature is set-up with the proper locations, there are three ways you can 

create the actual Roaming User Profile:

‣ Train a new Roaming User

1. Close any open local user.

2. Go to

NaturallySpeaking > Open Users

3. Click New  and begin training the user as you normally would.
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‣ Convert a non-roaming local user to a Roaming User

1. Close any open local user.

2. Go to

NaturallySpeaking > Manager Users

3. Select the location of your local non-roaming user files from the “Location of user 

files” field. You should see a list of local non-roaming users you can convert.

4. Click Advanced , then Save to Roaming .

5. Select the appropriate Master Roaming User location in the “Save to Roaming” win-

dow, and click OK .

‣ Copy a User to the Master User Location

1. Navigate on your computer to the directory where your local user files are stored.

2. Select the user files you wish to copy.

3. Navigate to the Master Roaming Users location and paste the copied user files.

If you already have local non-roaming user profiles created, copying the user files to 

the Master Roaming User location is perhaps the quickest way to create new Roaming 

users, particularly if you have several to create.

By default, non-roaming local users are located at C:\Documents and Settings\All Us-

ers\Application Data\Nuance\NaturallySpeaking9.5\Users. Each non-roaming 

local user has it’s own directory structure. Make sure to copy the entire user directory structure to the Mas-

ter Roaming User directory.

OPENING A ROAMING USER

To begin using a Roaming User profile from a networked workstation or via the Internet:

1. Go to

NaturallySpeaking > Open Users

2. Find the Roaming User profile you wish to use. If you don’t see the user you are seeking, press F5 

to refresh the view. Also, make sure that the correct location is selected in the “Location of user 

files” field.
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3. Click Open .

MULTIPLE DICTATION SOURCES

Some Roaming Users will use a variety of different recording devices as they work among different work-

stations. As with local user profiles, you can allow multiple input devices to be used with a single Roaming 

User profile.

To add a new input device to a Roaming User profile:

1. Select the Roaming User you wish to use in the “Open User” window.

2. Click Source , then New , displaying the “New Dictation Source” window.

3. Select the new input device from the list.

4. Click OK  to return to the “Open User” window.

5. Select the User profile and click Open . Since you have not previously trained the user 

with the new device, a wizard should open to help you train the device.

6. Proceed with the device training until completed.

OPTIMIZING ROAMING USERS

Since changes made to Local Roaming User profiles are synchronized with the Master Roaming User pro-

files, the Acoustic and Language Model Optimizer can only be run on the Master Roaming User profiles. 

Your system administrator should be the one who periodically runs the optimizer.

To run the Acoustic and Language Model Optimizer, the system administrator can either install a licensed 

copy of DNS Professional on the network server or access the Master Roaming User files from a networked 

workstation running Dragon NaturallySpeaking. The optimizer is scheduled to run by the system adminis-

trator, preferably at a time when no Local Roaming User files are being used.

To schedule the Acoustic and Language Model Optimizer for Roaming Users:

1. In Windows, go to

Start Menu > Programs > Dragon NaturallySpeaking 9.5 > Dragon NaturallySpeaking Tools > 
Schedule for Acoustic and Language Model Optimizer
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The Windows path to Dragon NaturallySpeaking programs and tools may vary between 

Windows XP and Windows Vista. Additionally, there are some differences between Ver-

sion 9 and Version 9.5 of Dragon NaturallySpeaking. You should be able to find the nec-

essary files, though, as the differences are minor.

2. Access the directory of the Master Roaming User files you want to optimize by going to File > Set 

Speaker Directory.

3. In the “Set User Profile Directory” window, enter the path of the directory or use  Browse…  to 

locate the target directory.

4. Select the users you want to optimize and set a schedule for running the Acoustic and Language 

Model Optimizer. See Scheduling the Acoustic and Language Model Optimizer for more informa-

tion.

MSI INSTALLATION

Enabling Roaming Users can be achieved by using a MSI Installation. This topic requires advanced com-

puter operation skills outside the scope of this Guide. For more information, consult the Help topics in 

DNS, consult your Nuance Certified Partner, or contact American Dictation.
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PERFORMANCE TIPS

There are many reasons Dragon NaturallySpeaking may need to be “tweaked” to increase performance. 

As you’ve probably seen from the technical requirements of the software, DNS uses a considerable amount 

of RAM (Random Access Memory) and hard drive space. The speed – or lack of speed – of your computer’s 

central processor impact’s DNS’s ability to perform it’s purpose.

If your computer exceeds the technical requirements of DNS and you don’t have lots of other processor-

intensive applications running on your computer, you will probably find DNS works just fine. However, if 

you feel it’s not as responsive for your normal use, you might consider adjusting some of its settings.

Before spending a lot of time tweaking the settings mentioned in this chapter, we do 

recommend that you try working with as few open applications as possible. Especially 

those that run constantly in the background, such as widgets, e-mail and instant mes-

saging. While small in screen size, you’d be surprised how much CPU power some of 

these small programs consume.

OPTIONS

If you’ve taken a look at the various tabs in the Options window of the program, you’ve seen that there 

are many different settings. While the default settings are generally useful, you can increase the perform-

ance of DNS by selecting or de-selecting various options in the different tabs of the Options window.

Each of the following sections addresses some of the more common and beneficial selections you can 

make, grouped by option tab. To access the Options window, go to

Tools > Options

COMMANDS TAB

‣ Enable commands in HTML windows. De-select to turn off special commands for Internet 

browsers, such as Internet Explorer or Firefox.

‣ Enable mouse motion commands. De-select to turn off special commands that move your 

mouse pointer.
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‣ Enable Natural Language Commands. De-select to turn off special commands to control 

word processors, such as Microsoft Word.

‣ Require CLICK to select menus or controls. By requiring the use of the word CLICK before 

saying a menu command, DNS does not have to spend time deciding if you are giving a 

menu command or dictating text. Select to activate this feature.

‣ Use Active Accessibility for menu and dialog control. In Windows 2000, Active Accessibil-

ity allows you to control menus and controls by voice. DNS depends on this feature to 

select menus. If your version of Windows doesn’t require Active Accessibility or you 

don’t need to control menus using DNS, you can turn this feature off.

FORMATTING TAB

Additional processing is required by DNS to format text and numbers (e.g., punctuation, currency). If you 

don’t normally use these features, turning them off can help increase performance. 

‣ Enable postal code commands. De-select to prevent automatic formatting of postal codes.

‣ Do not automatically format text, such as numbers, Web addresses, e-mail addresses, ab-

breviations, etc. De-select to disengage.

‣ Other specific formatting features. In the Formatting tab, you’ll find specific formatting 

options for various other types of conditions. If you don’t need any of these, de-select 

them to relieve DNS of having to analyze formatting.

To restore the formatting options to their initial installed state, click “Restore Defaults.”

‣ Automatically add commas and periods. De-select to turn off automatic punctuation.

It has been our experience that allowing DNS to automatically format commas and pe-

riods is not more useful than dictating your own commas and periods. The algorithm 

DNS uses for calculating the placement of commas and periods does not always reflect 

how you would punctuate your dictation. Furthermore, this ability does not insert semi-

colons, exclamation marks or question marks. We find it much easier to dictate all punctuation, 

rather than trying to remember when to dictate punctuation and when to leave it to DNS.

CORRECTIONS TAB

While we recommend that you use speech data in the beginning as you learn DNS, you may find as time 

goes on that you aren’t playing back your dictation during correction or backing up your user files. Turning 

these features off increase the speed of Dragon NaturallySpeaking.
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‣ Automatic playback on correction. De-select if you don’t use this feature.

DATA TAB

‣ Disk space reserved for playback. If you don’t need to keep recordings of your dictation, 

you can reduce the about of hard drive space set aside for this feature. Set the value to 

zero to prevent DNS from keeping dictation recordings.

‣ Automatically back up user files. When the value of this feature is greater than zero, then 

DNS backs up your files each time you exit DNS (as well as every n number of saves). 

Set this value to zero to prevent back-ups.

We’re BIG fans of back-ups, having lost key data one too many times in the past. Un-

less your user profile directory is regularly backed-up using a back-up application or 

service, we suggest you keep automatic back-ups turned on if at all possible in case 

your current user profile becomes corrupt. Automatic back-ups are not the same, how-

ever, as disaster prevention back-ups, but they can come in handy if your computer crashes 

while DNS is open and your current user files somehow become unusable.

DICTATION MODES

Anytime you find that you’re dictating only one type of content, such as all numbers, all commands, spell-

ing, etc., you can give DNS a speed boost by switching to one of the specialized dictation modes, such as 

Dictation, Command, Numbers or Spell.

For more information about switching modes, see Recognition Modes.

There may be unique situations where you only need to use commands to control your computer. Per-

haps you’d rather type text and use your voice to control the computer, or you’re using an application 

where commands rather than text are important (e.g., graphics or architectural program). To give DNS 

maximum speed in these cases, create a user profile solely for this purpose. When you create the new user, 

choose “Commands Only” as the vocabulary.

Avoid adding custom words to a “Commands Only” vocabulary. Any future updates to 

DNS will not retain any custom word additions.
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SPEED VS ACCURACY

In the Miscellaneous tab of the Options window is a slider that allows you to adjust the trade-off between 

speed and accuracy. As you slide left, you increase the response speed of DNS at the expense of greater 

accuracy, and vice versa.

In essence, when you increase accuracy using this slider, you are asking DNS to analyze longer phrases 

before interpreting what it hears. This takes longer, but yields more accurate results. Alternatively, sliding 

toward more speed means that DNS is interpreting shorter phrases, thus being more responsive, yet less 

accurate.

There is no correct answer or suggestion for where you should place the slider. Also, until you have 

enough experience using DNS, as well as improving your profile through corrections and training, it’s diffi-

cult to adequately access how accurate DNS is at a given speed.

We suggest you keep the slider at its default position until you have used DNS for a while, unless your 

computer is responding very slowly to your dictation and you have exhausted all other “tweaks” to increase 

the response of Dragon NaturallySpeaking.

SYSTEM REQUIREMENTS

Since we’re on the topic of performance, let’s review the recommended computer system requirements 

for running DNS Professional:

❖ CPU. Intel Pentirum 4 (or equivalent AMD processor), 1 GHz or better clock speed. 2.4 GHz (1.6 GHz 

dual core processor) or equivalent AMD processor is recommended.

❖ RAM. 1 GB. 512 MB minimum available for DNS.

❖ Hard Disk. Minimum of 500 MB of free hard drive space. This would be for a minimum custom in-

stallation of only the program files and one set of speech files. Installations can actually range to as 

much as 2.5 GB for US English Medical version.

❖ Operating System. Windows 2000 Service Pack 4 or higher, Windows Server 2003, Windows XP Pro 

or Windows XP Home (SP2 or higher), Windows Vista Home or Professional Windows Vista (32-bit 

only).

If you need to view your computer specifications, go to

Start Menu > Programs > Accessories > System Tools > System Information

You can also right-click on “My Computer” and select “Properties.”
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HARD DRIVE

As you use your computer over time, your hard drive, by adding and deleting files, can become “frag-

mented.” Disk fragmentation is a topic you should consult with your computer technician. However, as a 

hard drive becomes fragmented, it will become less efficient. “De-fragmenting” a hard drive should be part 

of your computer maintenance routine.
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AUTOTRANSCRIBE

For busy dictators using a Third-Party Editing workflow, Dragon NaturallySpeaking Professional provides a 

means of having digital recordings transcribed automatically. The AutoTranscribe Folder Agent watches a 

designated folder and automatically transcribes any saved recordings, creating .TXT files using a specific 

user profile. For multiple users, separate directories can be set up for each user and user profile.

The AutoTranscribe Folder Agent will process the following audio format files: WAVE, PCM, MS ADPCM, 

IMA ADPCM, a-law, mu-law, VOX, WMA, and MP3.

The AutoTranscribe Folder Agent will be disabled if you start DNS on the same machine 

where it is running to avoid any conflicts with user profiles. Therefore, if you do use the 

AutoTranscribe Folder Agent, it should run on a machine where you do not need to oth-

erwise use Dragon NaturallySpeaking.

 With Dragon 10, you can set the Auto Transcribe feature to save the .DRA audio files along with the 

text output. This gives the editor, using Dragon 10, the ability to edit the text and make corrections that will 

improve the user profile accuracy, much like with Third-Party Dictation.

AUTOTRANSCRIBE FOLDER AGENT TASKS

The process of using the AutoTranscribe Folder Agent to automatically transcribe digital voice recordings 

begins with the creation of “tasks.” Each task designates the input directory (where the recordings will be 

deposited), the output directory (where the resulting .TXT files will be stored), the user profile to be used, 

the preferred vocabulary, and the dictation source.

Once the .TXT file is created, someone can take the file and copy its contents into a 

word processor, such as Microsoft Word or Corel WordPerfect for formatting and editing. 

Unlike traditional Third-Party Dictation, a .DRA file is not created when the transcription 

is processed. Corrections to the output will not enhance the user profile.

CREATING A NEW TASK

To create a new task:
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1. Start the AutoTranscribe Folder Agent. Go to

Start Menu > Programs > Dragon NaturallySpeaking 9.5 > Dragon NaturallySpeaking Tools > 
AutoTranscribe Folder Agent

2. Open the AutoTranscribe Folder Agent window:

• Double-click the AutoTranscribe Folder Agent icon  in the Windows System Tray, or

• Right-click the AutoTranscribe Folder Agent icon  in the Windows System Tray and 

select “Open.”

3. Select Task > New, displaying the Task window.

4. Enter the appropriate values for each of the fields:

• Input Directory – Select the directory where the digital voice files will be deposited for 

processing.

• Output Directory – Choose the directory where the .TXT transcription files will be 

saved.
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• Location – Specify where the DNS user files are on the computer.

• Name – Choose a user profile for processing the files related to the new task.

• Vocabulary – Select the vocabularies available for the selected user.

• Dictation Source – Select the dictation device available for the selected user profile.

5. Click OK .

EDITING A TASK

To edit an existing task, select the task from the AutoTranscribe Folder Agent window and choose Task > 

Edit from the menu. Make any desired changes and click OK  when completed.

DISABLING/ENABLING A TASK

Instead of deleting a task you do not wish to have running, you can disable it and preserve the settings. 

Once disabled, you can then re-activate, or enable, it.

To disable, select the task and choose Task > Disable Task from the menu.

To enable a task, choose Task > Enable Task.

DELETING A TASK

To remove a task from the AutoTranscribe Folder Agent, select the task to be deleted and choose Task > 

Remove.

AUTOTRANSCRIBE FOLDER OPTIONS

In the AutoTranscribe Folder Agent Options window, you can specify the actions you want taken as they 

relate to the AutoTranscribe Folder Agent.
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❖ Delete it. Removes the audio file once the transcription is complete. With some configurations, the 

software you use to save the audio file from a recording device may be able to make back-up copies 

of the audio files. Therefore, to save space on the computer with the AutoTranscribe Folder Agent, you 

may wish to have the audio files deleted after DNS creates the .TXT transcription file.

❖ Move it to the output directory. Once the transcription is completed the agent can move the voice 

file to the output directory where the .TXT files are stored. This may be helpful if the person process-

ing the .TXT files would like to listen to the audio file or if the audio file is to be saved with the result-

ing text file or other work product.

❖  Generate DRA File. Checking this box will allow you to save the Dragon Audio file for use in 

editing and correcting the text file. You can play back the dictation and correct the text to match the 

dictation. You can do this one of three ways:

• Correct the dictation using your user profile (if different from the dictating author)

• Correct the dictation using the dictating author’s user profile

• Correct the dictation without loading a user file (corrections will not improve a user profile, but 

will allow you to listen to the original audio while correcting the dictation)

Saving the .DRA file with documents can take up a lot of hard drive space, usually 

about 1.5 MB per minute of dictation. The .DRA files are saved in the same name as the 

text document. Therefore, when you complete the editing process, you may want to 

delete the .DRA file to save drive space. Simply look for the .DRA file with the same 

name as the text file.
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CONTROLLING THE AUTOTRANSCRIBE FOLDER AGENT

To start the agent so that it is waiting to transcribe files, go to

Start Menu > Programs > Dragon NaturallySpeaking 9.5 > Dragon NaturallySpeaking Tools > 
AutoTranscribe Folder Agent

A small icon will appear in the Window task tray.

To disable the AutoTranscribe Folder Agent, right-click on the icon in your Windows task tray and select 

“Exit.”

If you wish to have the AutoTranscribe Folder Agent start up with your computer, put a shortcut to the 

agent in the Startup Items folder on your computer (see Windows Help for information on locating this 

folder; it’s different for different flavors of Windows).
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SPECIAL TOOLS

It continues to amaze us how extensive Dragon NaturallySpeaking Professional is. Nuance includes a 

number of innovative and sophisticated features and tools that, while justifying a book like this one, add 

tremendous depth and versatility to the product. Features already covered such as the AutoTranscribe 

Folder Agent, Third-Party Dictation, and Custom Commands give the product its ability to truly be a “sec-

ond set of hands” for your workday.

While there are tools included with DNS that are best left to serious computer administrators, there are 

some that deserve some attention at this point, as they may be of some use to you as your work with DNS 

progresses beyond basic speech-to-text conversion.

VOCABULARY TOOL

The Dragon Vocabulary Tool or, as Nuance calls it, “Voctool” allows you to customize a DNS vocabulary 

by adding new words and optimizing the language model. This may be useful if you have many specialized 

words you wish to add to your vocabulary, or if you are building a customized vocabulary to distribute to 

other users (see Data Distribution Tool / Custom Vocabularies).

To open the Voctool wizard, go to

Start Menu > All Programs > Dragon NaturallySpeaking > Tools > Voctool
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The first screen of the wizard allows you to choose the User profile and Vocabulary you wish to custom-

ize, if not the combination currently open in DNS.

When running the Voctool, do not change the user profile or vocabulary. Doing so will 

abort the Vocabulary tool and all your changes will be lost.

The first required choice you have to make is between:

❖ Add new words from documents and adapt to writing style. This process, the same as using the 

Vocabulary Optimizer when you created your user profile, analyzes documents you specify and 

learns new words and your writing style based on those documents. You can also access this function-

ality through the Accuracy Center. This is the same process as described in Adding Words from 

Documents, as well.

❖ Add new words from word list files. This begins a process that underlines the real power of Voctool – 

to allow you to create customized vocabularies from custom word lists as well as provide language 

models for those words. This process is described in the section Adding Words from Lists.

What is important about Voctool is that it gives you the opportunity to save your revised vocabulary as a 

new vocabulary or you can merge it with an existing user model. If you create a new, revised model, you 

are able to preserve the original model and you create a new exportable vocabulary you can distribute to 

other users using the Data Distribution Tool.

DATA DISTRIBUTION TOOL

If your profession requires you and your colleagues to use specialized vocabularies and commands, you 

may find it worthwhile to learn how to create your own list of custom words, vocabularies and commands 

to use and distribute among other users. The Data Distribution Tool is an interactive tool to help you man-

age this process.

The Data Distribution Tool should be run on each computer where you want the new added words or 

vocabularies made available to DNS users on that workstation. This tool only runs on computers using 

Dragon NaturallySpeaking Professional series.

You can also run “nsadmin” from the command line to perform the same data distribu-

tion functions. For this Guide, we are limiting the instructions to the interactive tool. For 

command line version help, see the Help menu in DNS. 

You can choose anywhere to save the distribution files created by this application, as long as they are 

available to your intended users. Shared locations can be either mapped drives or UNC paths.
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To start the Data Distribution Tool, go to

Start Menu > All Programs > Dragon NaturallySpeaking 10.0 > Dragon NaturallySpeaking Tools 
> Data Distribution Tool

Activated this tool opens a wizard.

Select the appropriate function and click Next .

To set the location where the local installation of DNS stores customized words and commands, click 

Advanced… . By default, custom commands for existing DNS users are located at \Documents and 

Settings\All Users\Application Data\Nuance\Dragon NaturallySpeak-

ing9\Custom\[language].

CUSTOM WORDS

To distribute a list of custom words to other DNS workstations, you have to first create a text (.txt) file 

containing a list of words you make available across all vocabularies on the computer. This text file should 

conform to the following guidelines:

‣ Each word, phrase or name must be on a separate line.

‣ You can include a spoken form for a word by typing the word followed by a backslash and 

the spoken form. For example, to have “Lyndon B. Johnson” entered when you say 

“LBJ,” type:

Lyndon B. Johnson\LBJ.
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Save the text file in a location you can access from the computer onto which you will be installing the 

custom words.

To add your list of custom words to a DNS installation:

1. In the Data Distribution Tool Wizard, select “Add or remove words to share across vocabularies” 

and click Next .

2. Select the languages of the user profiles that will be using the custom word list, and click 

Next .

3. Import the .txt custom word list you created by selecting any lists you created and clicking 

Next .

4. When completed, you may review the operation log and then click Finish .

A file called NewWords.txt will be copied to the appropriate location on the local machine. Once 

completed, you should restart DNS to make the new words available to all users and vocabularies.

CUSTOM VOCABULARIES

If you have created a customized vocabulary using the Vocabulary Tool (Voctool), you can provide that 

vocabulary as a replacement base vocabulary for other users.

1. Copy the new vocabulary to a location which is accessible to all workstations you wish to install. 

The vocabulary file, by default, is located in \Documents and Settings\All Us-

ers\Application Data\Nuance\Dragon NaturallySpeaking9\us-

ers\[user name]\current. Vocabulary files end in .voc.

2. In the Data Distribution Tool, select “Add or remove base vocabulary” and click Next .

3. In the Add Base Vocabulary window:

• Give the vocabulary a descriptive name, such as “Architecture” or “Statistics.”

• Select the location of the vocabulary you copies in Step 1.

• Give the vocabulary a unique numeric ID. Use a number greater than 9000.

4. Click OK .

You can also use the Data Distribution Tool to distribute a vocabulary that was exported from DNS. When 

you export a vocabulary using the Manage Vocabulary function, you will create a group of files with differ-
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ent suffixes – all beginning with .to. To add an exported vocabulary using the Data Distribution Tool, 

select the exported file ending in .top.

You can also remove a base vocabulary by selecting the vocabulary you wish to delete in the Data Distri-

bution Tool.

CUSTOM COMMANDS

As with words and vocabularies, custom commands you create in DNS can be exported and distributed 

to other users.

First, export the custom commands created in DNS using the Command Browser. The commands will be 

saved to a .dat file. Copy this file to a location accessible for each target workstation.

To add custom commands:

1. Select “Add or remove shared commands” in the Data Distribution tool and click Next .

2. Select the languages of the user profiles and click Next .

3. Use Import…  to select the .dat file containing the exported custom commands, and click 

Next .

4. When completed, you may review the operation log and then click Finish .
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TROUBLESHOOTING

We would like to profess that we have encountered most of the problems you might encounter when 

using Dragon NaturallySpeaking. Unfortunately, we can’t. DNS has, for us, been a quite stable and produc-

tive tool. It is difficult, therefore, to create a troubleshooting section without relying on information pro-

vided by Nuance since we have not personally experienced most of the possible difficulties discussed in this 

section.

We have, where possible, enhanced the guidelines provided herein with our own experiences, but the 

core of this information is provided by Nuance in the Help menu of DNS.

WHERE TO GET HELP

Before addressing common problems, let’s talk about where to go for assistance when you can’t resolve 

an issue on your own.

❖ Your Vendor. The Nuance Certified Partner from whom you purchased DNS should be familiar with 

how DNS works (it’s part of becoming “Certified”), and can provide you with assistance.

❖ American Dictation. We are a Nuance Certified Partner dealer, and hopefully you’ve garnered from 

this Guide that we know a little bit about Dragon NaturallySpeaking. While we do provide free tech-

nical support for our customers, if you purchased DNS elsewhere and would like our assistance, you 

may be charged a nominal technical support fee. Call 866-408-1383 for information. You can also 

visit our Web site at www.AmericanDictation.com.

❖ Nuance. Of course. If you do not have a specific technical support maintenance agreement, you may 

be charged for technical support, but you can’t deny they know the product. You can reach Nuance 

by phone at 407-241-1822. Before calling, though, you might want to visit their support Web site at 

www.Nuance.com/NaturallySpeaking/support/.

ERROR MESSAGES

When a software error occurs, DNS will usually display an error message:
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1. Read the error message carefully. Don’t just dismiss the error without trying to understand what it 

says. We know that error messages can be cryptic, especially to non-techies, but Nuance does try to 

provide meaningful error messages.

2. If you have an open document you have dictated into, close the error message and save your 

document to avoid losing any work.

3. Do NOT save your user files.

4. Find the error message log file, called “Dragon.log.” In windows go to

Start > Programs > Dragon NaturallySpeaking > Show Dragon log

 Copy this file to a safe place. You may need to provide it to Nuance or your dealer.

5. Quit DNS and open it again. See if the error persists. If it does, restart you computer and test again.

6. You can also try repairing your DNS installation by inserting your DNS installation CD into your 

computer and running the installation program. Choose the “Repair” option. After re-installing, 

open DNS and run any previous updates.

7. For help with error messages, contact your vendor or Nuance. You can find most error message 

explanations at www.Nuance.com/NaturallySpeaking9/support/.

PERFORMANCE ISSUES

As you use DNS, you may feel that at certain points the software is slower to respond than normal. If you 

have taken the steps described in Performance Tips and you still feel you are getting less than ideal per-

formance, you may find some answers in the following recommendations:

❖ Working with large documents in Word or WordPerfect is slow. The size of word processing docu-

ments can affect the speed of DNS, particularly after the documents get over 50 pages in length. You 

might try dividing larger documents in to smaller documents.

❖ Working with documents slows over time. Depending on your computer system resources, working 

with DNS over a long period of time may begin to slow performance. Save and close your current 

document. Reopen it and continue.

❖ Working on a laptop is slower when using battery power. In order to conserve battery power, most 

laptops are configured by default to slow down processors and turn off hard drives after a certain time 

of inactivity. While you may reduce battery life, you can change these settings to allow more process-

ing power and prevent hard drive “spin down” after a longer interval.
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RECOGNITION ISSUES

As you use DNS, you might detect that recognition is not as accurate or efficient as usual. Many factors 

can contribute to such degradation. The following are ideas from Nuance on steps you could take to miti-

gate this issue:

❖ When you are wearing a headset microphone, make sure the microphone is positioned properly and 

in the same location as when you ran the Audio Setup wizard.

❖ Try moving the microphone closer to your mouth or to another position. Run the Audio Setup wizard 

again.

❖ Make sure your microphone is working properly. Run the Audio Setup wizard to see if your micro-

phone is still providing enough sound fidelity for accurate recognition.

❖ Make sure the open user in DNS is the correct one. Dictating with the wrong user profile will certainly 

yield less than ideal results.

❖ See Performance Tips for more ideas on increasing recognition accuracy.

If you find that your dictated commands are being recognized as text instead of commands:

❖ Pause briefly before and after saying a command. DNS uses these pauses to determine whether you 

are saying a command or dictating text. Do not pause, however, before saying dictation commands, 

such as CAP, NEW LINE, or NEW PARAGRAPH.

❖ When using the command SELECT, INSERT BEFORE, and INSERT AFTER, do not pause until after 

you say the words you want affected. For example, if you want to select “Carlsbad,” say SELECT 

Carlsbad without pausing after “select.”

❖ Be sure you are saying the correct command.

❖ Hold down the CTRL key as you start to say a command. This disables dictation and forces DNS to 

recognize your next utterance as a command.

❖ Train commands often mistaken for dictation so DNS knows how you pronounce them.

As you dictate and find your dictation is being misinterpreted:

❖ Don’t allow DNS to interpret breath sounds as words. These often appear as extra words, such as 

“and,” “in,” etc. You may need to re-position your microphone. If you do move your microphone, run 

the Audio Setup wizard again.

❖ If you want to type a word that is also a command, dictate the word without pausing before and after 

the word.
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❖ You can press and hold the SHIFT key to force DNS to interpret the next utterance as dictation and 

not as a command.

❖ If a word you often use is misinterpreted as a word you never use, delete the unused word from your 

vocabulary.

❖ When correcting small words – such as “in” – it is easier to select and correct a longer phrase.

There are undoubtedly other issues that may arise with your continued use of Dragon NaturallySpeaking. 

If your issue is not included in this Guide, consult your vendor or Nuance. You may also find additional 

guidance in the Help menu of Dragon NaturallySpeaking.
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COMMAND GUIDES

When you’re using Dragon NaturallySpeaking, it’s easy to find out what commands are at your disposal 

simply by saying WHAT CAN I SAY? However, sometimes it’s convenient to have a printed list of available 

commands beside you, especially as you begin to learn DNS.

In this section, we have prepared command guides for the specific applications accommodated in Dragon 

NaturallySpeaking Professional Series. Each application is prepared on a separate page or sub-section so 

you can print out just the guide you need.

These guides provide the most common commands. For the most complete list of available commands, 

use the Command Browser.

GLOBAL COMMANDS

CONTROLLING THE MICROPHONE

GO TO SLEEP OR STOP LISTENING WAKE UP or LISTEN TO ME

MICROPHONE OFF

CONTROLLING MODES

START COMMAND MODE STOP NUMBERS MODE

SPELL MODE OFF DICTATION MODE ON

SWITCH TO NORMAL MODE

GETTING HELP

GIVE ME HELP WHAT CAN I SAY

DISPLAY SAMPLE COMMANDS
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SELECTING AND CORRECTING

SELECT [word/phrase] SELECT AGAIN

SELECT THE NEXT FIVE CHARACTERS SELECT PREVIOUS PARAGRAPH

SELECT DOCUMENT CORRECT [word] 

SELECT ALL UNSELECT THAT

INSERTING LINES AND SPACES

NEW LINE NEW PARAGRAPH

PRESS ENTER PRESS TAB KEY

CAPITALIZING

CAPITALIZE THAT ALL CAPS ON

NO CAPS OFF

EDITING AND FORMATTING TEXT

CUT THAT COPY THAT

COPY ALL TO CLIPBOARD PASTE IT HERE

UNDOING AND DELETING

SCRATCH THAT DELETE THAT

UNDO THAT 

MOVING AROUND IN YOUR DOCUMENT

MOVE LEFT [number] WORDS MOVE DOWN [number] LINES

GO TO END OF LINE PAGE UP

INSERT BEFORE [word/phrase]
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DRAGONBAR

GIVE ME HELP SWITCH TO FLOATING MODE

OPEN DRAGONPAD SAVE USER FILES

MANAGE USERS TRAIN MY USER

CHECK AUDIO IMPROVE MY ACCURACY

OPEN ACCURACY CENTER BRING UP COMMAND BROWSER

CREATE COMMAND MODIFY CUSTOM COMMANDS

EDIT VOCABULARY SHOW ME THE OPTIONS

VIEW EXTRAS BAR CLOSE DRAGON NATURALLYSPEAKING
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DESKTOP AND MOUSE MOVEMENTS

START [application name] SHUT DOWN COMPUTER

CLICK START OPEN [desktop icon]

VIEW SAMPLE COMMANDS NATURALLYSPEAKING

SWITCH TO [application name] MINIMIZE WINDOW

MOVE MOUSE [UPPER LEFT/SLOWER/FASTER] MOUSEGRID

START [folder name] MOVE DOWN [number]

MOVE UP [number]
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DRAGONPAD

The following commands are only available if “Enable Natural Language Commands” has been selected 

in the Options window.

SAVE THIS DOCUMENT SAVE FILE AS

PRINT DOCUMENT PRINT PAGE [number] TO [number]

QUIT DRAGONPAD DISPLAY TOOLBAR

FIND WORD
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INTERNET EXPLORER

GO [BACK/FORWARD] GO TO ADDRESS BAR

MOVE [UP/DOWN] [number] PAGE [UP/DOWN]

STOP LOADING START SCROLLING [UP/DOWN]

STOP SCROLLING SPEED UP

SLOW DOWN SEARCH THE WEB*

OPEN SEARCH* SHOW FAVORITES*

VIEW HISTORY* GO TO THE HOME PAGE*

CLICK IMAGE NEXT PANE

CLICK TEXT LINK CLICK GO

COPY THAT PRINT PAGE*

SAVE AS* CLOSE EXPLORER*

TAB KEY CLICK FILE

* These commands are only available if “Enable Natural Language Commands” has been selected in Op-

tions.
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MICROSOFT WORD/COREL WORDPERFECT

OPEN A DOCUMENT* SAVE THE FILE*

SAVE AS* PRINT FILE*

CLOSE DOCUMENT* NEW LINE

NEW PARAGRAPH ADD PAGE NUMBERS*

INSERT DATE* GO TO END OF LINE

GO TO TOP OF DOCUMENT* BULLET SELECTION*

MAKE THIS UPPERCASE* BOLD THE PREVIOUS [number] 

WORDS*

CAPITALIZE THE PREVIOUS LINE* UNDERLINE THIS WORD*

UNDO THAT SELECT THE NEXT [number] WORDS

CUT THIS PARAGRAPH* COPY THIS SENTENCE*

PASTE IT HERE DELETE THAT

INSERT A PAGE BREAK* INSERT A [number] BY [number] TABLE*

SET ZOOM TO [number] PERCENT* CHECK SPELLING*

CHECK GRAMMAR* PRINT PREVIEW ON*

CLOSE PREVIEW*

* These commands are only available if “Enable Natural Language Commands” has been selected in Op-

tions.
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MICROSOFT OUTLOOK

The following commands are only available if “Enable Natural Language Commands” has been selected 

in the Options window.

CHECK FOR NEW MAIL VIEW BY SENDER

FORWARD MAIL DELETE MAIL

CREATE NEW MESSAGE SUBJECT FIELD

GO TO BODY FIELD ATTACH A FILE

SEND MAIL REPLY TO ALL

SEND AND RECEIVE SHOW THE ADDRESS BOOK

DISPLAY CONTACTS FOLDER DELETE CONTACT

CHECK SPELLING VIEW SENT ITEMS FOLDER

SWITCH TO THE CALENDAR FOLDER SHOW DATE

VIEW MONTH CREATE A NEW APPOINTMENT

INVITE ATTENDEES CANCEL INVITATION

SAVE AND CLOSE
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MICROSOFT OUTLOOK EXPRESS

The following commands are only available if “Enable Natural Language Commands” has been selected 

in the Options window.

CHECK FOR NEW MAIL SEND AND RECEIVE MESSAGES

CREATE MAIL OPEN A NEW MESSAGE

DELETE THE MESSAGE FORWARD THIS MESSAGE AS ATTACH-

MENT

GO TO THE INBOX FOLDER OPEN THE OUTBOX

ATTACH A FILE MARK ALL MESSAGES AS READ

GO TO SUBJECT GO TO TEXT

MOVE TO NEXT FIELD GO TO NEXT UNREAD MESSAGE

OPEN THE MESSAGE SHOW ADDRESS BOOK

PRINT THE MESSAGE REPLY TO ALL

SEND MESSAGE SEND THIS LATER

SHOW UNREAD MESSAGES
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MICROSOFT EXCEL

OPEN A NEW WORKBOOK* GO TO [NEXT/ PREVIOUS] WORKSHEET*

SAVE THIS FILE* RENAME THE WORKSHEET*

NEXT ROW* INSERT ONE ROW*

NEXT COLUMN* ROW [number]*

COLUMN [letter]* GO TO THE BEGINNING OF THIS ROW*

MOVE TO COLUMN [letter]* MOVE TO CELL [cell letter-number]*

BEGINNING OF THIS WORKSHEET* PAGE DOWN

CUT THIS COPY THAT

DELETE THAT CLEAR THIS*

PASTE THIS HERE CENTER ALIGN THIS COLUMN*

INSERT A NEW SHEET* AVERAGE THE VALUES ABOVE*

ADD UP THIS ROW* SUM THIS COLUMN*

SET THE FONT TO ARIAL* PRINT THIS*

UNDO THAT [start value] THROUGH [end value] 

ACROSS*

[start value] THROUGH [end value] DOWN

* These commands are only available if “Enable Natural Language Commands” has been selected in Op-

tions.
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MICROSOFT POWERPOINT

NEW PRESENTATION* OPEN A FILE*

SAVE THIS FILE* CHANGE SELECTION TO TITLE CASE*

MAKE THAT BULLETED* VIEW SLIDE SORTER*

SAVE THIS FILE AS* PRINT FILE*

MAKE A DUPLICATE SLIDE* DELETE THIS SLIDE*

START SLIDE SHOW* NEXT SLIDE*

PREVIOUS SLIDE* COPY THAT

DELETE THAT PASTE THAT

BOLD THIS* UNDO THIS*

* These commands are only available if “Enable Natural Language Commands” has been selected in Op-

tions.
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LOTUS NOTES

OPEN MAIL* SEND MAIL*

OPEN DOCUMENT* REPLY TO ALL*

DELETE MEMO* GO TO CC FIELD*

COMPOSE NEW APPOINTMENT* COMPOSE NEW CALENDAR ENTRY*

CREATE NEW MEMO* MOVE DOWN [number]

PRINT MAIL MESSAGE* EXIT LOTUS NOTES*

* These commands are only available if “Enable Natural Language Commands” has been selected in Op-

tions.
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PUNCTUATION AND SPECIAL CHARACTERS

To Dictate Say… To Dictate Say…

& AMPERSAND * ASTERISK

‘ APOSTROPHE ‘s APOSTROPHE ESS

@ AT SIGN ` BACKQUOTE

‘ [BEGIN/OPEN] SINGLE QUOTE ’ [END/CLOSE] SINGLE QUOTE

“ [BEGIN/OPEN] QUOTE ” [END/CLOSE] QUOTE

\ BACK SLASH / FORWARD SLASH

: (NUMERIC) COLON , (NUMERIC) COMMA

^ CARET … ELLIPSIS

-- DASH ° DEGREE SIGN

. DOT/POINT . PERIOD

$ DOLLAR (SIGN)/DOLLARS © COPYRIGHT SIGN

= EQUAL SIGN € EURO SIGN

! EXCLAMATION POINT - (NUMERIC) HYPHEN

£ POUND STERLING SIGN ? QUESTION MARK

® REGISTERED MARK § SECTION SIGN

; SEMI COLON space SPACE BAR

tab TAB KEY ~ TILDE

_ UNDERSCORE | VERTICAL BAR

{ [LEFT/OPEN] BRACE } [RIGHT/CLOSE] BRACE

[ [LEFT/OPEN] BRACKET ] [RIGHT/CLOSE] BRACKET

( [LEFT/OPEN] PARENTHESIS ) [RIGHT/CLOSE] PARENTHESIS

< [LEFT/OPEN] ANGLE BRACKET > [RIGHT/CLOSE] ANGLE 

BRACKET

« OPEN EURO QUOTE » CLOSE EURO QUOTE

- MINUS SIGN # [NUMBER/POUND] SIGN

% PERCENT SIGN + PLUS SIGN

:-( FROWNY FACE :-) SMILEY FACE

;-) WINKY FACE

These items are for US/Canada vocabularies. Non-US/Canada vocabularies may have different dictation 

rules. See Help for more information. 
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CHOOSING A MEDICAL VOCABULARY

One of the most powerful features of Dragon Medical 10 is the ability to choose a vocabulary that con-

tains the terms and phrases most used in a given medical specialty. While Dragon provides almost 80 dif-

ferent specialty vocabularies, you may not find an exact match for your needs.

Use the following chart to help you determine the best choice for your needs.

Specialty Choose

Addiction Psychiatry Addiction Psychiatry

Adolescent Medicine Family Medicine, Internal Medicine, or 

Pediatrics

Allergy and Immunology Allergy and Immunology

Anesthesiology Anesthesiology

Bariatric Surgery Surgery

Behavioral Health Psychiatry

Blood Banking/Transfusion Medicine Pathology

Breast Surgery Surgery

Cardiac Surgery Cardiac Surgery

Cardiology Cardiology

Cardiothoracic Surgery Surgery

Cardiovascular Disease Internal Medicine

Chemical Pathology Pathology

Child and Adolescent Psychiatry Psychiatry

Child Abuse Pediatrics Pediatrics

Clinical Cardiac Electrophysiology Cardiology

Critical Care Medicine Anesthesiology or Internal Medicine

Dentistry Dentistry

Dermatology Dermatology
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Specialty Choose

Dermatopathology Pathology

Developmental-Behavioral Pediatrics Pediatrics

Diagnostic Radiology Radiology

ENT ENT

Ear, Nose and Throat ENT

EEG Psychiatry

Emergency Medicine Emergency Medicine

EMG Examinations Neurology

Endocrinology Endocrinology Diabetes and Metabolism

Epidemiology Epidemiology

Family Medicine Family Medicine

Fetal Medicine Fetal Medicine

Forensic Pathology Pathology

Forensic Psychiatry Psychiatry

Gastroenterology Gastroenterology

General Medicine General Medicine

Geriatric Medicine Geriatric Medicine or Family Medicine

Geriatric Psychiatry Geriatric Medicine or Family Medicine

Geriatric Psychiatry Psychiatry

Hand Surgery Hand Surgery or Plastic Surgery

Hematology Hematology

Hospice and Palliative Medicine Pain Medicine, Emergency Medicine, 

Family Medicine, Internal Medicine, Pe-

diatrics, or Physical Medicine and Reha-

bilitation

Infectious Disease Infectious Disease

Internal Medicine Internal Medicine
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Specialty Choose

Interventional Cardiology Internal Medicine

Medical Education and Writing Medical Education and Writing

Medical Microbiology Pathology

Medical Oncology Internal Medicine

Medical Toxicology Emergency Medicine, Pediatrics

Mental Health Addiction Psychiatry, Endocrinology Dia-

betes and Metabolism, Psychiatry, or Psy-

chology

Midwifery Midwifery

Neonatal and Perinatal Medicine Neonatal and Perinatal Medicine

Nephrology Nephrology

Neurodevelopmental Disabilities Pediatrics

Neurology Neurology

Neuromuscular Medicine Physical Medicine and Rehabilitation

Neuropathology Pathology

Neuropsychology Psychiatry, Neurology

Neurosurgery Neurosurgery

Neurotology ENT

Nuclear Medicine Nuclear Medicine

Nuclear Radiology Radiology

Obstetrics and Gynecology Obstetrics and Gynecology

Oncology Oncology

Ophthalmology Ophthalmology

Oral and Facial Surgery Oral and Facial Surgery

Orthopaedic Surgery Orthopaedic Surgery

Osteopathy Osteopathy
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Specialty Choose

Otolaryngology ENG

Pain Medicine Pain Medicine

Pathology Pathology

Pediatric Cardiology Pediatric Cardiology

Pediatric Critical Care Medicine Pediatrics

Pediatric Dentistry Pediatric Dentistry

Pediatric Dermatology Dermatology

Pediatric Emergency Medicine Emergency Medicine or Pediatrics

Pediatric Endocrinology Pediatrics

Pediatric ENG Pediatrics

Pediatric Gastroenterology Pediatric Gastroenterology

Pediatric Hematology-Oncology Pediatrics

Pediatric Infectious Diseases Pediatrics

Pediatric Nephrology Pediatrics

Pediatric Otolaryngology ENT

Pediatric Pathology Pathology

Pediatric Pulmonology Pediatrics

Pediatric Rehabilitation Medicine Physical Medicine and Rehabilitation

Pediatric Rheumatology Pediatrics

Pediatric Rheumatology Pediatrics

Pediatric Surgery Surgery

Pediatric Transplant Hepatology Pediatrics

Pediatric Urology Urology

Pediatrics Pediatrics

Physical Medicine and Rehabilitation Physical Medicine and Rehabilitation

Plastic Surgery Plastic Surgery
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Specialty Choose

Plastic Surgery within Head and Neck ENT

Podiatry Podiatry

Psychiatry Psychiatry or Addiction Psychiatry

Psychology Psychology

Pulmonary Disease Pulmonary Disease

Radiation Oncology Radiology

Radiation Therapy Radiation Therapy

Radiologic Physics Radiology

Radiology Radiology or Nuclear Medicine

Rheumatology Rheumatology

Sleep Lab Sleep Lab

Sleep Medicine Family Medicine or ENT

Speech and Language Pathology Speech and Language Pathology

Spinal Cord Injury Medicine Physical Medicine and Rehabilitation

Sports Medicine Emergency Medicine, Family Medicine, or 

Physical Medicine and Rehabilitation

Surgery Surgery

Thoracic Surgery Thoracic Surgery

Transplant Hepatology Internal Medicine

Trauma Surgery Surgery

Undersea and Hyperbaric Medicine Emergency Medicine

Urology Urology

Vascular Surgery Vascular Surgery

Vascular and Interventional Radiology Vascular and Interventional Radiology
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SPECIAL BONUS

Thank you for purchasing “Mastering Dragon NaturallySpeaking®.” We hope it provides you with the 

help and encouragement to get more from DNS.

As an additional “Thank You,” we would like to extend a 15% discount on the new Dictaphone Power-

Mic II. This desktop recorder works great at capturing your voice with the quality and clarity to give DNS its 

best chance at transcribing your dictation. Plus, Dragon Medical 10 has direct PowerMic II functionality 

built right in!

To take advantage of this offer:

8. Call toll-free, 866-408-1383, during business hours to place your order.

9. Before you order, tell your American Dictation representative that you want to apply Bonus Offer 

MDNS10.

That’s all there is to it.

However, in the interest of full disclosure:

‣ You must order by phone to receive the bonus.

‣ Only one bonus per customer.

‣ Bonus cannot be applied to any other special offers, discounts or incentives.

Thank you again for your purchase.


